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1. Introduction 
 

1.1 IviumSoft 
 
The IviumSoft software can be used to control one or multiple CompactStat, IviumStat or Ivium-n-Stat 
instruments, by means of a Personal Computer. 
The PC is used to specify the parameters of the measurement, to display the measured curves and 
calculate the results of the measurements. 
 
Each instrument contains a microprocessor and a potentiostat/galvanostat which controls the potential 
or current applied to the electrodes and measures the current or potential response. To ensure that the 
instrument's internal microprocessor gets enough time to run its start-up procedure, there should be at 
least 10 seconds delay between powering up the instrument and connecting it in the IviumSoft. 
 
An instrument can be used with electrochemical sensors or electrochemical cells with 4 electrodes: 
working electrode, sens electrode, reference electrode and auxiliary or counter electrode. In the so-
called two-electrode configuration the counter- & reference-electrode and the working- & sens-electrode 
can be combined to a single electrode.  
In case the bipotentiostat is available, a 5th electrode WE2 is present. 
 
PC requirements:  
· Windows XP, Vista or 7  
· free USB port 
 
Multiple Iviumstats, CompactStats and Ivium-n-Stat-channels can be controlled with 1 pc. When the 
IviumSoft software is started, the operator can select the serial/channel number of the desired device. 
Pressing the arrow of the selectionbox at the rightside of the Connect button will dropdown a list of 
available devices. Pressing the Connect button will assign this software instance to the device indicated 
by the selectionbox. 
 
Multiple instances of IviumSoft can be started, that can each be assigned to another device. Once a 
device is assigned to a particular IviumSoft instance, it is no longer available for other instances (of 
course).  
When multiple instances are running and assigned, these can be recognized on the Windows taskbar 
by corresponding buttons. When an IviumSoft-instance is connected to a device, the text on the 
taskbar-button changes from "IviumSoft" to "Ivium X#####", with X###### the serial number (or 
assigned channel number for an Ivium-n-Stat) of that particular instrument. It is thus possible to control 
different experiments on several instruments simultaneously from one pc. These instruments will 
operate completely independent of each other. 
 
When exiting the Iviumsoft program, the actual method parameters are saved. When IviumSoft is 
restarted, these are reloaded. In this manner new sessions can continue where the previous ended.  
 
IviumSoft "Help" 
The IviumSoft software is equiped with a help function. The help function can be accessed from the 
menu bar under "Help" to execute a topic or word search. Alternatively, positioning the cursor/mouse 
anywhere on the IviumSoft and then pressing "F1" will automatically pop-up a window with a decription 
relevant to the indicated parameter/area. 
 
The help function is supported by the Windows Help. Windows Help (WinHlp32.exe) is a Help program 
that has been included with Microsoft Windows versions however, starting with the release of Windows 
Vista, the Windows Help program does not ship as a feature of Windows. IviumSoft uses the  Windows 
Help program for the software help. If you want to use or view the IviumSoft 32-bit.hlp files when 
running under Windows Vista, you must download and install the program (WinHlp32.exe) from the 
Microsoft Download Center. The download file and a guide on how to install it can be found at the 
Microsoft Download centre. 
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1.2 IviumStat instrument(s) 
 

 
Rearpanel:  
· Power connector: fits the standard power cable, which should be connected to the main power.  
· Fuseholder: contains 2 fuses. Replacement should be done by a qualified person.  
· USB connector: fits to the supplied USB A/B cable which should be connected between instrument 

and PC.  
· Cooling element with fan. Please make sure that air can flow freely. 
 
Frontpanel:  
· On/Off button: when pressed, the instrument powers up and the button lights up blue when ready. 

Please allow several seconds for the startup sequence to be completed.  
· Disconnect button: when pressed, all electrode cables are disconnected.  
· LCD screen: a graphical screen that displays the status of the instrument*.   
· Peripheral port: 37p connector that provides access to a range of analog/digital input/output signals.  
· Cell connector: 15p connector that fits the supplied electrode cable. 
 
 
The IviumStat20V and the IviumStat.XR are connected identical to the IviumStat. 
 
 
*The LCD screen displays a number of user-relevant information:  
· In the Left top an arrow ">" shows the status of the instrument; when changing between "<" and ">" 

the instrument is idle; when fixed in position, the instrument is busy.  
· Below the arrow it shows what method is running and the actual value of E and I. Note that these 

are updated at an interval with low priority, i.e. when the instrument is busy, updates of E and I may 
not show.  

· At the left bottom in the blue bar it is shown whether the instrument is operating in Estat or Istat 
mode. Below that the actual current range is shown.  

· In the right bottom corner in the blue bar the version of firmware that is running is displayed.  
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1.3 CompactStat instrument 
 

  
 
Rearpanel:  
· Power connector: fits the supplied 5V power adapter. In usb powered mode, this plug should be 

removed.  
· USB connector: fits to the supplied USB A/B cable which should be connected between instrument 

and PC.  
· Peripheral port: 37p connector that provides access to a range of analog/digital input/output signals. 
 
Frontpanel:  
· On LED: when the instrument is turned on from the PC, this LED will light up green.  
· Cell LED: when the cell is on (CE), this LED will light up red.  
· Cell connector: 15p connector that fits the supplied electrode cable. 
 
The CompactStat instrument can be powered via the external adapter, or from the USB cable. The 
instrument selects its power supply automatically based on the presence/absence of the dc-connector 
plug. This should be placed or removed before the usb-cable is connected. 
When powered via the external adapter, the instrument can access full power and no restrictions apply. 
When powered via the USB cable, the instrument draws its power from the pc. USB powered devices 
may formally draw a maximum of 500 mA, and some restrictions apply to the CompactStat to remain 
below this formal limit:  
· 10 mA current range should not be used  
· internal dummy cells should not be used  
· automatic 2-electrode mode should not be used 
However, most pc's will have no problem if the 500 mA limit is exceeded slightly for short periods of 
time. 
 
If the IviumSoft program is not running, or the instrument is disconnected, the CompactStat is put in 
standby mode (green LED is off). In standby mode, the instrument will lower power consumption to 
about 50 mA. 
 
Note 1: In the serial number read-out window, the lower case 'b' before the serial number indicates that 
this CompactStat is using usb-power, while a capital 'B' indicates mains-adapter power. This can be 
verified in Device maintenance, under Tools, by selecting "Check device" 
 
Note 2: No features are disabled in USB powered mode. The operator should be aware that formal 
USB limits may be exceeded if he/she applies the features listed above. 
 
Note 3: Some USB hubs are not compliant to 500 mA, and cannot be used to power the CompactStat. 
In this case, connect the CompactStat directly to the USB port of the pc, or use the external power 
adapter.  
 



   10 

1.4 Ivium-n-Stat instrument 
 

  
Rearpanel:  
· Power connector: fits the standard power cable, which should be connected to the main power.  
· Fuseholder: contains 2 fuses. Replacement should be done by a qualified person.  
· USB connector: fits to the supplied USB A/B cable which should be connected between instrument 

and PC.  
· EMO connector: Red, 4mm socket (banana)  
· GND connector: Green, 4mm socket (banana) 
 
Frontpanel:  
· On/Off button: when pressed, the instrument powers up and the button lights up blue when ready. 

Please allow several seconds for the startup sequence to be completed. 
 
sModule (channel):  
· Peripheral port: 15p subD connector that provides access to a range of analog/digital input/output 

signals.  
· Cell connector: 15p HD connector that fits the supplied electrode cable.  
· Multi-color LED: status LED between both connectors*. 
 
*Status LED: 
- blue (blinking white): idle with no pc-client connected  
- green (blinking white): pc-client connected, Direct mode, cell = off 
- red (blinking white): pc-client connected, Direct mode, cell = on 
- red (continuous): pc-client connected, Method mode 
 
Notes on the Ivium-n-Stat: 
The Ivium-n-Stat multi-channel potentiostat/galvanostat is operated in much the same way as the Ivium 
single channel instruments. However, there are some subtle differences: 
· The Ivium-n-Stat uses USB drivers that are standard included in MS Windows. Just plug the system 

in a USB port, and it is ready to go.  
· In a way the Ivium-n-Stat can be regarded as a number of separate Ivium instruments in one single 

box: each channel (sModule) can be operated as a separate instrument (see: Starting the Ivium-n-
Stat).  

· The peripheral connector of the sModule has 15 pins instead of 37 pins. The sModule has fewer 
signals than the IviumStat. Also note that the analog input-range is different.  

· As opposed to the IviumStat and CompactStat instruments the Ivium-n-Stat sModules are not 
equipped with internal dummy cells. Also the 2-electrode mode is not available. If only a WE and 
CE are present, simply connect the RE (blue) to the CE and the S (white) to the WE.  
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· The sModule is not equipped with a bipotentiostat. Its WE2 lead can instead be used to measure 
potentials relative to the S electrode, for example from the CE or an additional reference electrode.  
In Direct mode, the WE2 voltage sensor can be activated with a checkbox on the Extern tabsheet" 
"E at WE2".  
In the Method mode for techniques that measure potentials, the WE2 sensor can be chosen instead 
of the electrode potential by checking the "E at WE2" parameter. Specifications: 
a) Range:    ±10V 
b) Input resistance:  >12Mohm 
c) Bandwidth:   > 100kHz 

· No high sensitivity current ranges: The Ivium-n-Stat has a minimum current range for the sModule 
of 10nA full scale  with a minimum current resolution of 1.2pA. 

 
 

1.5 Installation and setup 
 
Install software before connecting the USB cable. 
(Refer also to: Quick reference guide) 
 
 
Software installation: 
1. Insert CDROM with IviumSoft Installation program. 
2. From the CDROM root directory, run "setup.exe", and follow instructions. 
 
Driver installation Windows XP: 
1. For CompactStat, first connect the power adapter to the CompactStat device. The adapter should 

be connected to the mains. Wait 2 seconds and connect the USB cable.  
2. For IviumStat, connect the powercable to the mains, switch the instrument on and connect the USB 

cable.  
3. Now you will see a sequence of dialog screens: 

a. "Welcome to the Found New Hardware ….." : select "No, not this time" , and press 
Next . 

b. At next screen: select "Install from a list or specific location (advanced )"  , and 
press Next . 

c. At the next screen, select "Search for the best river in these locations" , check 
"Include this location in the search" , press the Browse button and locate the driver, 
standard : "C:\IVIUMSTAT\IVIUMDRIVERS", and press Next . 

d. You will get a message that the this driver is not Signed. Press "Continue Anyway" . 
e. Press Finish  

 
Driver installation Windows Vista and 7: 
Windows Vista or 7 may not (successfully) automatically install the driver. Windows will give a 
notification when this occurs. In this case the driver needs to be installed manually. 
1. For CompactStat, first connect the power adapter to the CompactStat device. The adapter should 

be connected to the mains. Wait 2 seconds and connect the USB cable.  
2. For IviumStat, connect the powercable to the mains, switch the instrument on and connect the USB 

cable 
3.  

a. Go to "Start>Control panel". 
b. Select "Hardware and sound". 
c. Choose "Device manager" under "Devices and Printers".  
d. Expand USB controllers. 
e. Find the Ivium Instrument USB, right mouse click on it and select "Update Driver 

Software"  
f. Choose "Browse my computer..." and navigate to locate the driver, standard: 

"C:\IVIUMSTAT\IVIUMDRIVERS" 
g. Click next to install the driver. 

 
Note that the Ivium-n-Stat uses USB drivers that are standard included in MS Windows. Just plug the 
system into a USB port and it is ready to go 
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Resuming from a failed driver installation:  
In case an error occurred during a previous driver installation, the re-installation may not start 
automatically when the USB cable is plugged in again. The process can be started from the Windows 
device manager: 
1. Go to "Start>Control panel", select "System properties>Hardware", mouse click on "device 

manager". 
2. Expand "Universal Serial Bus controllers" and right-click "Ivium Device". 
3. Select update driver and follow instructions as stated above under "Driver installation". 
 
 
Hardware Installation: 
Depending on your location and environment, as well as whether you have additional Ivium modules or 
instruments connected, the Ivium instrument hardware configuration may need to be correctly set in the 
Options menu: 
1. After installation of the IviumSoft software and Ivium driver, start the IviumSoft. 
2. In the left top of the IviumSoft window mouse-click on the "Connect" button. 
3. In the menu go to "Options>Options". 
4. Under "Environment" check the relevant boxes. 
5. Close the window.  
The new settings are now implemented in the Ivium instrument. To make sure these new settings are 
activated, in the left top of the IviumSoft click the "Connect" button once to disconnect the device and 
again to reconnect the device. The instrument is now ready for use.  
 
 

1.6 Install Edoubler 
 
The Edoubler module is to be connected to the IviumStat20V via de 15-pins cell cable connector. The 
original cell-cable is connected to the output cell connector of the Edoubler module. The Edoubler 
requires an external 5 Volt powersupply (included in shipment), that must be connected. 
 
When the Edoubler module is connected, the configuration in the software should be updated. In the 
Options menu, the "Edoubler" checkbox should be checked. 
 
Note that when Edoubler is connected, the internal dummy cells, the 2-Electrode-mode, and the BiStat 
module should not be used.  
 
 

1.7 Install HiMux 

 
 
The "HiMUX.XR" multiplexer* is connected to the IviumStat/CompactStat via de 15-pins cell cable 
connector. Each multiplexer comes with 8 standard cell cables*, 1 for each of its 8 channels. Each 



   13 

channel/cell cable can then be connected to an electrochemical cell in the same way that the 
IviumStat/CompactStat would be connected directly.  
The HiMux requires an external 5 VDC powersupply (included in shipment), that must be connected 
before operation. 
 
In case multiple HiMux modules are used, a cell-cable-connection assembly should be used. This 
consists of a flexible cell-cable extender, and a connection-box. This box has 1 input (F) and 3 outputs 
(M), and can connect to 3 HiMux modules. Assemblies may be cascaded to connect more units. 
 
HiMux clamp kit 
The HiMux clamp kit is intended to enable easy mounting of the 8-channel HiMux into a 19-inch 
rack.The HiMUX-Clamp-Kit consists of an aluminium front with 2 brackets on the rear side for clamping 
the multiplexer unit in place. When mounted, on the front side all 8 channels are available, as well as 
two connectors for connecting the multiplexer to the Ivium potentiostat and for connecting an optional 
next multiplexer unit for additional channels. 
For detailed instructions on how to assemble the HiMux and clamp kit, refer to the "Installation notes for 
HiMux clamp kit". 
 
*There two models of the HiMux available. Both models are connected and controlled in the same way;  
· The older models of the HiMux have a blue-and-white plastic housing and the 8 channels have 4 

BNC-connectors each for WE,CE,RE,S. The compliance of this model is ±10V/±5A.  
· The later model HiMUX has a blue-and-grey metal housing and the 8 channels have the Ivium 

standard 15 pins HD cell connector for WE, CE, RE, S, WE2, GND. The compliance of this model is 
±20V/±5A. 

 
Operation 
After the HiMux has been installed the sequential use of all channels is available, either by choosing the 
channel in the Direct mode and then executing the desired technique (1) or automated via the 
Batchmode (2). 
 
1) In the Direct control tab sheet select the channel number next to the "Set MUX channel" button by 
entering the channel number manually or using the up/down arrows. Then mouse click on the "Set MUX 
channel" button to activate this channel. The red LED of the chosen channel on the HiMUX.XR will now 
light up. 
 
2) In the Batch mode use the "Direct Command" to set a channel number directly ("SetMuxChannel"), 
or use the "Loop" command to set the channel number to the loop index ("SetMuxToIndex").  
 
 

1.8 Install IviumBoost 
 

  
 
The IviumBoost is a current booster for the IviumStat that will increase the maximum current of the 
IviumStat. Two models are available: 
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- maximum 20A at ± 20V 
- maximum 40A at ± 10V 
 
The 20A&20V version can be used at its full range in combination with the IviumStat.XR. The 
40A@10V can be used optimally with either the IviumStat or the IviumStat.XR. 
 
Safeties and Alarms 
The IviumBoost is a very powerful device which is capable of high power outputs. In order to protect the 
user and  the test subject as well as the device itself, the booster is equipped with a variety of electronic 
safeties, some of which have LED alarm indicators. Located at the front of the IviumBoost is an 
indicator window that contains 8 LED indicators in two columns of 4: 
 
Indicator  Shows when: 
E+ ovl [orange]  potential range positive maximum is reached 
E- ovl [orange]  potential range negative maximum is reached 
I ovl [orange]  current range maximum is reached 
Cell on [green]  cell is electrically connected 
E max [red]  positive power supply overload 
E min [red]  negative power supply overload 
Temp [red]  temperature maximum inside IviumBoost is exceeded 
Osc [red]  an oscillation of the electrical signal in the electrometer occurs 
 
The [orange] LEDs show a warning that a range maximum has been reached. The [red] LEDs show 
that a terminal condition has occurred and subsequently automatically the cell has been disconnected 
and the measurement has been terminated. When a new measurement starts the IviumBoost is 
automatically reset and the indicator will switch off. 
 
When a (unforeseen) situation occurs where it is desired to protect the test subject/substrate from the 
reigning electrical conditions, an (emergency) manual override is possible. The cell (WE + CE) will be 
instantly isolated from the IviumBoost by pressing the red "Disconnect" switch located at the bottom 
right on the front of the IviumBoost. 
 
A representation for the same indicators that are on the front of the IviumBoost can be found in the 
IviumSoft window under and to the right of the menu bar. These will change color in the same manner 
when an overload is detected. When after a method these indicators are still lit to indicate the latest 
condition, they can be reset manually before the next measurement by clicking on the "Reset" button to 
the right. Alternatively, they will be reset when the next method/measurement is started. 
 
Connecting the IviumBoost to the IviumStat 
To connect the IviumBoost to the IviumStat: 
1. Take the 40 cm M/F HD15 cable. Insert the M-side into the Cell-connector of the IviumStat. Insert 

the F-side into the IviumStat connector. 
2. Connect the RE/S cable to the RE/S connector. 
3. Connect the (heavy) WE/CE cable by inserting the plug so that the notch and the slid line up. Then 

turn the plug clockwise until it clicks in place. (To unfasten, pull the silver button and turn the plug 
counter-clockwise). 

4. Connect the power cable 
5. Switch on the IviumBoost 
6. Switch in the IviumStat 
 
Note that the IviumBoost can only be operated in the 4-electrode mode. The RE and S leads need to be 
connected. 
 
By default the IviumStat is configured to operate stand-alone. In order to operate the IviumStat with the 
IviumBoost the configuration needs to be changed in the Options-menu (see also: Installation and 
setup). 
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Calibration of the IviumBoost 
To calibrate the combination IviumStat-IviumBoost for optimal accuracy at the given current range of 
10A of the IviumBoost proceed as follows: 
· IMPORTANT: Press the red "Disconnect" button on the front of the IviumBoost, so that it lights up 

red.  
· In the IviumSoftware go to "Tools" in the menu bar and select "Device maintenance"  
· At the bottom-left in the pop-up window click on "Booster offset". This will induce a number of clicks 

in the devices followed by a beep in the IviumStat indicating that the devices have been calibrated*.   
· De-press the red "Disconnect" button on the front of the IviumBoost, so that the lights extinguishes.  
· Close the pop-up window and commence working. 
 
*Note that the calibration of the IviumBoost is done with all the cell relais closed (hence the clicking 
noise during the calibration procedure). After measurements all cell relais will be opened to return the 
IviumBoost to default mode. This means that the value for the current that is displayed in the IviumStat 
window as well as in the software "Direct mode" tab page may be different from the calibrated value. 
Nevertheless, in all measurements the calibrated value is used. 
 
Cell cable connections 
The IviumBoost is capable of outputting high currents and high powers. In order to guarantee the best 
measurement results, the current carrying cables of the WE and CE have been separated from the 
potential measurement cables RE and S. It should be noted here however, that the IviumBoost can only 
be operated in the 4-electrode mode. The RE and S leads need to be connected. 
 
The WE and CE electrode cables end in an o-ring for fastening to the testsubject. The shipment of the 
IviumBoost includes several appendages for connecting the cell cables to the test subject. The gold 
plated bananas can be attached to the o-ring of the WE or CE cables by unscrewing the back of the 
banana and re-fasten it through the o-ring. Do not use other banana's, because these gold plated 
banana's have been manufactured and tested for 50A capability. 
To attach the battery clips to the WE or CE electrode cables, remove the handle insulation of the 
battery clip. Fasten the electrode cable o-ring at the bolt in the handle, and re-attach the handle 
insulation. 
 
The RE/S cable includes the ground cable. All end in a banana-plug. The RE and S should be 
connected to the appropriate contacts of the test subject (or the WE and CE leads). These cables do 
not carry any current and can be connected using the crocodile clips that are included in the IviumBoost 
shipment.  
 
 

1.9 Install MultiWE32 
  

 
 
The Ivium Technologies MultiWE32 works with CompactStat or IviumStat to provide simultaneous 
electrochemical potentiostatic control of 32 working electrodes versus one counter electrode and one 
reference electrode. 32 channel impedance can also be measured sequentially. 
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Connection to Ivium-potentiostat 
To connect the MultiWE32 to an IviumStat or CompactStat: 
1. Take the 40 cm M/F HD15 cable. Insert the M-side into the Cell-connector of the IviumStat or 

CompactStat. Insert the F-side into the HD-15 connector at the front of the MultiWE32. 
2. Insert the multi electrode cable to the HD-37 connector at the back of the MultiWE32. 
3. Connect the 5Vdc power adapter to the MultiWE32 (at the back). The green power LED at the front 

will now light up.  
4. Switch on the IviumStat or connect the CompactStat. 
5. In the Options-menu, check the option for the MultiWE32. 
6. Now in the various parameters to control the MultiWE32 are available in the Direct and Method 

modes 
 
The MultiWE32 is now ready for use. 
 
Operation 
When the MultiWE32 option is activated, the instrument can be controlled sequentially via the Direct 
mode or simultaneous via the Method mode. In the Method mode, in the method parameters of the 
various Techniques, one or two extra parameters will become available (depending on the technique):  
· WE32_offsets: to set the offset for each WE (all techniques)  
· WE32_allchannels: whether to record all channels simultaneously (only available for LSV Standard, 

CV Standard and CA Standard) 
 
Of course the MultiWE32 is also integrated in the Batch mode. 
 
The MultiWE32 can be operated in 2 modes: 
 
1. Sequential mode : All available potentiostatic methods can be run in this mode.  
 
Before a method is started the user can select the channel number on the Direct Control tabsheet. The 
MultiWE32 operation is similar to the HiMUX multiplexer: select the channel number next to the "Set 
WE32 channel" button by entering the channel number manually or using the up/down arrows. Then 
mouse click on the "Set WE32 channel" button to activate this channel. The red LED of the chosen 
channel on the front of the MultiWE32 will now light up. 
The selected channel will be measured; however, note that the potential is applied to all channels 
simultaneously. 
 
Channel selection can be automated in the Batchmode, similar to the HiMUX . The Loop command has 
a property "SetWE32ToIndex" that will set the channel number to the loop counter.  
 
Alternatively, the channel number can be set directly with the DirectCommand property 
"SetWE32channel"  
 
2. Simultaneous mode : To acquire measurement from all 32 channels simultaneously.  
It is available for the following techniques: LSV standard, CV standard and CA standard. 
 
This is activated with the "WE32_allchannels" method property, in Advanced mode. When checked, the 
currents for all 32 working electrodes are recorded. Each scan will therefore produce 32 curves. 
Individual curves can be stored with "save data", while all 32 scans can be stored in a single file with 
"save dataset". 
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1.10 Install Plus-module 
  
 

 
 
The Plus-module as a separate unit is available in 2 models: 
 
- maximum ±250mA and ± 20V 
- maximum ±800mA and ± 10V 
 
The Plus-module is to be connected to the CompactStat via de 15-pins cell cable connector. The 
original cell-cable is connected to the output cell connector of the Plus module. 
The Plus requires an external 12 Volt powersupply (included in shipment), that must be connected. 
 
When the Plus module is connected, the configuration in the software should be updated. In the 
Options menu, the relevant "Plus" checkbox should be checked: 
 
(1) 
- only "CompactStatPlus" for the ±250mA and ± 20V model 
- both "CompactStatPlus" and "type II" for the ±800mA and ± 10V model 
 
(2) 
When the relevant box is checked, close the Options window, and in the software "Disconnect" the 
instrument and "Connect" again to switch on the Plus-module. 
 
 
Note that when Plus is connected and activated, the internal dummy cells, the 2-Electrode-mode, and 
the BiStat module can not be used.   
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2. Getting started 
 

2.1 Starting the CompactStat 
 
CompactStat :  
· If operating on adapter power, first connect the acdc adapter to a mains socket and to the round dc-

plug at the rear of the instrument.   
· Connect the USB cable to the CompactStat device and a free USB socket of the pc.  
· Start the IviumSoft program. From the top left corner of the screen in the drop-down menu select 

the serial number of the CompactStat that you will be using. This can be verified with the serial 
number written on the underside of the CompactStat.  

· Wait 10 seconds and press the connect button at the left-top-corner. The IviumSoft program will 
turn on the CompactStat and the green LED at the front of the CompactStat should now be lit.  

 
 

2.2 Starting the IviumStat 
 
IviumStat:  
· Attach the powercord to the instrument and mains, and press the power button.  
· Connect the USB cable to the IviumStat device and a free USB socket of the pc.  
· Start the IviumSoft program. From the top left corner of the screen in the drop-down menu select 

the serial number of the IviumStat that you will be using. This can be verified with the serial number 
written at the rear of the instrument.  

· Wait 10 seconds and press the connect button at the left-top-corner. The IviumSoft program will 
activate the IviumStat and the instrument should indicate the connection.   

· Before starting measurements, be sure that the red "disconnect" button is depressed and is un-lit. 
 
 

2.3 Starting the Ivium-n-Stat 
 
Ivium-n-Stat:  
· Connect the USB cable to the IviumStat device and a free USB socket of the pc.  
· Attach the powercord to the instrument and mains and press the power button.  
· Start the IviumSoft program.   
· Execute the channel management: 
 
Channel management 
Each s-module has a unique serial number, assigned at the factory. This number will never change. For 
multi-channel operation, it is useful to assign sequential channel numbers instead of working with 
factory serial numbers. When starting up after a fresh installation, the software will show the factory 
serial numbers, such as "S09001", "S09007', etc. To convert these to channel numbers: 
 
1) After starting IviumSoft, do not press the connect button, but select select in the menu bar 
"Tools/Define Channels" 



   19 

2) A form will be opened with a list of connected devices. Ex factory, the Channel numbers are 
predefined according to the slot positions in the Ivium-n-Stat Frame. To accept this assignment, simply 
press "Close".  
 

 
 
3) To change the channel assignment, use the up/down thumbs. A ChannelNo of "0" means 
unassigned. To identify specific modules, pressing the Identify button will flash its LED for 2 seconds. 
Pressing the "Write" button will apply the new channel assignments.  
 
4) Note that the serialnumbers & channelnumbers are stored in each datafile, for your reference. The 
ChannelNo is stored inside the sModule, and will be kept, until re-assigned by the operator. After a 
fresh software install, the actual serial numbers can be read from the modules, by opening and closing 
the assignment screen. 
 
5) After assigning, the connection selectionbox will display the channel numbers instead of the serial 
numbers. 
 

  
 
The assignment has to be done only once after installation. The settings are kept when the software 
restarts. 
 
Connecting the instrument: 
· In the channel selection box select the channel that you wish to connect  
· Press the "Connect" button, at the left-top-corner. The IviumSoft program will activate the selected 

channel and the instrument will indicate the connection (see status LED). 
 
In a way the Ivium-n-Stat can be regarded as a number of separate Ivium instruments in one single 
box: each channel (sModule) can be operated as a separate instrument and is identified with a unique 
serial number. In the current IviumSoft the operator can connect to the channel/sModule of choice, and 
a new instance of the IviumSoft needs to be opened to connect to the next channel. 
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For ease of use the operator can identify the channel that is currently connected in the IviumSoft 
instance. In the Direct mode tab there is an "Identify" button. When this button is clicked the channel 
that is connected will flash its LED for two seconds.  
 
 

2.4 Multiple Ivium instruments on 1 PC 
 
Multiple Iviumstats, CompactStats and Ivium-n-Stat-channels can be controlled with 1 pc. When the 
IviumSoft software is started, the operator can select the serial number of the desired device. Pressing 
the Connect button will assign this software instance to the device indicated by the selectionbox at the 
right side of the Connect button. Pressing the arrow of the selectionbox will dropdown a list of available 
devices. 
 
Multiple instances of IviumSoft can be started, that can each be assigned to a specific device. Once a 
device is assigned to a particular IviumSoft instance, it is no longer available for other instances (of 
course).  
When multiple instances are running and assigned, these can be recognized on the Windows taskbar 
by corresponding buttons. When an IviumSoft-instance is connected to a device, the text on the 
taskbar-button changes from "IviumSoft" to "Ivium X#####", with X###### the serial number of that 
particular instrument. It is thus possible to control different experiments on several instruments 
simultaneously from one pc. These instruments will operate completely independent from each other.  
 
 

2.5 Measurement 
 
Measurements can be done with the internal dummy, the external TestCell1 (see chapter TestCell1 
module), or electrochemical cells. 
Execute the supplied test procedures 1, 2, 3 for an introduction to operations. 
Also study the following section on electrode connections. 
 
Measurements with the Testcell1:  
· Connect the electrode cable to the HD15 connector at the front of the instrument  
· Connect the 4mm bananaplugs to the "TestCell1" (included in shipment): 

o Gnd: ground (green) 
o WE1, WE2: Working Electrode (red), WE2 refers to the Bipotentiostat. 
o CE: Counter Electrode (black) 
o RE: Reference Electrode (blue) 
o S: Sense (white)  

· On the Method sheet, a measurement technique can be selected from the method tree, and 
configured on the parameter grid.  

· Measurements can be started with the "Start" button, and aborted with "Abort" button.  
· Results can be saved with the "File" menu-item: "Save data". 
 
Measurements with electrochemical cells:  
· Electrode connections can be made similar to the TestCell1 described above: 

o Gnd may be connected to a shielding body, such a Faraday cage. If possible connect gnd to a 
low impedance grounding point, to avoid noise. 

o WE1,WE2: should be connected to the electrode "under test". 
o CE: to be connected to the electrode that delivers the "counter" current.  
o RE: to be connected to the electrode that maintains a fixed potential. In 2-electrode 

configurations, this is connected at the same point as CE. 
o S: allows for a secondary RE in a 4-electrode configuration, in 2-or 3-electrode configurations, 

this is connected at the same point as WE1.  
· On the Method sheet, a measurement technique can be selected from the method tree, and 

configured on the parameter grid.  
· Measurements can be started with the "Start" button, and aborted with "Abort" button.  
· Results can be saved with the "File" menu-item: "Save data".  
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2.6 Connecting the electrodes 
 
The standard IviumStat/CompactStat electrode cable has 6 leads with 4 mm plugs:  
· CE (black) counter electrode  
· WE (red) working electrode  
· WE2 (red) working electrode for bipotentiostat (inactive if not ordered)/potential sensor for sModule 

(Ivium-n-Stat)  
· RE (blue) reference electrode  
· S (white) sense electrode  
· GND (green) ground connection 
 
Usually an experiment does not require all these electrodes separately. In that case tie multiple leads 
together. 
The GND lead is (normally) not connected to an electrode, but to a grounding point like a Faraday 
cage, to reduce noise.    
 
Configurations 
 
For a 2-electrode Electrochemical experiment:  
· connect WE and S together to the electrode to be studied  
· connect CE and RE together to the other electrode  
 
NB: it is possible to let the instrument make the WE-S and the CE-RE shortcuts internally, by setting the 
2-EL mode, thus you only need to connect WE and CE. However, it is recommended to use the 4-EL 
mode, because that configuration gives better performance in some cases, see below. 
 
For a 3-electrode Electrochemical experiment, using a reference electrode:  
· connect WE and S together to the electrode to be studied  
· connect CE to the counter electrode  
· connect RE to the reference electrode 
 
For a 4-electrode Electrochemical experiment, using 2 reference electrodes:  
· connect WE er to the electrode to be studied  
· connect CE to the counter electrode  
· connect RE to the reference electrode near the counter electrode   
· connect S to the reference electrode near the working electrode  
 
For an experiment with the bipotentiostat:  
· connect WE/S/RE/CE as described above  
· connect WE2 to the secundary working electrode 
 
Only for the Ivium-n-Stat WE2 lead:  
· connect WE/S/RE/CE as described above  
· the sModule is not equipped with a bipotentiostat. Its WE2 lead can instead be used to measure 

potentials relative to the S electrode, for example from the CE or an additional reference electrode.   
· in Direct mode, the WE2 voltage sensor can be activated with a checkbox on the "Extern tabsheet" 

"E at WE2".   
· in the Method mode for techniques that measure potentials, the WE2 sensor can be chosen instead 

of the electrode potential by checking the "E at WE2" parameter. 
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Special techniques 
Special techniques may require an alternative way of connecting the electrodes, such as 
electrochemical noise measurements. A standard noise measurement uses 3 electrodes: 1 reference 
electrode, and 2 identical working electrodes. Connect these is the following manner:  
· RE to reference electrode  
· WE+S to working electrode 1  
· Gnd to working electrode 2 
 
Theory of operation: 
 
The WE and CE leads carry the current, while the RE and S measure the potential. The instrument has 
a control loop that will keep the potential of WE near the gnd-potential, while applying a signal to CE. 
In galvanostatic mode, the instrument will apply a defined current through CE, and thus WE.     
In potententiostatic mode, the instrument will force a current through CE&WE so that the 
potentialdifference (S-RE) is a defined value. 
There are distinct advantages of using 4 electrodes instead of 2, because the separate (current-less) 
measurement of potential eliminates losses over the cable:  
· any cable has an ohmic resistance that causes a voltage drop at higher currents. A good standard 

cable may add approximately 0.2 ohm, that amounts to 200 mV loss at 1 A. In such cases a 4-
electrode configuration is recommended.  

· any cable also adds inductance and parasidic capacitances. These may become dominant at 
higher frequencies. Therefore also for high fequencies, the 4-electrode configuration is 
recommended. 
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2.7 Screen layout 
 

 
  
1. Device & Software control 
 
On top the mainmenu is shown (see also later in this chapter):  
· File: to load/save method and datafiles  
· Options: setting the device and module options, incl. FRA options  
· Tools: tools for device maintenance (upgrades/calibrations) and special functions.  
· Help: information how to use the software   
· About: information about the software   
 
To start:  
· At the left top of the screen the serial/channel number read-out window is located. In the drop down 

menu to the right side of that select the device by serial/channel number.  
· To operate this instrument, click "Connect". (Connect button: connect or disconnect the instrument 

displayed in the indicated "serial number box". You must be connected before you can 
communicate with a device. When the IviumSoft program is terminated, the device will 
automatically disconnect. A device can only be connected to one IviumSoft application at a time.) 

 
2. Operating parameters  
 
Direct mode: for direct control of the instrument  
· Intended for diagnostic purposes.  
· Actual potential and current are displayed. These values are updated every second.  

6 
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· When no potential/current is applied, the open-cell potential (S-RE) is displayed (within specified 
accuracy). 

 
Method mode: for executing electrochemical methods 
The operator can define a technique or measurement protocol on the Method sheet.  
When the Start button at the bottom of the tab sheet is pressed, this measurement protocol is executed. 
In this state, the software takes control over the instrument: Method control. This will last until the 
measurement is completed or aborted by the user. 
During Method control, the Direct control functions are not available, neither are some filing and 
analysis functions. 
 
3.  Advanced parameters 
 
Measurement bar: indicates the actual current range and overload status: 
- Eovl: will turn red if the voltage compliance limit is exceeded on CE. If this occurs, the data obtained 

will not be reliable. Usually it is caused by a bad connection to RE. 
- Iovl: will turn red if the WE current exceed 3 X the current range. In some cases data could still be 

reliable, but it is recommended to select a larger current range. 
- Ext: will turn red if the voltage on the analog input channel 1 exceeds the defined value. The operator 

may set this value. 
- Current range: will show the actual current range. If automatic current ranging is activated, this value 

will be updated during the scan. 
 
Operational mode: Basic/Advanced, sets the access level for the operator. In Basic mode, only the 
essential method parameters are shown. In Advanced mode, more specialized parameters are 
accessible. Also in Advanced mode, the automatic selection of filters and stability settings can be 
overridden, etc.  
 
Sigview: opens a window that shows voltage and current signal trace during a measurement. Can be 
used to verify the quality of the signal and to check for i.e. overload/oscillation situations. 
 
BatchMode: opens the batch programming window. This can be used for automating measurements. 
 
4. Measurement results 
 
When a measurement is started the data are shown real time in the result graph. A right mouse click on 
the graph will give the user a number of options, including changing the graph colour and background, 
as well as copying the graph to clipboard. 
 
The buttons to the left allow additional data to be displayed ("Graphic toolbar"). Data is by default 
displayed "2D"; "3D" and "3Di" display may also be chosen. Clicking the "Cor" button after the 
measurement has finished, will start the correction mode, allowing the user to change individual data-
points. "X" shows the primary data, "Ain, ocp, pre, Q, Rs, Cs" will all open a second graph that shows 
the corresponding data when available: optional analog inputs, ocp-measurement before scan, pre-
treatment data, etc. 
 
The "Scale" button allows the scale of the graph to be adjusted via the drop down menu; clicking on the 
button itself will auto-scale the graph. "Analysis" will make a number of analysis methods available to 
the data in memory. "Edit" will allow smoothing of the scan data. 
 
The buttons on the top right of the graph activate different representations of impedance data. 
 
The tabs "Result graph" and "Result data" on top enable switching between graphical and numerical 
representation of the scan data. The "E scan" tab will show the data for analysis when an impedance-
scan method has been carried out. 
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5.  Legend panel 
 
1) "Scan" shows the scans that have just been measured or loaded as data from memory. 
"Hide all"/"Show all" will respectively hide and show all scans. In the list of scans below that, 
checking/unchecking the box next to the scan will show/hide individual scans. Note that the scan that is 
highlighted blue is the scan in active memory. This is the one that is evaluated in "Analysis", or has the 
numerical data shown in "Result data", etc. Clicking on a different scan will select that one (highlight it), 
making it available for analysis, saving, etc. 
"Save data" will save data only of the selected scan, as data file (.idf) 
"Save dataset" will save all scans, as data set (.ids) 
"Delete" will delete the selected scan 
"Delete all" will delete all scans 
"Data appear" will allow user to change the appearance of the data: lines, colours, symbols.  
 
2) "Olay" will allow the user to load data from file, to overlay it so that it can be compared to the scan 
data that was just recorded. Several scans can be loaded at the same time. All the same options apply 
as in the scan-tab. 
 
3) The "Chan" tab shows when analog inputs are sampled (advanced method parameter), it allows the 
user to show/hide analog channels in the second graph. 
 
6. Status bar 
 

 
 
At the bottom of the user interface the Status bar is located. Depending on the status of the instrument 
(idle, running a method, kind of method, etc.) a series of parameters is shown. In the case of a CV- 
scan (see figure above) it shows actual E, actual I, number of acquired data points so far, cycle 
number, runtime of the scan and the notification that a measurement is in progress. In case an OCP 
measurement is carried out, the OCP value can also be found in the Status bar. 
Note: the values shown in the information bar may be lagging behind when high sampling rates are 
used. 
 
Note that: 
- Scans and data are by default NOT automatically s aved (unless the option is activated in the 

advanced parameters of the method). User action is necessary to save data. 
- When different electrochemical methods are used, the data cannot always be represented in 

the same graph; i.e. running a FRA-scan after a CV- scan without clearing the graph window 
will lead to unreadable graphs.  

- Running a CV-scan will automatically clear the gr aph when the next experiment is started. 
Save data before running the next experiment.  

 
 

2.8 File menu 
 
Load data: load a datafile (*.idf) from a previously stored measurement. This action will 

clear any data that might be present already. 
 
Save data: save the selected scan data to disk as *.idf. If none is selected, the most 

recent is taken. 
 
Load dataset: load a previously saved set of scans (*.ids) 
 
Save dataset: save all data in the "Scan" panel to disk in a single file as *.ids file. 
 
Save visible dataset: save all data in the "Scan" panel that is made visible in the graph, to disk in a 

single file as *.ids file. 
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Load method: load a previously saved measurement protocol (*.imf) 
 
Save method: save the current measurement protocol as *.imf 
 
Export data as ASCII: save the selected data to disk as textfile, without method information 
 
Export dataset as ASCII: the different scans from the actual dataset will be saved as ASCII in separate 

files with the addition of '_x' to the filename, with x the sequence number of 
the scan. 

 
Import data as ASCII: imports a textfile as measurement data. The actual method protocol will be 

assumed to apply on this data. This action will clear any data that might be 
present already. 

 
Exit: exits the IviumSoft program 
 
 

2.9 Options menu 
 
In this menu 2 selections are possible: 
1) Options: change instrument and FRA options, see below. 
2) Register idf/ids files: clicking this option will register Ivium data files (*.idf) and Ivium data sets (*.ids) 

on your computer. This action will make it possible to double mouse click on an Ivium data file/set to 
load it in the scan panel of the IviumSoft. Note that each double click on a datafile will open a new 
instance of IviumSoft. 

 
The Options>Options menu is only available when an instrument is connected because some of these 
settings are changed inside the instrument. When the window is closed the instrument should sound a 
beep to acknowledge that the changed settings are excepted. The options menu will allow manipulation 
of:  
o Device configuration settings: parameters that control the instrument and module configuration  
o Safety settings: parameters to terminate measurement for protection of the test object  
o FRA settingsheet: parameters that control impedance measurements 
 
Environment   
· 60Hz: check this box in countries that have 60Hz mains frequency. A correct setting will strongly 

improve noise suppression, because the measurement period will be synchronised with the line 
frequency.  

· XR 20V mode : check this box to enable the 20 V potential range of the IviumStat.XR; note that the 
increased potential range decreases the potential resolution.  

· Edoubler : check this box if the Edoubler is connected (only for IviumStat20V).  
· CompactStat.8V : check this box when you are using an 8V-conversion CompactStat.  
· CompactStatPlus : check this box if the Plus-module (20V/250mA) is connected to the 

CompactStat.  
· type II : also check this box if the Plus2-module (10V/800mA) is connected to the CompactStat.  

· IviumBoost : check this box when the IviumBoost is Connected to the IviumStat; the radio buttons 
allow the correct setting for your IviumBoost.  

· MultiWE32 : check this box when you are using the MultiWE32 module.  
· Audio off : checking this option will disable the instrument's internal speaker.  
· AC input : check this box when the AC input of the peripheral port is used in method-mode. 
 
Automatic disconnect  
The automatic disconnect functions can be activated for extra protection of a testobject. When checked 
and the cut-off criterium is reached during a method-run experiment, the instrument will automatically 
disconnect the cellcable and the measurement is terminated. This is controlled from inside the 
instrument independent from the software that is running on the PC.  
· at external signal, Ext1 > : when this box is checked, the Analoginput1 of the peripheral port is 

measured. When this signal exceeds the voltage that is entered in the adjacent box, the 
measurement will be terminated.  
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· at temperature : unavailabele for change by user; when the instrument's inside reaches a 
temperature exceeding 80 degC the measurement will be terminated. This is an automatic safety 
feature to protect the instrument.  

· at Eovl (CE electrode) : when this option is checked, in galvanostatic mode the instrument will 
terminate the measurement when an E_overload is reached. The potential range can be set by 
user in the advanced method parameters.  

· at current OVL (WE electrode) : when this box is checked, in potentiostatic mode the instrument 
will terminate when a current of 3.072 x the set current range is exceeded. This option may also be 
used in combination with Automatic Current Ranging (AutoCR). 

 
When a method is aborted by the automatic disconnect feature, a message is shown on the bottom 
Statusbar. Also the condition is logged in the process-report. 
 
Note that Automatic disconnect is intended as a safety feature. It is directly hardwired in the electronics, 
therefore it works instantaneous and does not depend on whatever the software is doing at that time. 
Even in the event the software has crashed, the electrodes will still be disconnected on the alarm 
conditions. 
The automated disconnect at temperature overload will always be active, and cannot be disabled. 
 
FRA settingssheet  
· Stabilisation period: time delay after an ac-signal is applied, before acquisition is started. This 

allows the cell and instrument to reach a steady state after a new frequency or amplitude is applied. 
It can be specified as an absolute time (seconds) or as a multiple/fraction of the applied signal 
period (cycles). Both criteria must be true before the measurement starts, thus the longest of the 2 
is taken.  

· Acquisition period: time period that the ac-signals are measured. It can be specified as an absolute 
time (seconds) or as a multiple/fraction of the applied signal period (cycles). Both criteria must be 
true before the measurement ends, thus the longest of the 2 is taken. Increasing the measurement 
time will let the instrument acquire more datapoints/cycles that are used to calculate the average 
impedance, and thus give more accurate results. Range: 2s - 60s.  

· Result optimalization: set maximum number of re-measurements for each impedance point. In case 
of an overload or underload, the instrument will attempt to change its settings: current range and/or 
gain settings, and measure again at the new settings. This process continues until optimum settings 
are reached, or the maximum number of retries has occurred. Increasing these numbers will 
improve accuracy, but extend measurement duration.   

· Set default: will reset all FRA-setting to default values  
 
 

2.10 Tools menu 
 
Device maintenance: the device maintenance window will allow the user to diagnose the instrument, 

calibrate and upgrade instrument firmware. Also in this window the idle sampling 
of the instrument may be disabled.  

Restore device: this option is only available when the instrument is not connected in the software. 
When not connected this option may be used to return the instrument to factory 
settings, factory firmware or previous firmware.  

Performance test: opens a window to run a performance test of the instrument.   
Pulse generator: opens a window that allows operation of the pulse generator.  
CurrentInterrupt: opens the window to operate the CIM (Current Interrupt Module).  
Define channels: to define sModules as channel; only available with an Ivium-n-Stat  
 
 

2.11 Help menu 
 
Contents: lists the topics on which help is available. 
 
Topic search: search for help on specific topics. 
 
Help on help: how to use the online help tool. 
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2.12 About 
 
This opens a window that shows the release version of the IviumSoft that is running.  
 
 

2.13 Internal dummy cells 
 
The instrument has 4 internal testcells: 
   
· dummy 1: 1 kOhm resistor  
· dummy 2: 100 kOhm resistor  
· dummy 3: 10 MOhm resistor  
· dummy 4: 250 ohm resistor (IviumStat) or 100 ohm resistor (CompactStat) in series with 1 kOhm 

resistor parallel over 1 uF capacitor 
 
An internal dummy cell can be selected in Direct as well as in Method mode. All internal dummies are 
measured in the 2-Electrode configuration.The external cell is disconnected while internal dummies are 
measured. Therefore, the cell cable does not need to be connected. 
 
The internal dummy cells are used for calibration of the instrument, or for performance tests, see Test-
1. Internal dummy cells are not available for the Ivium-n-Stat.     
 
 

2.14 Testcell1 module 
 
The instrument is delivered with a standard testcell, "TestCell1". It has six 4 mm sockets that 
correspond with the cell cable leads. Each lead should be plugged in before measurement. 
 
The testcell contains a number of resistors:  
· 1 kOhm between CE and WE  
· S is connected to WE  
· RE is connected via 100 ohm to CE  
· WE2 is connected via 100 kOhm to CE  
· GND is connected to the internal shielding of the testcell box 
 
The TestCell1 is used for testing the instrument in combination with the cell cable, see Test-2.      
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2.15 Test 1: internal dummy 1 
 
The cell cable does not need to be connected for this test (this test is not available for the Ivium-n-Stat). 
Start the instrument as described, go to Method mode and load the measurement procedure TEST1.imf 
that was supplied by the manufacturer (standard: C:\IviumStat\datafiles). Measurement procedures can 
be loaded with the "Load method" function from the File Menu. Press Start, and the instrument starts 
the measurement. When completed, the result should look like the plot below. 
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2.16  Test 2: standard testcell 
 
The cell cable must be connected to the instrument and the testcell, as described. Start the instrument 
as described, go to the Methode mode and load the measurement procedure TEST2.imf that was 
supplied by the manufacturer. Measurement procedures can be loaded with the "Load method" function 
from the File Menu. Press Start, and the instrument starts the measurement. When completed, the 
result should look like the plot below. 
 

  
 
 

2.17 Test 3: standard testcell & BiStat 
 
The cell cable must be connected to the instrument and the testcell, as described (this test is not 
available for the Ivium-n-Stat). Start the instrument as described, go to Method mode and load the 
measurement procedure TEST3.imf , that was supplied by the manufacturer. Measurement procedures 
can be loaded with the "Load method" function from the File Menu. Press Start, and the instrument 
starts the measurement. When completed, the result should look like the plot below. 
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Note that the bipotentiostat result, here plotted in blue, is referenced to the right axis. In some cases, 
automatic scaling will cause both curves to be drawn exactly over each other. To identify the separate 
curves, use the Show Left/Right axis option.  
 
 

3. Direct control 
 

3.1 Direct control 
 
The instrument can be controlled directly from the Direct control sheet and simple measurements can 
be performed. This is intended for very simple measurements, diagnostics or trouble shooting. Normal 
measurements are controlled from the Method sheet. 
It is important to note that the method settings ar e not related to the direct control settings. 
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The Direct control sheet:  
· Top panel:  

DC/AC: normally DC is active and DC signals are measured, pressing the AC setting will enable the 
ac tabsheet below that allows the application of ac signals, and AC signals are measured and 
shown in the measurement panel.  
IRcorr: turns on the online IR correction by current feedback. The settings are controlled from the 
IR-comp sheet below. 
HiSens: turns on the 4 lower current ranges. As these rely on the postgain amplifier, this option 
cannot be used simultaneously with IRcorr or in galvanostatic mode. 
Zstat: for using the instrument as constant load (constant Z). This option is not available.  

· Measurement panel: displays E and I in idle mode, or Rs and Cs when impedance measurements 
are running. When no potential/current is controlled E and I display open cell values (within 
specified accuracy). In idle mode when the instrument is connected, the actual current and potential 
are updated regularly (once/second).  

· Current range radiogroup: allows setting of the current range manually. Please note that in 
Galvanostatic mode, the current range is selected automatically, depending on the applied current.  
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· Connect group: this controls the connections to the electrode, internal dummy cells, Bipotentiostat, 
and potentiostatic/galvanostaticoperation. For connections to external cells, also the checkbox must 
be enabled. Available configurations: 
- Off: default, cell is switch off and instrument is placed in idle configuration (open cell). 
- Cell Estat4: potentiostatic operation with 4 electrodes. 
- Cell Estat2: potentiostatic operation with 2 electrodes, WE and CE.  
- 1 kOhm Estat: potentiostatic operation with internal 1 kOhm resistor.  
- 100 kOhm Estat: potentiostatic operation with internal 100 kOhm resistor. 
- 10 MOhm Estat: potentiostatic operation with internal 10 MOhm resistor. 
- R(RC) Estat: potentiostatic operation with internal 250 ohm resistor (IviumStat) or 100 ohm 

resistor (CompactStat) in series with a 1kohm resistor placed in parallel with a 1 µF capacitor. 
- Cell Istat4: galvanostatic operation with 4 electrodes. 
- Cell Istat2: galvanostatic operation with 2 electrodes, WE and CE.  
- Dummy Istat: galvanostatic operation with internal dummy cell. 
- Cell Bistat4: potentiostatic operation with 4 primary electrodes, and the bipotentiostat WE2. 
- Cell Bistat2: potentiostatic operation with primary electrodes WE and CE, and the bipotentiostat 

WE2.  
· Stability: set bandwidth of the applied signal, hispeed/standard/high stability.  
· Filter: set filter of measured signals, 1MHz/100kHz/10kHz/1kHz/10Hz. These filters are applied to 

all measured signals: current, potential, and bipotentiostat current.  
· Apply: set the potential in potentiostatic mode or current in galvanostatic mode; enter the value in 

the box and click "Apply" to apply the signal.  
· Set Mux channel: for manually choosing the channel to be measured of the multiplexer. Enter a 

channel number in the adjacent box directly or use the arrows to increase/decrease channel 
number. After setting the desired channel, click on "Set Mux channel" to activate this channel.  

· Set WE32 channel: for manually choosing the WE32-channel to be measured of the MultiWE32-
module (only available when MultiWE32 module is active). Enter a channel number in the adjacent 
box directly or use the arrows to increase/decrease channel number. After setting the desired 
channel, click on "Set WE32 channel" to activate this channel.  

· Automatic E ranging: when unchecked, the potential measurements are done on the widest range. 
Therefore the resolution for measured potential is limited: 0.125mV for CompactStat, 0.333mV for 
IviumStat, etc. When checked (default), the instrument will automatically choose a more sensitive 
range if possible. This will increase resolution to below 1uV.  

 
At the bottom of the Direct-sheet some tabbed pages are located. Some of these tabs are only visible if 
the configuration allows this:  
· BiStat: to configure the bipotentiostat; this page is only visible when the "Cell BiStat" is activated in 

the connect group.  
· AC: to apply directly a sine wave of chosen/indicated frequency and amplitude.  
· Extern: to read and set signals of the peripheral port: 

- analog input: the potential on all 8 analog inputs will be measured, when the button "Read analog 
inputs" is pressed. 

- analog output: set the potential of the 2 analog output ports (enter the value in the box and click 
"ch1" or "ch2" to activate the value for that channel). 

- digital output: set the levels of the 3 digital output ports by checking/un-checking the adjacent box.  
- digital input: read the levels of the 2 digital input ports (click the "Read" button). 
- Ext ACin  1.0 X: when checked, the analog or ac signal connected to pin 9 of the peripheral port 

will be superimposed on the DC signal that is set in the Direct mode (multiplied by 1).  
· IR-comp: to configure the online IR correction by current feedback. Clicking "Calculate" will give the 

maximum compensation possible in the selected current range. Entering the desired value in the 
box and clicking "Apply" will apply the IR-compensation.  

· PDA: when one or more PDA-modules are used, in this tab page the values of the analog inputs 
can be read. 
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3.2 SigView 
 
The Signal Monitor window is accessible by clicking on "SigView" in the top function bar (advanced 
parameters, see "Screen layout"). 
 
1) In Direct control mode, the signal can be observed in an oscilloscope type of screen: current and 
potential vs time. This can help to diagnose connection problems, and find sources of noise. The 
operator can manipulate the timebase in direct mode. 
 

  
 
Top panel: 
- Rescale: clicking will rescale the graph. 
- Options: shows graph options. 
- Copy: copy graph to clipboard. 
- Freq: shows frequency based signal. 
- Sample: when clicked will give a signal sample. 
- Auto: shows continuous signal trace. 
- Hide: hides the window. 
 
Graph: 
- Black plot corresponds to left axis, Blue plot corresponds to right axis. 
- Left axis: Current/% of full current range as selected. 
- Right axis: Potential/% of full range as selected (by automatic E ranging or maximum range). 
 
Lower panel: 
- Period: enter period of measurement. 
- I = actual I value with accuracy interval 
- E = actual E value with accuracy interval 
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2) During an impedance measurement (Method control), the perturbing and resulting sine waves are 
shown, with the actual filter and amplifier settings. This will give a good idea about the quality of the 
result and may be useful for experimental optimizations. 
 

 
 
Top panel: 
- Rescale: clicking will rescale the graph. 
- Options: shows graph options. 
- Copy: copy graph to clipboard. 
- Freq: shows frequency spectrum. 
- Hide: hides the window. 
 
Graph: 
- Black plot corresponds with left axis, Blue plot corresponds with right axis. 
- Left axis: Current/% of full current range as selected. 
- Right axis: Potential/% of full range as selected (by automatic E ranging or maximum range). 
 
Lower panel: 
- Freq = actual applied frequency 
- CR = actual current range 
- Igain = gain value for current measurement 
- Egain = gain value for potential measurement 
- Filter = filter number 
- Coupling = internal signal coupling code 
 
3) During an impedance measurement the signal traces for each data point are stored in the datafile 
and can be recalled to be investigated/analyzed later. Not only the data is stored, but also the 
measurement settings: Current range/ overload flags/etc, for each individual frequency. To display the 
specifics of a datapoint, first open the Signal monitor, and point the mouse at the datapoint in question 
(on the graph of an opened impedance measurement). The Signal view will show the data in Recall 
mode: 
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In the example above, the E/I traces are displayed in recall mode. It also shows the current range, 
which is useful if AutoCR was active. If this datapoint was obtained in an overload situation, the status 
would indicate this. Furthermore, the original date and time of acquisition are shown: mm/dd/yyyy 
hh:mm:ss. 
 
Note that the display in Recall mode is different from the AC signal monitor shown during the EIS scan: 
Lower panel: 
- Freq = actual applied frequency 
- CR = actual current range 
- Zabs = value for Z_abs 
- Status: status of overload situation for this datapoint 
- Phase = actual phase angle 
- Date/time of actual data point  
 
 

4. Method control 
 

4.1 Method control 
 
From the Method control panel the operator can define a technique or measurement protocol on the 
Method sheet. When the Start button on the taskbar is pressed, this measurement protocol is executed. 
In this state, the software takes control over the instrument: Method control. This will last until the 
measurement is completed or aborted by the user. During Method control, the Direct control functions 
are not available, neither are some filing and analysis functions. 
 
When during Method control the Abort button is pressed, the measurement is halted immediately. 
However in some cases there maybe a quantity of data pending in the buffers, which has to be 
processed, and it may take a while (up to a few seconds) before the software appears to return from 
method control. 
 
During method control while the method is running, the number of commands that can still be accessed 
is limited. However, at the bottom of the result graph sheet, depending on the electrochemical method 
running, some commands may be available, i.e. to pause the ongoing scan. 
 
Note that when the IviumSoft is closed, the method parameters of the last method that was used are in 
active memory and will show when the IviumSoft is started again.   
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4.2 Sequence of a measurement 
 
After the Start button has been pressed, a sequence of events is started:  
· first, the pretreatment stages are executed, if the number of pretreatment levels > 0.  
· thereafter, the OCP is determined, if that option was activated  
· thereafter, the equilibrium stage is applied, if the equilibration time >0. The equilibrium potential is 

equal to E_start.  
· thereafter, the actual measurement technique is applied: LSV/CV etc..   
 
 

4.3 Method sheet 
 
The Method sheet contains all parameters to set up an automated 
measurement. This is the normal way measurements are conducted. 
Please note that the settings on this sheet are not related to the 
direct control settings. 
 
From the top: 
 
Method history list: quickly select a predefined measurement 
protocol that was stored before. 
 
Method tree: select the measurement technique from a structured 
list. You can expand nodes by clicking on the "[+]" boxes. 
 
Method parameter grid: set the values of each method parameter:  
· The first column lists the parameter name. If a parameter 

contains subparameters, a "+" symbol will be displayed in front 
of it. When such a parameter is activated, the subparameter 
names will appear below it, indented.  

· The second column allows you to edit the parameter values: 
- text parameters can be entered by typing any string of 

characters 
- value parameters can be entered by typing numerical 

characters, non-numerical characters are ignored. On leaving 
the field, the value is tested against its allowed limits. 

- boolean (on/off) parameters can be set by (un-)checking the 
checkbox 

- enumerated (list) values can be set by selecting the desired 
item from the dropdown list. The dropdown arrow will appear 
when the field is selected. 

- dialog variables are displayed with a square button in the grid. 
When this button is pressed, a dialog screen appears with the 
group of variables.  

· The third column will indicate the unit of the parameter, if 
applicable. 

 
Note that pressing F1 will provide an explanation of the currently 
selected parameter. 
 
When exiting the Iviumsoft program, the actual method parameters 
are saved. When IviumSoft is restarted, these are reloaded. In this 
manner, new sessions can continue where the previous ended.  
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4.4 Result graph sheet 
 
Here the results are shown in graphical form. 
 

 
 
On top, the graphic toolbar is shown. 
On the right, the legend panels are shown 
 
In the center, the data-plots are shown. The results of the primary measurements are always shown, 
and optional 1 or 2 additional graphs are shown. Extra graphs are accessible through the buttons to the 
left of the graph:  
· X: show primary data.  
· Ain: Analog peripheral inputs: up to 8 channels can be displayed in 1 or 2 extra graphs. These 

values can be shown as measured, in Volt. Or they can be transformed with user defined functions, 
thus showing physical parameters as temperature/pressure/etc. If 2 types of transformations are 
required, 2 groups of analog inputs can be assigned to different graphic windows. Data options are 
available from the Method sheet - advanced parameters - Data options.  

· ocp: if the "wrt OCP option" was selected, this window will show the results of the measured Open 
Cell Potential vs time.  

· pre: Pretreatment data: if pretreatment stages are applied, this window will show the results of the 
data obtained during these stages.  

· Q: will show the charge passed (only if applicable).  
· Rs: will show the Rs value (only if applicable).  
· Cs: will show the Cs value (only if applicable). 
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At the bottom of the graph sheet, depending on the method used, some extra method commands may 
show. For example:  
· In cyclic voltammetry, the "Reverse scan" and "Pause/Resume" buttons are shown. These can be 

used during a scan to temporarily pause the scan or to reverse the scan direction.  
· During a ChronoAmperometry scan in standard mode, a button appears with a potential-input-field. 

Any valid potential can be typed. After pressing the "Apply direct" button, the new potential will be 
applied to the cell immediately after the next measured point. This potential will be applied for the 
remainder of the presently executing level.  

· An ongoing chronamperometric scan, in standard speed (sample interval > 2ms) can be paused by 
pressing the Pause button, at which it will maintain the momentary potential applied. Pressing the 
Resume button will continue the scan sequence, as defined by the method. During a Pause period, 
the data is not recorded. 

 
 

4.5 Graph options 
 
A right mouse click over the graph will allow the graph options to be selected, resulting in the 2 windows 
shown below (3D parameters only show when 3D graph is selected): 
 

 
 
 

4.6 Graph popup menu 
 
When the mouse is moved across a particular graph and the right-mouse-button is pressed, a pop-up 
menu appears:  
· Autoscale: performs autoscale on all axis  
· Graph options: manipulates plot appearance: titles, background colors, etc.  
· Data appearance: manipulate appearance of the data: lines/symbols/colors/styles/etc.  
· Scale X axis: scale the horizontal axis manually or automatically   
· Scale Y axis: scale the (left) vertical axis manually or automatically   
· Scale Z axis: in 3D plots scale the depth axis manually or automatically, in twin axis plots scale only 

the right vertical axis manually or automatically  
· Copy graph: copies graph to clipboard  
· Print graph: send graph directly to printer. The standard Windows printer-dialog will appear at which 

the printer & properties can be selected.  
· Set phase: opens a window to change the phase for phase sensitive AC voltammetry.  
· CV plots: opens a separate graph where data for cyclic voltammograms can be represented by 

users choice: I vs E, I vs time, E vs time; a right mouse click will allow this graph to be 
copied/printed: 
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4.7 Legend panels 
 
To the right of the Result graph sheet, the legend panels are shown. These panels allow the selection 
of particular scans, that can be manipulated/saved/analysed etc. Clicking on a particular scan will make 
that scan available for manipulation etc. (it will be highlighted blue, independent of whether the box next 
to it is (un)checked).  
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Scan panel : recently measured data will be shown here:  
· Datalabel selector: optionally shows the numerical values of the datapoints in the plot. It is possible 

to show only every nth datalabel.   
· Scanlist: displays a checklistbox of all available scans. Scans can be made (in)visible by 

(un)checking the corresponding box. Scans can be selected by clicking them with the mouse, these 
will appear blue.  

· Save data: saves the selected data to disk as *.idf. If none is selected, the most recent is taken (at 
the bottom of the list).   

· Save dataset: saves all listed data to disk in a single file as *.ids.   
· Delete: deletes the selected data.  
· Delete all: deletes all listed data, clears the list.  
· Data appearance: manipulate data appearance of the data: lines/symbols/colors/styles/etc. 
 
When multiple scans are displayed, it is possible that each was measured at different conditions. The 
method parameters of each individual scan can be viewed by a right-click of the mouse button while the 
mousepointer is on the scan in question in the Legend panel. A form with the corresponding data will 
pop up. In this form, it is also possible to edit the Title of this single scan: retype, and press the Change 
button. 
Additionally, the specific parameters of the selected plot will be copied into the Method parameter 
panel, when the CTRL key is pressed while the scan was selected: keep the CTRL key pressed and 
click on the scan-name in the Legendpanel. 
Note that this will change the active Method parameters. If thereafter Start were pressed, it would start 
a scan using the parameters of the selected scan. However the use of the CTRL key should  avoid 
unintentional modification of the active parameters.  
The latter function can also be used after reading a previously recorded Dataset. 
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Chan panel : when recorded, shows the results of the analog input channels of the peripheral port 
(when no analog inputs are entered in the method parameters, this tab will be invisible). 
· Channel list: displays a checklistbox of all available channels. Channels can be made (in)visible by 

(un)checking the corresponding box.   
· Option: manipulate plot appearance: titles/background colors etc..  
· Data appearance: manipulate appearance of the data: lines/symbols/colors/styles/etc.  
· Copy: copies plot into clipboard (WMF format) 
 
Olay panel : overlays data from previous measurements  
· Overlay list: overlays can be made (in)visible by (un)checking the corresponding box.  
· Load: loads a datafile (*.idf) that will be overlaid. Multiple files can be overlayed at the same same 

by keeping the CTLR or Shift buttons pressed while selecting the files.   
· Overlay Dataset: loads a complete Dataset file (*.ids) as overlay.  
· Delete: deletes the selected overlay data.  
· Delete all: deletes all listed overlays, clears the list.  
· Data appearance: manipulate data appearance of the overlay data: lines/symbols/colors/styles/etc. 
 
NB in all 3 panels, all (in-)visible checkboxes can be checked at once by pressing "show all", and 
unchecked by pressing "hide all".   
 
 

4.8 Data appearance 
 
A right mouse click on the graph or a click on the button at the bottom of the legend panel will make the 
data appearance available. This will allow the user to choose the colors for the lines and the 
colors/size/appearance of symbols in the graph. 
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4.9 Graphic toolbars 
 
Above and to the left of the Result graph, two graphic toolbars are shown. These contains a number of 
tool buttons, that are visible depending on the data that is present: 
 

 
 
 
To the left, a vertical toolbar is displayed:  
· 2D/3D/3Di: selects 2- or 3-dimensional presentation. The assignment of the 3rd axis depends on 

the result type. I.e. for scan techniques, the 3rd axis equals the scan sequence number, while for 
nyquist plots, the 3rd axis equals the frequency. In the latter case the 3rd axis can be forced to 
show the sequence number by selecting "3Di".  

· Zm/Cor: set Zoom or Correction mode. Standard the Zoom mode is selected, in which you can 
expand parts of the plot by left-click and drag the mouse cursor. In Correction mode you can correct 
erroneous data points: 
- select the point to be edited with a left-mouse-click  
- while keeping the left-mouse button pressed, drag the point up or down to the desired location in 

the graph 
- release the mouse-button, and the data point will be updated 
- Note that the correction tool will change the measured datapoint, and should be used with care.   
- when the point to be edited is right-mouse clicked, the option to delete the data point 

appears.Note that deletion is irreversible. Be sure to save the data before performing this action.  
· L/R/2nd: Left/Right twin axis selector. If the double vertical axis presentation is active (i.e. for 

impedance measurements), you can select to hide either the left or the right axis, by depressing 
L/R. Or you can split the graph into 2 separate plots by pressing "2nd".   

· N/F/B scanned pulse visualization: at Differential pulse or Square wave voltammetry also forward 
and backward current can be shown: 
- N: normal, difference (forward-backward) is shown 
- F: forward, forward current is shown 
- B: backward, backward current is shown  
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· X/Ain/ocp/pre/Q: display a 2nd graph above the primary data graph, Ain = analog inputs, ocp = 
OCP data, pre = pretreatment data, Q = integrated current (charge), while X will hide the secundary 
data graph.  

 
On top, a horizontal toolbaar is displayed:  
· Scale: clicking "Scale" will autoscale the current graph on all axis;   

The drop down menu will allow: 
Autoscale: performs autoscale on all axis 
Scale X axis: scale only the horizontal axis manually or automatically  
Scale Y axis: scale only the (left) vertical axis manually or automatically  
Scale Z axis: in 3D plots scale only the depth axis manually or automatically, in twin axis plots scale 
only the right vertical axis manually or automatically  

· Analysis (see also "Analysis" chapter): 
- Equivalent circuit: to fit measured impedances with an equivalent circuit 
- Corrosion rate: to analyze and calculate corrosionrate from linear polarisation scans 
- Peakfind automatic: to determine location and height of peaks automatically 
- Peakfind advanced: to determine location and height of peaks manually and to subtract baseline 
- Clear peaks: to remove peaks from the screen that were created with Peakfind analysis 
- Electrochemical noise: to analyse chemical noise results with FFT and/or MEM  
- Find levels: "level finding" tool for chronopotentiometric data 
- Solar cell report: complete analysis of a solar cell from FRA experiments 
- Curve fit: to fit arbitrary polynomials 
- Electrolysisreport: will analyse and display the passed charge and current  

· Edit (see also "Edit" chapter): 
- Edit data: data smoothing functions, based on Savitzky-Golay or Fourier transformation, and 
change data point 

- Smooth all data: automatically smooths all data according to the prevailing smoothing settings. 
(Note:  once pressed the raw data is replaced by the smoothed data, so save data before using). 

- Subtract ohmic drop: to correct by calculation the potential-loss due to the effects of ohmic 
resistance on Linear scans and Cyclic Voltammograms 

- Average scans: automatically averages scans in a dataset 
- Subtract overlay[1]: subtracts overlay graph from scan graph 
- Add overlay[1]: adds overlay graph to scan graph  

· Impedance plot selection: set graphical presentation of impedance data 
- |Z|, Phi: Bode plot, the absolute impedance is plotted with the left, and the phase angle is plotted 

with the right axis 
- Rs, Cs: the Rs is plotted with the left, and the Cs is plotted with the right axis 
- Z',Z'': Nyquist plot, impedances-Z'' is plotted vs Z'. In 3D, the frequency is on the depth axis 
- Y',Y'': Admittances -Y'' is plotted vs Y'. In 3D, the frequency is on the depth axis 
- Z, freq: the Z' is plotted with the left, and the Z'' is plotted with the right axis 
- Y,freq: the Y' is plotted with the left, and the Y'' is plotted with the right axis 
- epsilon: the 10log(e') is plotted with the left, and the 10log(e'') is plotted with the right axis: the 

complex permittivity. The permittivity is defined as: 
Epsilon = - j * Addmittance / (2*pi*freq * Cap0) 
with j the complex variable, freq the frequency, and Cap0 the reference capacity. This reference 
capacity equals the capacity of an "empty" cell, and it should be defined by the user. It can be 
changed in the Data Options method parameter, on the Electrode tabsheet. 

- Tan(d): the Tan(delta) is plotted with the left, and the Cs/C0 is plotted with the right axis: the so 
called Loss Tangent. The Loss Tangent is defined as the ratio of real and imaginary impedance. 

- Cole: Cole-plot, the -Y''/w is plotted vs Y'/w  
· E/I value correction: when in the method parameter "Data options" an offset potential or an 

electrode surface area are entered, the graph data can be updated for these values 
- Ecor: updata graph for E_corrections 
- Idens: updata graph for electrode area (current density)  
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4.10 Result data sheet 
 
Here the results are shown in numerical form. 
 

 
 
The top toolbar contains 2 buttons: Refresh and Export. Refresh updates the displayed data, and 
Export opens dropdown list with options for data export:  
· Copy all to clipboard: places all numerical data from the grid into the clipboard  
· Copy selected to clipboard: places the selected numerical data from the grid into the clipboard.  
· Save all to disk: saves all the numerical data from the grid into the clipboard  
· Save selected to disk: saves selected numerical data from the grid into the clipboard 
The data is formatted as shown in the grid, thus as characters. Note that non-visual digits are lost, and 
it is advisable to set the appropriate units first. 
 
Show data: defines which data is shown:  
· selected data: shows only data that is selected in the Scan Legend. Usually this is the most recent 

scan.  
· all data: shows all data that is listed in the Scan Legend; when the "sequentially" box is ticked, the 

data will be shown sequentially in one column  
· extended dataset: shows the selected scan, together with the data from the external analog inputs.  
· OCP values: when an OCP measurement is selected, this will show the numerical OCP data; these 

can be subsequently copied and exported. 
 
Current units: set the format of the displayed current values.  
 
Potential units: set the format of the displayed potential values. 
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Time units: set the format of the displayed time values.  
 
Impedance: select the parameters of impedance data to be shown 
 
Format: when the box is ticked the values are shown in scientific notation with a 2 digit exponent; this is 
especially useful when small values are shown since by default only 4 digits are displayed. 
 
 

4.11 E scan sheet 
 
When an impedance scan is carried out, the "E scan" tab will show next to the "Result graph" and 
"Result data" sheet. This will allow impedance data to be plotted and evaluated. Also Mott-Schottky 
analysis done here (see "Analysis" chapter).  
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5. Techniques 
 
Available Methods: 
 
LinearSweep LSV 
o Standard: staircase voltammetry, records current at the end of each step  
o CurrentAveraging: records average currents (integrated) over each step 
o TrueLinear: applies true linear voltage ramp, requires optional LinScan module 
o Galvanostatic: staircase potentiometry, records potential at the end of each step  
 
CyclicVoltammetry CV 
o Standard: cyclic voltammetry, records current at the end of each step  
o CurrentAveraging: records average currents (integrated) over each step 
o TrueLinear: applies true linear voltage ramp, requires optional LinScan module 
o Galvanostatic: cyclic potentiometry, records potential at the end of each step  
 
Transients TR 
o ChronoAmperometry: applies up to 255 voltage steps, and records current 
o ChronoPotentiometry: applies up to 255 current steps, and records potential 
o MixedMode: applies up to 255 definable steps, records current & potential & impedance 
o Electrochemical Noise: corrosion measurement, records current & potential at 2 separate working 

electrodes 
 
ElectroAnalysis  
o Amperometric detection  
o Differential Pulse  
o Square Wave 
o AC Voltammetry 
o Potentiometric Stripping Analysis 
o AC detection  
o Normal Pulse Voltammetry 
 
Impedance EIS 
o Controlled E: voltammetric frequency scan at a fixed DC potential 
o Controlled I: galvanostatic frequency scan at a fixed DC current 
o PotentialScan: voltammetric frequency scans for a range of DC potentials 
o CurrentScan: galvanostatic frequency scans for a range of DC currents 
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5.1 LinearSweep Standard  
 

 
 
A linear potentialsweep is created by updating the potential with E_step at each interval, so that a 
staircase scan is applied to the cell with a defined scanrate. 
The interval is defined by E_step/scanrate. The recorded currents are measured at the end of each 
interval (unless the Alpha parameter is activated). Standard mode allows for interval times down to 
0.002 s, for shorter intervals use HiSpeed mode.  
 
 

5.2 LinearSweep CurrentAveraging 
 
A linear potentialsweep is applied, identical to LinearSweep Standard. 
However, instead of recording the current at the end of each interval, the current is integrated during 
the whole interval and divided by the interval time. This results in the average current during each 
potentialstep. In some situations, this technique yields the same results as when using a True Linear 
Scan technique. 
 
This particular technique can be used when the standard staircase method does not give the desired 
results, such as experiments involving time dependent phenomena such as film formation or 
electrochemical nucleation.  
The CurrentAveraging method is more sensitive to capacitive currents. When that is undesirable, the 
standard variant is more appropriate.  
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5.3 LinearSweep TrueLinear 
 
A continuous linear analog potentialsweep is applied, instead of the standard staircase. 
The E_step variable defines the interval time. The interval is defined by E_step/scanrate. The recorded 
currents are measured at the end of each interval. Standard mode allows for interval times down to 
0.002 s, for shorter intervals use HiSpeed mode.  
 
 

5.4 LinearSweep Galvanostatic 
 
This is similar to the Standard potentiostatic sweep, but now galvanostatic. A linear currentsweep is 
created by updating the current with I_step at each interval, so that a staircase scan is applied to the 
cell with a defined scanrate. 
The interval is defined by I_step/scanrate. The recorded potentials are measured at the end of each 
interval (unless the Alpha parameter is activated). Standard mode allows for interval times down to 
0.002 s, for shorter intervals use HiSpeed mode.  
 
 

5.5 Cyclic voltammetry 
 
Generic features of all cyclic voltammetry techniques are: 
 
1) When a CV scan is running (standard speed), the datapoints appear real-time on the screen. It is 

possible for a user to react directly on the result, and change a vertex by mouse-click. During a CV 
scan, the operator can reverse the scan direction immediately by pressing the "ReverseScan" 
button at the bottom of the Result graph sheet. Clicking the button is only effective when the scan is 
moving away from "E start", thus the scan-range can be constricted, but not extended. The new 
vertex is applied to the ongoing cycle only.  
Also an ongoing scan can be paused with the "Pause" button: during a pause, the applied 
potential/current will be kept constant, and the instrument will suspend measurements. A paused 
scan can be continued by pressing the "Resume" button. 

 
2) Cyclic Voltammograms are usually displayed as Current vs Potential, but also the Current vs time 

and Potential vs time plots can be shown. Note that the interval time between 2 consecutive 
datapoints equals Estep/Scanrate. 
To show the CV-time plots, move the mouse on the resultplot, right click and select "CV plots". 

 
3) For plots with Cyclic Voltammograms, the scan direction can immediately be recognized: the scan 

in positive direction is plotted in a thicker line that the negative direction.  
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5.6 CyclicVoltammetry Standard 
 

  
 
Each scan consists of 3 linear segments: E_begin to Vertex 1, Vertext 1 to Vertex2, and Vertext 2 back 
to E_begin.  
The segments are created by increasing the potential with E_step at each interval, so that a staircase 
scan is applied to the cell with a defined scanrate. 
The interval is defined by E_step/scanrate. The recorded currents are measured at the end of each 
interval (unless the Alpha parameter is activated). Standard mode allows for interval times down to 
0.002 s, for shorter intervals use HiSpeed mode. 
 
In standard mode the number of datapoints is unlimited, in HiSpeed mode a maximum of 32,000 
datapoints applies. 
 
 

5.7 CyclicVoltammetry CurrentAveraging 
 
Linear potentialsweeps are applied, identical to the standard variant. 
However, instead of recording the current at the end of each interval, the current is integrated during 
the whole interval and divided by the interval time. This results in the average current over each 
potentialstep. In some situations, this technique yields the same results as when using a True Linear 
Scan technique. 
 
This particular technique can be used when the standard staircase method does not give the desired 
results, such as experiments involving time dependent phenomena such as film formation or 
electrochemical nucleation.  
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The CurrentAveraging method is more sensitive to capacitive currents. When that is undesirable, the 
standard variant is more appropriate.  
 
 

5.8 CyclicVoltammetry TrueLinear 
 
Continuous linear analog potentialsweeps are applied, instead of the standard staircase. 
The E_step variable defines the interval time. The interval is defined by E_step/scanrate. The recorded 
currents are measured at the end of each interval. Standard mode allows for interval times down to 
0.002 s, for shorter intervals use HiSpeed mode.  
 
 

5.9 CyclicVoltammetry Galvanostatic  
 
This is similar to the Standard potentiostatic sweep, but now galvanostatic. 
Each scan consists of 3 linear segments: I_start to Vertex 1, Vertext 1 to Vertex2, and Vertext 2 back to 
I_start.  
The segments are created by increasing the current with I_step at each interval, so that a staircase 
scan is applied to the cell with a defined scanrate. 
The interval is defined by I_step/scanrate. The recorded potentials are measured at the end of each 
interval (unless the Alpha parameter is activated). Standard mode allows for interval times down to 
0.002 s, for shorter intervals use HiSpeed mode. 
 
In standard mode the number of datapoints is unlimited, in HiSpeed mode a maximum of 32,000 
datapoints applies.  
 
 

5.10 Transients ChronoAmperometry 
 

 
 
During chronoamperometry, a single or a series of potential pulses (max. 255) is applied, and the 
current is recorded. The timebase of the experiment is set by the interval time, it defines the 
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measurement speed and the pulse duration. The minimum interval time is 10 µs, and the maximum 
level duration is 4E9 times the interval time. 
 
At interval times larger than 2 ms, the standard mode can be applied. Here the number of datapoints is 
unlimited. 
For interval times shorter than 2 ms, the HiSpeed mode must be applied. In HiSpeed mode, the 
maximum number of datapoints is 8192. 
 
In standard mode, the multicycling option can be applied. 
 
During ChronoAmperometry, the user can change the applied potential manually, without stopping the 
experiment. The operator may specify potentials that deviate from the fixed potential levels that were 
pre-defined in the procedure method. This feature gives the user the possibility to react directly on an 
observed event. It can be especially useful for long duration experiments. 
During a ChronoAmperometry scan in standard mode, a button appears below the Result graph, with a 
potential-input-field. Any valid potential can be typed. After pressing the "Apply direct" button, the new 
potential will be applied to the cell immediately after the next measured point. This potential will be 
applied for the remainder of the presently executing level. 
Note that if this feature is used, the sequence of applied potentials will no longer be completely defined 
by the methodfile, and "user intervention" is not recorded. This may hinder the repeatability of 
experiments. 
 
An ongoing chronamperometric scan, in standard speed (sample interval > 2ms) can be paused by 
pressing the "Pause" button below the graph, at which it will maintain the momentary potential applied. 
Pressing the "Resume" button will continue the scan sequence, as defined by the method. During a 
Pause period, the data is not recorded.  
 
 

5.11 Transients ChronoPotentiometry 
 
During chronopotentiometry a single or a series of current pulses (max. 255) is applied, and the voltage 
is recorded. The timebase of the experiment is set by the interval time, it defines the measurement 
speed and the pulse duration. The minimum interval time is 10 µs, and the maximum level duration is 
4E9 time the interval time,  
 
At interval times larger than 2 ms, the standard mode can be applied. Here the number of datapoints is 
unlimited. 
For interval times shorter than 2 ms, the HiSpeed mode must be applied. In HiSpeed mode, the 
maximum number of datapoints is 8192. 
 
In standard mode, the multicycling option and dynamic level switching can be applied. 
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Example of ChronoPotentiometry with 2 levels, and 4 cycles, and dynamic level switching at +0.9 Volt 
and +0.2 Volt. 
 

Same experiment as above, with CyclesSeparate option activated and plotted in 3D with cycles index 
as depth axis.   
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5.12 Transients MixedMode 
 
The MixedMode technique provides maximum flexibility. You can alternate between Potentiostatic, 
Galvanostatic and Open-cell mode. Moreover, it allows the combination of DC with Impedance 
measurements and potential/current sweeps in a single experiment:  
· Programmable switching between Potentiostatic and Galvanostatic and Open-cell mode (OCP), 

while recording dc current and potential simultaneously.   
· Potential- and Current- Sweep capability: the Estat and Istat stages can optionally be defined as 

Sweep-stages. Sweeps can be activated by checking the SweepE/SweepI option. When activated, 
values for Eend/Iend and scanrate can be entered. Note that the values for Estep/Istep are defined 
by scanrate/interval time.  

· Up to 255 levels may be sequenced. Each level can be set to Potentiostatic/Galvanostatic/Open-
cell mode. Programmed sequences can be repeated up to 65535 times.  

· Each level can be set to a fixed time duration. Also levels can be ended dynamically when 
predefined criteria are met, see table below.  

· Simultaneously, the ac impedance can be measured, in both Potentiostatic and Galvanostatic 
mode.  

· Automatic Current ranging can be used in the usual manner: 
- Only applicable for Estat stages. In Istat and OCP stages the initial current range is reset a the 

beginning of the stage.  
- If an Estat stage is preceded by another Estat stage, the starting current range is the same as the 

last current range of the previous stage.  
- If AutoCR is activated, the dynamic threshold options I<, I>, dIdt<, dIdt>, Ifraction<, |Q|> are not 

available 
- AutoCR will only decide to change current ranges based on dc-values. If the simultaneous ac-

measurement is active, the impedance is measured at the same current range as the dc-signal.  
· The analog output port from the Peripheral port can be set at the start of each level. In this manner, 

it is possible to generate complex waveforms to control external equipment: RDE-rotationrate, 
intensity of light sources, positioning of SECM, temperature of thermostats, etc. Also this feature 
may be used to synchronize external events at defined point(s) inside the measurement sequence. 
Unlike the AUX.trigger function, this may be different at each level from the start of the sequence.  

· Specifications: 
- Switching between Potentiostatic and Galvanostatic mode < 1us 
- Switching between Potentiostatic/Galvanostatic and OCP mode < 5ms  
- Minimum measurement interval time: 2ms. When AC measurements are required, the minimum 

interval time is 0.2s 
 
Dynamic level parameters: 
parameter available  
E applied Estat Applied potential 
E vs Eprev Estat Applied potential vs last measured potential of  
  previous level. If the previous stage was dynamically ended  
  from threshold criteria, the actual last applied/measured  
  potential is used. 
SweepE Estat Creates a linear sweep with E applied as start potential,  
  E_step = scanrate/interval time 
I applied Istat Applied current 
SweepI Istat Creates a linear sweep with I applied as start current,  
  I_step = scanrate/interval time 
Duration always Level duration (not when SweepE/I is active) 
Record ac Estat,Istat When checked, impedance is measured using defined  
  frequency and amplitude 
Until E> Istat, OCP End level if E exceeds value 
Until E< Istat, OCP End level if E falls below value 
Until I> Estat End level if current exceeds value 
Until I< Estat End level if current falls below value 
Until dE/dt> Istat, OCP End level if E-rate-of-change exceeds value 
Until dE/dt< Istat, OCP End level if E-rate-of-change falls below value 
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Until dI/dt> Estat End level if current-rate-of-change exceeds value 
Until dI/dt< Estat End level if current-rate-of-change falls below value 
Until An1> If enabled End level if the analog input voltage level is exceeded  
Until An1< If enabled End level if the analog input voltage level falls below  
  value 
Until dAn1/dt> If enabled End level if AnalogInput-rate-of-change exceeds value 
Until dAn1/dt< If enabled End level if AnalogInput-rate-of-change falls below 
  value 
Until Ifraction< Estat End level if I decreases > 10% 
Until|Q|> Estat End level if |Q| exceeds value 
AnOut1 always Set value for Analog Output1 at start of level 
Digouts always Set digital outputs with value at start of level  
  (8 bit conversion: 0 = all digouts off; 
  1 = digout1 on digout2and3 off, etc.) 
 
During the dc measurements, the ac amplitude is removed. The analog input threshold criteria are only 
active if the analog inputs are measured in the analog 2 channel mode. The dynamic threshold tests will 
ignore the 1st measured point after a new level was applied.  
 

 
 
Example stages: 
· Apply 50mA constant current for 100s, or until E>3.5V, record impedance   
· Switch to open cell for 5 seconds  
· Apply -50mA constant current for 100s, or until E<0.1V, record impedance   
· Switch to open cell for 5 seconds 
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Example of Mixed mode: 2 cycles with a 1F supercap using stage-protocol above: 
bottom plot in 2nd mode (= 2 separate graphs): 
o top: measured current 
o bottom: measured potential 
 
top plot (Rs activated): 
o blue dots: resistance measured at 1kHz. Note that capacitance can be shown by pressing the 

Cs button on the toolbar at the left. 
 
 

5.13 Transients Electrochemical Noise 
 
This allows for noise measurements with a standard Ivium instrument, no hardware modifications are 
required. Usually this technique is applied in corrosion research.  
 
Specifications: 
· Data sampling of E and I up to 500 samples /second, simultaneously 
· Minimum current resolution: 0.15 fA 
· Minimum potential resolution: 40nV (IviumStat), 16nV (CompactStat)  
 
A standard noise measurement uses 3 electrodes: 1 reference electrode, and 2 identical working 
electrodes. Connect these is the following manner: 
· RE to reference electrode 
· WE+S to working electrode 1 
· Gnd to working electrode 2 
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The software can evaluate the recorded results automatically. It is possible to perform the analysis in 
"Time-domain" or in the "Frequency-domain": 
 
Before an ElectroChemical Noise scan, the voltage bias can be removed. If the checkbox "Remove DC 
initial"  is checked (method parameters), the initial voltage is measured and subsequently electronically 
subtracted from the cell potential before measurement. This option can improve the sensitivity of ECN 
measurements, because it will allow for a more narrow Potential range setting with a higher resolution.  
 
 

5.14 ElectroAnalysis Amperometric Detection 
 
During amperometric detection, a potential is applied, and the current is recorded. 
The timebase of the experiment is set by the interval time.  
 
 

5.15 ElectroAnalysis Differential Pulse 
 
 
During differential pulse voltammetry, a staircase scan is applied with a superimposed pulse at the end 
of each interval. The current is measured before and at the end of each pulse, from which the 
difference is displayed. The operator can choose pulse time and height. The pulse time must be shorter 
than half of the interval time. 
Normally only the current difference is displayed. Optionally, the original measured currents can be 
viewed.   
 
In analytical experiments, the result usually appears as a peak which height is proportional to the 
concentration.  
 
 

5.16 ElectroAnalysis Square Wave 
 
During square wave voltammetry, a staircase scan is applied with a superimposed square wave. The 
interval time equals 1/frequency. The current is measured at the end of the 1st flank (forward), and at 
end of the 2nd flank (backward), from which the current difference is displayed: forward-backward. The 
sign of forward/backward pulses is defined by the scan direction. The operator can choose amplitude 
and frequency.  
Normally only the current difference is displayed. Optionally, the original measured currents can be 
viewed: forward and backward.   
 
In analytical experiments, the result usually appears as a peak which height is proportional to the 
concentration.  
 
 

5.17 ElectroAnalysis AC Voltammetry 
 
During AC voltammetry, a staircase scan is applied with a superimposed sine wave. The resulting ac 
current is measured and displayed. 
The operator may set the amplitude and the frequency of the applied ac signal 
If Phase sensitive is turned off, then the rms value is shown. If Phase is turned on, the user may choose 
the phase which will be used for detection. 
Optionally, the second harmonic current might be recorded (advanced parameter). 
 
Note: AC voltammetry is similar to the impedance potentialscan technique, but with a few differences. 
Only 1 frequency is used and the results are obtained as currents, instead of impedances. Because AC 
voltammetry must obey the time constraints of the potentialscan, no re-measurements are done and 
automatic gaining is not used. Therefore the dynamic range for accurate measurement is less, and on 
occasion flyers might be observed during automatic current range selection.  
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5.18 ElectroAnalysis Potentiometric Stripping 
 
A potentiometric stripping experiment contains 2 stages: first a product will be deposited on the 
electrode at potentiostatic conditions during a longer period, thereafter the product will be stripped in a 
relatively short time while recording the potential under galvanostatic conditions. For the second stage, 
2 variants are possible:  
· chemical stripping: occurs spontaneous at Open Cell Potential, no external current is applied 

(Current stripping option = Off)  
· electrochemical stripping: the galvanostat applies a constant current that removes the reactant 

electrochemically (Current stripping option = On) 
 
According to convention, the recorded potentials are transformed to the inverse differential w.r.t. time: 
dt/dE. This will yield a pattern of peaks that can be used to determine concentrations.  
 
 

5.19 ElectroAnalysis AC detection 
 
The technique "AC Detection" can be used to record the ac impedance with time, at a fixed frequency. 
This application is comparable to AC Voltammetry, but at a constant dc potential. The results are 
plotted as Rs and Cs, at left and right axis. Rs & Cs are determined from a circuit with a resistor and 
capacitor in series: Rs=Z1, Cs=-1/(2PI*frequency*Z2). 
 
Specifications:  
· Frequency range: 10Hz to 2MHz  
· Interval time: 0.2s to 2.5s   
 
 

5.20 ElectroAnalysis Normal Pulse Voltammetry 
 
With Normal Pulse Voltammetry a repetitive potential pulse is applied at increasing amplitude. Starting 
at a base potential (E start), a pulse with a definable pulse time is applied at each interval time 
(Estep/Scanrate). Each subsequent pulse is increased with Estep, until E end is reached.  
 
 

5.21 Impedance Constant E 
 
A range of frequencies is applied, at a constant dc potential.  
Frequencies and amplitudes can be defined by pressing the Frequencies button in the method grid. 
This will open a pop-up window where a choice can be made to apply a SingleSine or MultiSine 
method. 
 
SingleSine 
In SingleSine  mode the operator can supply the amplitude, a start- and end-frequency and the number 
of frequencies each decade. When pressing "Apply" the software will calculate automatically a 
logarithmic spread of frequencies. The operator may choose to override specific frequencies and 
amplitudes, and enter these manually (check "Manual override" box and enter values). 
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It is recommended to always start with the highest frequency, because real systems have usually lower 
impedance at higher frequencies. Starting at the lowest impedance is favorable, because the probability 
for overloads is less and the system will find the optimal set of internal gains more quickly. 
 
MultiSine 
For EIS measurements MultiSine applies multiple sine wave frequencies simultaneously, and the 
corresponding impedances are collected in a single measurement. For measurements at lower 
frequencies this can decrease measurement time considerably, and minimize artefacts caused by to 
time-variable impedances. 
 
In Multi-sine mode, 5 frequencies within a single decade are combined. By using the odd harmonics: 
1:3:5:7:9 Hz., etc. and carefully controlling the relative phase of these frequencies it is possible to 
minimise the total combined amplitude for a given effect. Thus, the maximum amplitude from the 
combination of 5 frequencies is less than 2.5 times the individual amplitudes. This minimises the signal 
degradation which is traditionally inherent in the multi-sine technique whilst still producing fast results. 
 
Compared to SingleSine, there are some constraints: 
· Start and End frequency must be at decade-boundaries  
· Manual override of individual frequencies/amplitudes is not available. The amplitudes are the same 

for all frequencies.  
· Fixed number of frequencies per decade (5) 
 
The MultiSine method is applicable for frequencies below 100Hz. However, it is possible to combine the 
SingleSine method and the MultiSine method in a single frequency scan. In the MultiSine tab simply 
select the frequency range required and the software will automatically determine which method to use 
over the frequency range. In the screenshot below, note that the frequencies above 100Hz will use the 
SingleSine method, while below 100Hz the MultiSine method is applied. Also note the logarithmic 
frequency distribution for SingleSine, and the odd-harmonic distribution for MultiSine. 
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The measurement data format will be the same as for SingleSine, each frequency will be stored 
individually. Also the data analysis is conducted in the same manner. 
 
Note that MultiSine offers faster measurement, however this is at the expense of measurement 
accuracy. If measurement duration is not an overriding issue, it is strongly recommended to use the 
standard SingleSine method. 
 
Sequence 
The measurement sequence during a frequency scan:  
· prepare the frequency: set filters, stabilization, dc-coupling, etc..  
· apply the frequency and allow the system to settle (stabilization period)  
· record current and potential during the acquisition period  
· determine theoretical optimal current range, dc bias, and gainsettings  
· if actual settings are not optimal, adjust settings, and repeat measurement  
· send result to pc, and continue with next frequency 
 
Note that for each following frequency, the settings are copied from the previous frequency. If the 
frequency-spacing is not too large, the settings are usually almost the same, and 1 or 2 attempts will 
probably give an optimal result. Therefore the first frequency will often take a longer time than the rest. 
 
Although in Advanced mode, it is possible to override automatic Filter and Stability settings, this is 
usually not recommended. 
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The results are recorded and stored in the format: Z1, Z2, frequency. However these maybe visualized 
in a number of formats:  
· Impedance plot selection: set graphical presentation of impedance data with the buttons above the 

graph. 
 
 

5.22 Impedance Constant I 
 
A range of frequencies is applied, at a constant dc current. 
The implementation is analog to the Constant E variant, except:  
· dc & ac currents should be supplied instead of potentials  
· automatic current range selection is not possible 
 
Special care should be taken with the choice of the amplitude. If the resulting ac potential gets too 
large, non-linearity effects might occur that hinder the interpretation of the result.   
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5.23 Impedance PotentialScan 
 
The implementation is analog to the Constant E variant, but it is repeated at a range of dc potentials. 
The results can be stored as single potential files *.idf, or all together as dataset *.ids. 
 
In the primary data graph, results for each potential are plotted in the usual manner: Z1Z2/Y1Y2/etc.. 
On the Escan sheet, results may be plotted vs potential:  
· Cs vs E  
· Z' vs E  
· Z'' vs E  
· Y' vs E   
· Y'' vs E  
· Mott-Schottky : 1/Cs^2 vs E 
 

 
 
Specific frequencies can be shown or hidden by clicking these in the "Select frequencies" checklist. 
Also, a specific potential range can be selected by setting the "from" and "to" in the "Select potentials" 
group.  
 
 

5.24 Impedance CurrentScan 
 
Galvanostatic impedance scans can be performed in combination with a dc Current scan, in much the 
same way as the PotentialScan variant. Select the "Currentscan" method, and set the dc scan 
parameters: Istart, Istep and Iend. The frequency scan will now be repeated at every dc-step value of 
the ramp. The results can be stored as single potential files *.idf, or all together as dataset *.ids. 
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6. BatchMode 
 
Using BatchMode, the operator can automate complex measurement sequences and interface to 
external equipment for process automation. It is possible to:  
· automatic loading and execution of method files  
· automatic saving of results  
· create loops for repetitive tasks  
· switch the multiplexer or MultiWE32 to fixed channels or to the loop index variable  
· set the digital and analog outputs  
· wait for a HI or LO level on the digital input  
· set delays and program a schedule  
· etc. 
 
The Ivium Batch language has a number of commands that may contain parameters, to be manipulated 
by the operator:  
Command Parameters Description 

 Load method file from disk LoadMethod 
Methodfile Filename of parameter file to  

be loaded 
 Execute loaded method. 
Savedatafile Filename of data to be saved (*.idf) 
Save as dataset Save data as dataset (*.ids) 
OverwriteIfExists If left unchecked, a unique  

filename will be generated by 
appending _# , where # is an 
increasing number. If executed 
within a Loop, the loopindex 
will be appended to the 
filename as L#. 

ExecuteMethod 

ClearGraph Clear plot before scan starts 
This is useful when different data 
are plotted, i.e. CV and impedance. 

 Create a repetitive loop. The  
number of loops is unlimited. 
Nesting is allowed up to 32 
levels deep. 

LoopCycles Number of repetitions 
SetMuxToIndex Switch the multiplexer channel  

to the loop-index. 

Loop 

SetWE32ToIndex Switch the MultiWE32 channel  
to the loop-index. 

LoopEnd  Set the end of the loop. Each  
Loop command must be 
matched with a LoopEnd 
command. 

 Edit a single parameter of loaded  
method.  

EditMethod 

Parameter Textual expression of the  
parameter-name 
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ValueText Textual expression of the  
parametervalue. The format of 
the supplied value must 
correspond with the type of the 
selected parametername. If 
the selected parameter is a 
checkbox, a value of 'true' will 
correspond to the checked 
condition, anything else will 
uncheck the box. Numerical 
text strings must be of the 
correct format. 

 

Incremental If unchecked (default), the new  
value will replace the existing 
one. If checked, the new value 
will be added to the existing 
parametervalue. This option is 
only valid for parameters that 
accept numerical data. 

 Execute a direct command. 
Scheduler Events can be scheduled: the Repeat  

time-timer keeps track of total time 
lapsed since the Batch was started. 
Events can be scheduled at a fixed 
time, independent of the durations of 
previous executed scans. Thus 
measurements can be repeated 
exactly every minute, hour, etc. 
Note the difference with the 
DirectCommand.Wait function, that 
adds a delay. 
To activate, check Scheduler, and set 
Repeat time variable. 
Scheduler will take precedence over 
other DirectCommands in the same 
Batchline: they will be set only after 
the Repeat timer period has passed. 

Scheduler.Repeat time Repeat period can be set: 
1 sec to 1E7 s (> 3 months) 

SetMuxChannel If checked, the channel is  
switched 

SetMuxChannel.channel Channel no#  to be set 
SetWE32Channel If checked, the channel is switched 
SetWE32Channel.channel Channel no#  to be set 
SetDAC If checked, the analog outputs are  

set 
SetDAC.DAC 1 New value for An_out 1 
SetDAC.DAC 2 New value for An_out 2 
SetDigOut If checked, the DigOuts are set 
SetDigOut.DigOut 1 On if checked 
SetDigOut.DigOut 2 On if checked 
SetDigOut.DigOut 3 On if checked 
WaitForDigIn1 If checked, the execution is  

halted until the digital input 1 
reaches the desired level, or 
timeout is exceeded. 

DirectCommand 

WaitForDigIn1.WaitForHi If checked, the system waits  
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 until a HI level is applied. If 
unchecked, it waits for a LO 
level. 

WaitForDigIn1.TimeOut Maximum period that is waited  
for the selected level on 
diginput 1. 

 

Wait Program a delay  
 
The batch-script is kept in a simple text file, and may be edited by any ASCII editor. However, it is 
strongly recommended to use the BatchEditor that is included in the IviumSoft. Making scripts is fast 
and easy with the graphical interface. The BatchEditor is activated by pressing the [BatchMode] button. 
This will open the Batch tabsheet: 
 

 
  
On top of the Batch tabsheet are the batchfile options, to load and save batchfiles. 
Below are the Methodfolder and Datafolder fields, that specify where the parameterfiles are located, 
and where the generated data should be stored. The small buttons at the right will open dialog screens 
to find folders. Before running your script, make sure all required methodfiles are in the Methodfolder, 
and that the Datafolder exists. 
 
To edit a batch-script, first select the commands in the top-grid: BatchCommand-grid. Clicking on a 
Line-field will open a selection list with the available commands. When a line in the Command-grid is 
selected, its parameters can be edited in the bottom-grid: the BatchParameter-grid. 
Above the BatchCommand-grid there are several buttons: 

[AddLine]: add a new line at the bottom of the script 
[DeleteLine]: delete currently selected line 
[InsertLine]: insert a new line above the currently selected line 
[Test]: test the script for illegal Loop constructions, or non-existing Methodfiles 
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[Start]: execute the batchscript. If the script contains errors, it will not be executed. 
[AbortLine]: abort the action on the currently executing line and proceed to the next line  
[AbortBatch]: abort the action on currently executing line and stop the batch. 

  

 
 
Example of a batchscript: measurement on 2 multiplexer channels 

Line[1]: Load method with filename "testmux1" 
Line[2]: Loop with 2 repetitions, set the multiplexer channel to loopindex  
Line[3]: Execute method and save data as "tmux"  
Line[4]: Close loop 
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7. Data analysis and reporting 
 

7.1 Current density graphs 
 
All plots that show current can be plotted as current density. When the [Idens] button on the top toolbar 
is pressed, the data will be divided by the specified surface area. The plot axis text will change to 
"Current density" and the recalculated data is shown. 
The surface area can be specified by selecting the "Data Options" method parameter, and the 
"Electrode" tab sheet. The specified area will be saved in the method file and in the datafile. 
 
Usually the area is specified before the measurement is executed. However it is possible to change the 
area afterwards: first select the scan, and in "Data Options" press apply to selected data (re-save when 
necessary). 
 
Note that the original data is not changed. Releasing the [Idens] button will show the total current again.   
 
 

7.2 Reference potential graphs 
 
All plots that show potential can be automatically corrected to refer to an offset potential or various 
reference electrodes. When the [Ecor] button on the top toolbar is pressed, the potential axis will be 
automatically corrected for the selected offset or reference electrode. The plot x-axis text will change to 
"Potential" and the recalculated data is shown. 
 
The potential correction can be specified by selecting the "Data Options" method parameter, and the 
"Ecorrections" tab sheet. The values will be saved in the method file and in the datafile. 
 
Usually the correction is specified before the measurement is executed. However it is possible to 
change it afterwards: first select the scan, and in "Data Options" press apply to selected data (re-save 
when necessary). 
 
Note that the original data is not changed. Releasing the [Ecor] button will show the total current again. 
 
 

7.3 Scaling and zooming 
 
Standard, plots are autoscaled. When a new datapoint is recorded that is outside the present graphical 
range, the scaling is adjusted to include the new point. 
It is possible to override this behaviour:  
· manually scale X/Y/Z axis: over the graph press the right-mouse button and choose the axis, or use 

the scale option from the graphic toolbar.  
· zooming: left-click the mouse on the graph, keep button pressed, and move over de area to be 

expanded. When the leftmouse button is released, the enclosed area is expanded to full scale. 
 
It is always possible to restore automatic scaling, either with the right-mouse button popupmenu, or 
pressing the scale button on the graphic toolbar.  
 
 

7.4 Clipboard functions 
 
Graphs can be stored on the clipboard, to be transferred to other applications, such as WORD or 
EXCEL. 
The graphic data is stored as WMF: windows meta file, which is vector based and can be resized 
without losses. 
To place a graph in the clipboard, move the mouse above the plot, right-click and select Copy. Or use 
the Copy function on the graphic toolbar above the plot, when available. 
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Numerical data can also be stored on the clipboard, to be copied to other applications. The data is 
stored as textcharacters in columns, separated by TAB-delimiters, and rows are separate by CR-
delimiters. This is the basic format for applications as WORD or EXCEL, and transfer goes 1:1. 
To place numerical data in the clipboard, use the toolbar above the numerical grid, for example see the 
Result data sheet. 
   
 

7.5 Edit 
 
In the graphic toolbar "Edit" will open a dropdown menu that allows the operator to execute a number of 
data manipulations: 
 
- Edit data: will allow the operator to smooth data, or change an individual datapoint 
- Smooth all data: will automatically smooth data 
- Subtract ohmic drop: will allow ohmic drop compensation when resistance is known 
- Average scans: will automatically average scans in the Scan-panel  
- Subtract overlay: will subtract overlay scan from the one Scan-panel 
- Add overlay: will add overlay scan to the one in Scan-panel  
 
 
7.5.1 Edit data 
 
Edit data allows the operator to smooth data or edit (=change) a data point. This can be activated from 
the graphic toolbar. The selected data to be manipulated will be shown in a different smoothing dialog 
window. After smoothing is completed and accepted by the operator, the original data is replaced. 
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On the left of the smoothing dialog window 3 tabsheets are shown from which the data editing process 
is controlled: 
- Smooth 
- FFTsmooth 
- Change point 
 
Generally with smoothing data, if the noise is non-frequency-specific, the general smoothing gives 
better results. However when noise is concentrated in specific fequency bands, such as 50/60Hz, the 
Fourier variant works better. 
 
Smooth 
The Smooth tab sheet gives access to Savitzky-Golay smoothing and spike rejection. Savitzky-Golay 
smoothing will process the data by using a moving window that interpolates each point using the 
position of neighboring datapoints. The algorithm calculates a quadratic fit and shifts the center point to 
the modeled position. The smoothing effect is stronger when more points are used: 5/11/25. 
Spike rejection uses an algorithm that detects spikes, and when detected interpolates these. The 
algorithm uses 2 points on either side to decide whether a datapoint is a spike. 
 
FFTsmooth 
On the FFTsmooth tab sheet, smoothing based on Fourier frequency analysis is executed. When this 
sheet is activated, 2 graphs appear: the original data and the Fourier transform. The original data is 
recalculated to the corresponding time-transient, to calculate the proper frequencies. For example 
Linear PotentialSweep data, is recalculated to current vs time (from current vs E). 
In the frequency plot, the most abundant frequencies are visible. Usuallly a peak is visible at the 50/60 
Hz line frequency, and possibly its multiples. This can be removed by either using the "Low pass filter" 
or the "Band reject filter".  
For the Low pass, set the cutoff frequency and press apply. Set the cutoff frequency low enough to 
remove the noise, but not too low that data is deformed. 
For the Bandreject, set the cutoff frequency, the Bandwidth and press apply. It is also possible to 
remove the higher harmonics by checking that option: this will repeat the bandfilter at all multiples of the 
cutoff frequency. 
 
Change point 
In the Change point tab sheet it is possible to change individual data points. Activate the mouse editor, 
left click on the data point to be changed and drag it to its desired vertical position.  
 
 
7.5.2 Smooth all data 
 
From the Edit menu, select: "Smooth all", and all presently loaded scans will automatically be 
smoothed, and spikes are removed. This is done by Savitzky Golay smoothing, using a sliding 
polynomial of default 11 points. This number may be modified in the Edit data screen. Every time the 
"Smooth all" function is activated, the data will be smoothed again; this can be applied repeatedly.  
 
 
7.5.3 Subtract ohmic drop 
 
The potential-loss due to the effects of ohmic resistance on Linear scans and Cyclic Voltammograms 
can be corrected by calculation. If the resistance is known, the ohmic drop can be calculated from the 
product with measured current. The real applied potential can thus be calculated. 
 
First select the scan to be processed, and from the Edit menu, select : "Subtract ohmic drop". A window 
will popup, at which the resistance should be entered. Pressing Apply will process the selected scan.  
 
 
7.5.4 Average scans 
 
The operator can average scans. In the graphic toolbar select the Edit menu>Average scans. Clicking 
this option will automatically average all scans in Scan panel.  
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7.5.5 Subtract overlay 
 
With this function the operator can subtract the scan in the Overlay panel from the scans in the Scan 
panel. Note that this function can be applied repeatedly: each time it is activated the overlay will be 
subtracted from the scans.  
 
The scan to be subtracted should be saved as a normal datafile (*.idf) and loaded as the first overlay. 
After recording the new scan, you can select Subtract Overlay[1] from the Edit menu. The overlay will 
be subtracted from all scans. However, it only works for datafiles with identical structure: same Estart, 
Estep, Vtx1, Vtx2. 
 
The Subtract overlay function also works with (identical) datafiles loaded from memory into the scan 
and overlay panels.  
 
 
7.5.6 Add overlay 
 
With this function the operator can add the scan in the Overlay panel to the scans in the Scan panel. 
Note that this function can be applied repeatedly: each time it is activated the overlay will be added to 
the scans. 
 
The scan to be added should be saved as a normal datafile (*.idf) and loaded as the first overlay. After 
recording the new scan, you can select Add Overlay[1] from the Edit menu. The overlay will be added 
to all scans. However, it only works for datafiles with identical structure: same Estart, Estep, Vtx1, Vtx2. 
 
The Add overlay function also works with (identical) datafiles loaded from memory into the scan and 
overlay panels.  
 
 

7.6 Analysis 
 
The graphic toolbar "Analysis" will open a dropdown menu that allows the operator to execute a number 
of analysis options. These analysis options are available when relevant to the data in memory: 
 
- Equivalent circuit: equivalent circuit analysis for impedance measurements 
- Corrosion rate: analysis of corrosion rate for LSV 
- Peakfind automatic: will automatically draw peaks 
- Peakfind advanced: will allow operator to identify and analyse peaks 
- Clear peaks: will clear peaks that were drawn earlier from peakfind 
- Electrochemical noise: will allow analysis of electrochemical noise data 
- Find levels: allows operator to identify and analyse levels 
- SolarcellReport: will automatically create a solar cell report of the available data in memory 
- Curve fit: will allow curve fit analysis 
- Electrolysisreport: will automatically create an electrolysis report of the available data in memory  
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7.6.1 Equivalent circuit analysis 
 
The equivalent circuit fit module can be started from the Analysis dropdown menu on the Graphic 
toolbar. After selecting "Equivalent circuit" the module is opened in a new window: 
 

 
 
On top a menu appears: 
File  
· load fitresult: loads a previously saved model, including the parameter values.  
· save fitresult: saves current model, including the fitted parametervalues (if available).  
· load Zplot data: imports a datafile produced with the Zplot program  
· save as Zplot file: exports a datafile so this can be read by the Zplot program 
 
Edit  
· Copy graph: copy current graph to clipboard  
· Copy fit parameters: copy fit parameters to clipboard  
· Swap Z for Y: changes Z into Y in plot  
· Copy simulated: copies simulated data to measurement result  
· Subtract as parallel components: subtract the entered equivalent circuit off the data as parallel 

components to analyse remaining data  
· Subtract as series components: subtract the entered equivalent circuit off the data as series 

components to analyse remaining data 
 
Options 
Fitting options: 
· Optimize: select which measured parameter should be used to fit best on the theoretical model: 

Z1andZ2/Zabs/Z1/Z2/phase.  
· Error weight 

- equal for each point: to minimize the absolute errors 
- proportional to absolute impedance: to minimize the errors relative to measurement accuracy 
- proportional to value: to minimize the relative errors 

· allow negative values: whether components R/C/etc can have negative values 
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On the left middle, the graphical equivalent circuit editor is shown. It contains a toolbar with the 
selectable electrical components:  
· R: resistor  
· C: capacitor  
· W: Warburg (diffusion impedance)  
· Q: Constant Phase Element (CPE)  
· L: inductance   
· T: hyperbolic tangent   
· O: hyperbolic cotangent   
· G: Gerisher impedance  
· ¾  : horizontal conductor  
· del: delete element, to remove components from the circuit 
 
To place a new element, click the desired component on the element toolbar and drop it on the desired 
location in the grid. Components can be removed with the del-element. Vertical conductors are placed 
automatically between upper and lower neighbors. Where this is not wanted, maintain an empty row 
between elements. Horizontal conductors are placed after selecting the "-" element. When editing is 
finished, press Accept and the components are named, and the CDC expression is evaluated.  
When Apply is pressed the model will be implemented in the fitting engine, the fit-able parameters are 
shown in the parameter grid below. 
 
Instead of entering the circuit manually, predefined circuits might be loaded (load fitresult), or be 
selected from the dropdownlist in the CDC field. 
 
In the parametergrid:  
· Par: name of the parameter, the symbol R/C/etc en the sequence number corresponding to the 

componentgrid and the CDC expression  
· Fixed: when checked, this parameter will not be changed by the fitting engine (not fitted)  
· Value: start value at which the fitting starts, will be updated during fitting, and contains end value 

after fitting is complete; a (start/fixed) value may be entered manually by selecting the field and 
entering the desired value  

· Error: calculates the error of the fitted parameter; is only calculated after fitting is completed   
· Unit: unit in which the parameter is listed, Ohm/F/etc. 
 
Calc Startvalues: It is important to supply start values that are close to the actual values, or 
convergence might not be reached. For some predefined circuits, the software will calculate such 
values for you, when the Calc Startvalue is pressed before the Fit is executed. 
 
The Fit range: the frequency range may be limited by selecting the start- and end- index of the included 
frequencies.   
 
Simulate: will draw the impedance curve using the present equivalent circuit and the parameter values 
in the parameter grid. 
 
Execute: will start the fitting engine, that optimizes the parameters in the parameter grid on the present 
equivalent circuit. 
 
Stop: will stop an ongoing fitting process 
 
Accept: closes the equivalent circuit fit module. The present model and parametervalues will be 
included in this data. If this data is stored later, it will include the impedance analysis. When the 
equivalent circuit fit module is started again with this data, the same results will be shown. 
 
Cancel: closes the equivalent circuit fit module without saving the results. The present model and 
parameter values will not be included in this data.  
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Data 
The calculated parameters for the equivalent circuit can be exported from the Equivalent circuit 
calculator". From the Edit menu, choose "Copy fit parameters". This will place the results in the 
clipboard, to be exported to other applications. 
 
On the Data tabsheet of the "Equivalent circuit calculator", the numerical data can be accessed: 
- Phi |Z|: phase/impedance data 
- Z' Z": complex impedance data 
- "Phi |Z| model": will display the modelled numerical phase/impedance data 
- "Z' Z'' model": will display the modelled numerical complex impedance data 
- "Copy data": will copy the currently displayed data into the clipboard. 
 
 
7.6.2 Corrosion analysis 
 
The corrosion rate analysis can be applied on data from a Linear Sweep experiment. The analysis can 
be started from the Analysis dropdown menu on the Graphic toolbar. 
 

 
 
The corrosion analysis window contains a data panel on the left, where input data is supplied and 
analysis results are shown. 
3 types of analysis are available:  
· Slope analysis: the corrosion potential and Rp are calculated at the zero current intersection point  
· Tafel analysis: the corrosion parameters are calculated from the 2 Tafel lines  
· Model analysis: the corrosion parameters are calculated with a numerical analysis of the available 

data 
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Manual and automatic analysis can be used. For manual, the operator has to set the potential markers 
by mouse-click, while in automatic mode the software will set the markers. 
The 3 analysis types can be run by pressing the corresponding buttons, the results are shown in the 
grid above. Because the result fields are independent, the various results can be compared. 
Note that the Tafel analysis is based on simplifications that do not always apply. For instance one must 
have data over a very wide potential range on either side of the corrosion potential, which is often not 
available. The Model analysis usually gives the most reliable result.  
 
 
7.6.3 Peakfinding and baseline correction 
 
The IviumSoft program contains an integrated "peak finding" tool. It is accessible from the Analysis 
menu, via the options: Peakfind automatic and Peakfind advanced. The automatic option will execute 
the peak-search automatically with a single click. The advanced option will allow the operator to 
manipulate the automatic peak-search parameters, or manually add/remove peaks, subtract baselines 
and process the results. 
 
The advanced tool also contains a baseline corection option, as wel as the option to manually 
add/remove peaks. 
 
 
7.6.4 Peakfind automatic 
 
This will automatically find and draw the peaks. 
Note that the peakfind parameters can be modified in the advanced tool. 
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7.6.5 Peakfind advanced 
 
Pressing the Peakfind advanced , will open an extra window that contains:  
· Automatic peak find tool, and its editable parameters.   
· Manual peak addition tool.  
· Peak results list, and peak removal functions  
· Baseline subtraction options 
 

 
Graphical presentation of the data with found/added peaks drawn in: Automatic peakfind example with 
whole peak and 1st derivative selected 
 
The automatic peak find tool is located on the top left panel. It has an 'execute search button': 
"Automatic peak find", and below that a list of parameters that will be applied during automatic search 
actions: 
Construct from : whole peak / front flank / rear flank 
Selecting whole peak will construct a full peak, while front flank will only use the rising part of the peak, 
and rear flank only the descending flank. Whole peak is best suited for peaks with clearly defined flanks 
and horizontal baselines. Front peak is appropriate when the tail of the peak is "smeared out", or has a 
steep baseline, or is close to the scan boundaries, as is often the case in Cyclic Voltammetry.  
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Find Method : 1st derivative / 2nd derivative 
Selects the control variable for the method that is used by the algorithm that determines where peaks 
start and end. The 1st derivative method is more sensitive to small peaks, but only works well when the 
baseline is (nearly) horizontal. The 2nd derivative technique can cope with sloped baselines, as is often 
the case for fast scan techniques, as Linear Sweep or Cyclic Voltammetry. 
Height mode : proportional / absolute 
Refers to the minimum height.  
Minimum height : in absolute height mode it defines the absolute minimum height for a peak, while in 
proportional mode, it defines the minimum fraction from the maximum value in the whole scan. 
Width mode : proportional / absolute 
Refers to the minimum width.  
Minimum width : in absolute width mode it defines the absolute minimum width for a peak, while in 
proportional mode, it defines the minimum fraction from the range of the scan.  
Sensitivity : number of consecutive points that must fulfill the begin & end criteria for a peak to be 
accepted. A higher number usually expands the peak 
Smoothing : Apply smoothing on the data from which the peaks are to be determined. Use higher 
levels (more points) on noisy data. Note that the underlying data will not be changed. 
 

 
Automatic peakfind example with front-flank and 2nd derivative selected 
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Peaksearch parameters are stored : When peak search parameters are changed by the operator, 
these become the default values, which are applied to all subsequent peak-finding actions. When a 
datafile that contains peakresults is stored, also the used peak search parameters are included in that 
datafile. When such a datafile is loaded at a later time, it may thus contain peak search parameters that 
could be different from the active default values. However if all peaks are cleared in this dataset, the 
default search parameters will be applied on subsequent search actions. 
 
Manual peak addition tool : Peaks can be added manually by first marking (left-mouse-click) the 
desired locations in the graph, and thereafter pressing the Add marked peak button. Peaks can be 
added either from 2 marks or from 3 marks. When 3 markers are set, these are taken as the beginpoint, 
toppoint, and the endpoint of the peak. When 2 markers are set, these are taken as the beginpoint and 
the endpoint of the peak, while the top is determined automatically. 
When Cyclic Voltammograms are edited, the checkbox must be checked before markers on the reverse 
scan can be set. 
Note that manual addition works independent of the peak search parameters, and always whole peaks 
are added. 
 
Baseline subtraction : Sometimes it is convenient to remove the baseline before the peak-analysis is 
executed. To activate the baseline subtraction tool, select the "Baseline subtract" tabsheet.  
 

 
Example of baseline subtraction with a 6th order polynomial 
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The operator should use left-mouse clicks to set anchor-points (markers) to which the baseline is fitted. 
The software will recalculate the baseline automatically after the addition of each anchor-point, unless 
this is disabled with the indicated checkbox. There is no limit to the number of anchor-points. When the 
projected baseline is satisfactory, press <subtract baseline>, and the data correction will be applied. 
Please note that this procedure will change the underlying data, and prior calculated peakdata will be 
cleared. 
  
Two baseline types are available:  
· Polynomial: 1st order corresponds to linear, 2nd to parabolic, etc.  
· Exponential: the sum of exponents of increasing order, up to the indicated value. 
 
The baseline order can be set from 1 to 6. However the order will always be lower than the number of 
data points, for example on 3 anchor-points the baseline order is limited to 2.  
For Cyclic Voltammograms, forward and reverse scan baselines have to be subtracted separately. Use 
the "mark CV reverse scan" checkbox to select each branch.  
  

 
Figure a: baseline determination of CV forward scan 
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Figure b: baseline determination of CV reverse scan 
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Figure c: CV after baseline subtraction  
 
 
7.6.6 Clear peaks 
 
In the graphic toolbar selecting the menu item "Analysis" > "Clear peaks" will allow the operator to 
remove peaks from the graph that have previously been drawn by the Peakfind automatic or Peakfind 
advanced options.  
 
 
7.6.7 Electrochemical noise analysis 
 
The software can evaluate the recorded results of an electrochemical noise experiment automatically. It 
is possible to perform the analysis in "Time-domain" or in the "Frequency-domain", and to subtract the 
baseline. 
 
In "Time-domain", the potential and current noise are calculated by statistical analysis. Also derived 
parameters, such as "Corrosion resistance" and "Pitting index" are evaluated. Moreover, with the 
software tool, one can monitor the changes of the parameters vs time, by segmenting the datastream. 
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The "Frequency-domain"analysis offers 2 methods to calculate frequency spectra:  
· Fast Fourier Transformation (FFT): straightforward transformation  
· Maximum Entropy Method (MEM): alternative method to calculate the frequency spectra using a 

finite number of coefficients. MEM yields more smooth spectra, if less coefficients are used. If the 
number is increased, the MEM result converges to the FFT curve.   

 

 
Evaluation of noise data with FFT (black) and MEM (red). Data was recorded by TNO, Den Helder, The 
Netherlands 
 
Because FFT and MEM are affected by the so-called "leakage effect", it is advisable to use a 
Windowing function. A choice of 5 different Windows is provided. 
If the data contains a dc-drift, it can be removed by checking the "Subtract baseline" box. This will 
construct a baseline between 1st and last point, which is subtracted from the dataset before 
transformation. 
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A more extensive option to remove a baseline or trends from the data is available in the "Baseline 
remove" tab. The order of the polynomial baseline is selectable from 1st (linear) to 9th order. Pressing 
the "Apply" button will subtract the baseline from both the Potential and Current data. Subsequent time-
domain and Frequency-domain analysis will use the corrected data. After the ECN Analysis tool is 
closed, the original data is also changed, and corrected curves can be saved thereafter.  
 
For details about the mathematical background, contact Ivium Technologies.   
 

  
ECN data before baseline subtraction 
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ECN data after baseline subtraction  
 
 
7.6.8 Find levels 
 
The IviumSoft program contains an integrated "level finding" tool for chronopotentiometric data. It is 
accessible from the Analysis menu, via the option: "Level Find". This will open a window where the 
operator can execute the tool, manipulate level-search parameters, and process the results. 
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Pressing the <Find> button will execute the search. The results are shown in the graph and written to 
the table below the graph. On the left, parameters can be altered before a "find" is done: 
· Search for: plateau (only option for now, enhancements possible upon request).  
· Threshold slope: set detectionpoint for a level  
· Minimum separation: minimum distance between 2 results  
· Value reference: absolute/differential; for absolute all results are referenced to time=0 , for 

differential, relative subsequent result-values are referenced from the preceeding found result.   
· Convert result: On/Off; normally (Off) the timevalue is taken as the result, alternatively this option 

can be checked (On) at which the result can be converted to another value. The following sub-
properties can be defined: 
- factor: resultvalue is multiplied by a definable constant, deault = 1  
- time: On/Off; when checked the result is multiplied by time  
- charge: On/Off; when checked the result is multiplied by charge 
- unit text: textual value that is written behind the result value     

· Smoothing none/5/11/25: integrated Savitzky-Golay smoothing that is applied before each find 
option, to be used for noisy data. Selecting more smoothing points will result in stronger smoothing. 

 
When parameters are changed, these are automatically stored in the configuration file (IviumSoft.ict), 
thus these are always copied from a previous session. 
Results can be copied to for example to WORD/EXCEL with the "Copy results" button (numerical data) 
or the "Copy graph" button (graph). 
When a datafile is saved after an analysis is executed, the analysis results are stored in the file (*.idf). 
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7.6.9 Solar cell report 
 
The Ivium instruments and IviumSoft are equiped to carry out experiments to characterize solar cells, 
for example in combination with a light source such as the Ivium ModuLight. When the relevant 
measurements are carried out, a Solar cell report can be created by selecting in the graphic toolbar: 
"Analysis" > "SolarcellReport". This will open a pop-up window where by choice a basic (basic model) 
or more elaborate (including Rs, Rp) model can be executed. After entering the cell area and light 
intensity, clicking the "Calculate" button will result in all the relevant parameters of the solar cell, given 
in the "Analysis results" window. 
 

 
 
Solar cell fitting equations 
 
(1) I = Isc - AA * ( exp(BB*V) - 1 ) -V/Rp 
 
with: 
 
(2)  V = E + I * Rs 
 
I total current 
E total potential 
V internal potential across solar cell (= excluding potentialdrop over Rs) 
Isc shortcut photocurrent (V=0) 
AA saturation current 
BB exponential constant related to ideality factor 
 
Note that equation (1) and (2) cannot be solved by simple calculation. IviumSoft uses the Leven-
Marquard method of nonlinear fitting, by iterative minimizing the sum of quadratic deviations from the 
experimental E/I data with the model.     
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7.6.10 Curve fit 
 
A tool to fit arbitrary polynomials can be accessed from the Analysis menu in the graphic toolbar. 
Choosing this option will open a pop-up window where a curve analysis can be carried out. 
 
First select the curve to be analysed in the scan panel, and press Analysis/Curve fit. On the left, the 
projection can be chosen based on the available variables: potential, current, time, Z1, Z2, frequency, 
etc. Also both axis can be transformed: linear/log/exp/sqrt/power/ etc. 
If desirable, the range that should be fitted can be constricted by clicking the Mouse on the start- and 
end-points. 
On the right, the order of the polynomial can be selected: max 9. 
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7.6.11 Electrolysis report 
 
From the Analysis menu in the graphic toolbar, an Electrolysis report can be generated. It will display 
the passed charge and current. Also it will report the numerical values for "Total Charge" and "Netto 
Charge". The "Netto Charge" is defined as the "Total Charge" corrected for the "Baseline Current", 
which is taken to be equal to the "End current". 
 
Note that this analysis can be used in combination with the Mixed-Mode technique, where in 
Potentiostatic mode the "Until fraction" parameter can be used to complete electrolysis. 
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7.6.12 Mott-Schottky analysis 
 
Mott-Schottky: After an impedance scan technique, on the Escan tabsheet Mott-Schottky can be 
selected. Automatically the slope and intercept are calculated, using Linear regression. The results 
appear in a table below the graph. If the selected potential range is decreased, the non-selected 
potentials are excluded from the calculation. 
The results may be copied with the Copy button (Excel format). 
 

 
Example of Mott-Schottky plots at various frequencies from measurements on a diode  
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8. Special functions 
 

8.1 Device maintenance 
 
The "Device maintenance" panel can be accessed from the Tools menu. It will open a pop-up window 
where the instrument can be maintained. 
 

 
 
In the device maintenance window, 8 area's can be distinguished: 
 
1) Verify device: clicking the "Check device" button will show the (power) status and configuration of the 

instrument. This will also show whether the instrument is USB or self powered. 
 
2) Verify firmware: clicking the "Check firmware" button will display the firmware version that is running. 

A new instrument will always have installed the firmware belonging to the software that is delivered. 
When a software upgrade is carried out, the firmware also needs to be upgraded. After upgrading 
the firmware, the "Check firmware" will show whether the firmware has been upgraded (a higher 
version number will be shown). 

 
3) Set configuration: when a LinScan or BiStat upgrade is purchased after the the instrument has been 

deliverd, the upgrade code can be applied here. When necessary, special instructions will be sent.  
 
4) Calibration: calibration is done by the manufacturer. Only the Booster offset can be calibrated by the 

user. 
 
5) Manual control: Reboot device is needed after a firmware upgrade. 
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6) Upgrade firmware: methods for upgrading the firmware. 
 
7) Upload file: to upload a specific file to the instrument internal PC. This is not meant to be used 

without proper specific instructions from the manufacturer. 
 
8) Disable idle sampling: clicking this button will disable the idle sampling (when no method is running 

or in direct mode, every second a sample taken to update the status bar and the values shown in 
direct control panel).  

 
 

8.2 Calibration 
 
Full calibration of any instrument is done by the manufacturer or the official distributor for your 
geographic region. 
 
Only the offset calibration for the IviumBoost and the PDA calibration can be done on site by the 
operator. 
 
If for some reason, the instrument does not function properly, or a performance test turns up a "fail" 
repeatedly, please apply the Restore procedure described elsewhere. Use "Restore factory options".   
 
 

8.3 Upgrading firmware 
 
After upgrading the pc-based software to a newer release, it is necessary to also upgrade the internal 
software of the instrument: the so-called firmware. No tools or files are necessary. The required 
firmware is packed inside the pc-software, and the upgrade can be performed with the standard usb 
cable. 
 
After the instrument is connected, in the main menu, press Tools > Device Maintenance: 
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The right-middle panel "Upgrade firmware" gives access the firmware upgrade functions.  
Press Method 1: 
 

 
 
After pressing Start, the firmware is transferred to the instrument. When no error messages occur, 
press close, and in the Device Maintenance panel, press "Reboot Device" (top-right under "Manual 
control"). Now close and re-start the pc software. The new firmware will be activated after re-
connecting. 
 
If during this process an error message is shown, try to upload again. If Method 1 remains ineffective 
after several attempts, try to apply Method 2. Here in the pop-up use the right-top-button indicated with 
"Start". 
 
If the instrument becomes unresponsive after a failed upgrade, see the "restore instrument" paragraph.   
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8.4 Restore instrument 
 
If the connection process takes exceptionally long, or the instrument fails to respond at all, possibly its 
internal firmware is corrupt. Please note that the recovery procedure is slightly different for different 
instruments. 
 
For CompactStat:  
· remove power cable and USB cable      
· start the pc software and re-connect the usb cable (do not press connect!) 
 
For IviumStat:  
· switch instrument off with power button on the front of the instrument  
· press the CELL OFF button, before switching the instrument on  
· start the pc software (do not press connect !) 
 
For Ivium-n-Stat:  
· switch instrument off with power button on the front of the instrument  
· connect EMO to GND (make a wire connection between the EMO and GND sockets, for example 

using a banana lead)  
· switch on instrument (the status LEDs will light up a faint red) 
 
From the main menu, press Tools and Restore Device: 
 

 
 
3 options are shown: 
- Restore factory settings: reverts back to the original settings and calibration values. 
- Restore factory firmware: sets the firmware back to the original release 
- Restore previous firmware: go back to the version before the last upgrade 
 
The last option is useful when recovering from a failed upgrade. If also the previous version was 
corrupt, the factory version can be used. 
When a firmware version is running again, the upgrade may be re-tried. 
 
After the relevant option has been selected (click on it), remove power and USB cable (CompactStat) or 
switch instrument off (IviumStat, Ivium-n-Stat). Then re-connect or switch instrument on again, and retry 
to connect in the IviumSoft.  
 
Please note that these recovery functions can only be used directly after power-on, before the 
"Connect" button in the IviumSoft was pressed. For the CompactStat, it means that the usb cable and 
power cable must have been removed. 
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8.5 Performance test 
 
To verify proper operation and to diagnose possible problems, the instrument can be instructed to 
perform a self-test.  
 
To execute the test:  
· Connect the cellcable and Testcell 1  
· Select "Performance test" from the Tools menu.  
· Click the "Run test" button. Each individual test result is compared to preset limits, and a Pass or 

Fail status will be assigned. A testreport is generated that can be saved or printed directly. Also it 
can be copied to the Windows clipboard and transferred to the application of choice. The report is 
generated in ASCII format and can be read by any text editor.  

· All status reports should read "Pass". If one reads "Fail", re-run the test. If after repeatedly running 
the test, a fail continues to show up, the instrument may need recalibration. 

 
Note that the report is stored automatically in the IviumStat main directory, with the serial number as 
filename and ".ipt" as extension, for example "B07003.ipt" (subsequent reports with the same 
instrument will overwrite older reports). The test report starts with recording time/date and the 
instrument/software configuration, and is followed by the test results. Each individual test result is 
compared to preset limits, and a Pass or Fail status will be assigned. 
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8.6 Pulse Generator 
 
A continuously repeating pulse can be applied to the cell with variable period and duty cycle. It is 
intended as a tool to treat the electrode, without data being measured. It can be applied in potentiostatic 
(Estat) or in  galvanostatic mode (Istat), both in 4-electrode mode. The duration of a pulse-level can be 
defined from 10us to 0.6 seconds (0.01 to 650 ms). Each level: Hi_period and Lo_period can be set 
independently. 
 

 
 
The pulse generator can be started form the Tools menu. Please note that the settings for Current 
range and Stability are copied from the Direct tabsheet. These settings should be set before the Pulse 
generator form is opened. After pressing <Apply> the pulse will be applied, and repeated continuously, 
until <Stop> is pressed. The period and Voltage/Ampere values will be retained until the IviumSoft 
program is ended.  
 
 

8.7 Current Interrupt 
 
The current interrupt technique can be used for measuring the IR-drop of an electrochemical system. 
This application is designed to operate in combination with the Ivium Technologies CIM. As the name of 
the technique suggests, the current of a running experiment is interrupted instantly and the response of 
the cell potential is measured in high speed mode. The momentary drop of the cell potential, 
representing the IR-drop of the electrochemical system, is then shown in a graph of the potential vs. 
time. 
 
Operation: In the IviumSoft, the current interrupt technique is integrated as a diagnostic tool.  
 
To operate the current interrupt technique, in the "Direct Mode" set the desired potential in either the 
potentiostatic 4-electrode or 2-electrode configuration, and then apply so that the potential is applied to 
the test object and the current flows. Then in the menu bar choose "Tools>CurrentInterrupt" and then 
press "apply". The current is momentarily interrupted and a graph is produced showing the potential vs. 
time. From this result the IR-drop is calculated (see graph below). 
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8.8 Software development driver DLL 
 
You can develop your own software to control the IviumStat and CompactStat instruments. Developing 
programs is easy, because IviumSoft will do all the hard work. The supplied driver will allow you to 
integrate the functionality in your own program. You can still use the convenience of the IviumSoft 
software, and program your specific tasks with a few program lines in the desired language: VB, Delphi, 
C, Labview, etc. 
Advantages:  
· Faster development of applications than programming from scratch. IviumSoft takes care of most 

overhead: communication, error handling, graphic plotting, datastorage etc. You may mix modes, 
for example first set the device in a desired state with IviumSoft, and let your own program take 
control from that point.   

· More flexible than using a scripting language. You can use all the programming power of the higher 
programming language of your choice. It is possible to customize data processing, or react on 
specific results and events.  

· Control multiple Ivium devices at the same time, and simultaneously control/read other types of 
devices: pumps, valves, thermostats, motors, sensors, etc. 

 
Method: 
1) Import the provided dll in your program:  IVIUM_remdriver.dll  
2) Embed the control-functions in your software 
3) Start IviumSoft and your own program 
 
The dll allows you to import and execute most basic  functions of the Ivium device: 
Imported function Description 
GENERAL  
IV_open Opens the driver 
IV_close Closes the driver 
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IV_selectdevice(int) Select device, applicable for multi-device configurations, default=1 
IV_getdevicestatus Returns status of device: -1=no IviumSoft; 0=not connected;  
 1=available_idle; 2=available_busy 
IV_readSN(*char) Returns serial number of selected device, empty string if not 

connected 
IV_connect(int) Connect to selected device, int=1 for connect, int=0 for disconnect 
DIRECT MODE  
IV_getcellstatus(int) Returns cell status: bit 2=I_ovl, bit 4 =Anin1_ovl, bit 5 = E_ovl,  
 bit 7 = CellOff_button pressed 
IV_setconnectionmode(int) Select configuration, 0=off; 1=EStat4EL(default), 2=EStat2EL,  
 3=EstatDummy1,4=EStatDummy2,5=EstatDummy3,6=EstatDummy4  
 7=Istat4EL, 8=Istat2EL, 9=IstatDummy, 10=BiStat4EL, 11=BiStat2EL 
IV_setpotential(double) Set cell potential 
IV_setpotentialWE2(double) Set BiStat offset potential 
IV_setcurrent(double) Set cell current (galvanostatic mode) 
IV_getpotential(double) Returns measured potential 
IV_setcurrentrange(int) Set current range, 0=10A, 1=1A, etc, 
IV_setcurrentrangeWE2(int) Set current range for BiStat, 0=10mA, 1=1mA, etc, 
IV_getcurrent(double) Returns measured current  
IV_getcurrentWE2(double) Returns measured current from WE2 (bipotentiostat)  
IV_setfilter(int) Set filter, for int :0=1MHz, 1=100kHz, 2=10kHz, 3=1kHz, 4=10Hz 
IV_setstability(int) Set stability, for int 0=HighSpeed, 1=Standard, 2=HighStability 
IV_bistat_mode(int) Select mode for BiStat, for int 0=standard, 1=scanning 
IV_setdac(int,double) Set dac on external port, int=0 for dac1, int=1 for dac2 
IV_getadc(int,double) Returns measured voltage on external ADC port, int=channelnr. 0-7 
IV_setmuxchannel(int) Set channel of multiplexer, int=channelnr. starting from 0(default) 
IV_setdigout(int) Set digital lines on external port, int is bitmask 
IV_getdigin(int) Returns status of digital inputs from external port, int is bitmask 
IV_setfrequency(double) Set ac frequency, double in Hz 
IV_setamplitude(double) Set ac amplitude, double in Volt 
  
IV_getcurrenttrace Returns a sequence of measured currents at defined samplingrate 
           (int ,double,*double) (npoints, interval, array of double): npoints<=256, interval: 10us to 

20ms 
IV_getcurrentWE2trace Returns a sequence of measured WE2 currents at defined 

samplingrate 
           (int ,double,*double) (npoints, interval, array of double): npoints<=256, interval: 10us to 

20ms 
IV_getpotentialtrace Returns a sequence of measured potentials at defined samplingrate  
           (int ,double,*double) (npoints, interval, array of double): npoints<=256, interval: 10us to 

20ms 
IV_we32setchannel(int) Select active WE32 channel (chan) 
IV_we32setoffset(int,double) Set WE32 offset (chan,value), value -2 to +2V.  
 Use chan=0 to apply the same offset to all channels. 
IV_we32getoffsets(int,*values) Returns actual WE32 offset values (Nchan,values),  
 with Nchan the number of channels (1..32) 
IV_we32readcurrents(*values) Returns array with 32 WE32 current values,  
 that are measured simultaneously 
METHOD MODE  
IV_readmethod(*char) Loads method procedure from disk, with char as filename 
IV_savemethod(*char) Saves method procedure to disk, with char as filename 
IV_startmethod(*char) Start method procedure. If char is empty then presently loaded  
 procedure is used, else the procedure is loaded from disk. 
IV_savedata(*char) Saves actual result data to disk, with char as filename 
IV_setmethodparameter Modify method parameter, with char1=parameter_name,  
                    (*char1,*char2)  char2=new value 
IV_Ndatapoints(int) Returns actual available number of datapoints:  
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 indicates progress during a run 
IV_readdata(int,d1,d2,d3) Read datapoint with index int, returns 3 doubles (d1/d2/d3) that  
 represent measured values depending on the used technique, for  
 example LSV/CV methods  return (E/I/0) Transient methods 
  return (time/I,E/0), Impedance methods return (Z1,Z2,freq) etc. 
 
Programming considerations:  
· All imported functions return an integer as result (32 bits signed number), 0=successfully executed,  

-1= no device, 1=illegal command, 2=argument out of range. Note that IV_getdevicestatus return 
codes are different.  

· Arguments are passed by reference.  
· Pchar= zero-terminated string; int=32 bit signed integer; double=8 byte floating point number  
· Current is expressed in Ampere, potential in Volt, time in s, and frequency in Hz   
· The driver must be opened with the IV_open function before the control functions can be used.  
· When the driver is opened, it automatically connects the first connected device. For single-device 

users, nothing needs to be done to select it. For multi-device configurations, use the 
IV_selectdevice() command to select each different device.  

· After starting a method, IV_getdevicestatus will indicate whether a scan is ready. During a scan, 
progress can be monitored with  the IV_Ndatapoints function.  

· When reading datapoints with the IV_readdata command during an ongoing scan, be sure to check 
whether data is available with the IV_Ndatapoints function, before attempting to access the data.  

· The IV_setmethodparameter(pchar1,pchar2) function will change method-parameters of the 
currently loaded procedure. If subsequently a scan is started, the new values will be used. It 
requires 2 arguments, the parameter name and the parameterv alue: 
o Parametername: this must correspond exactly to the spelling on the method-tabsheet.  
o Parametervalue: textual expression of the parameter value. The format of the supplied value must 

correspond with the type of the selected parameter name. If the selected parameter is a 
checkbox, a value of 'true' will correspond to the checked condition, anything else will uncheck 
the box. Numerical text strings must be of the correct format. 

o When the technique should be modified, first set the Method, thereafter the Technique. For 
example when selecting Standard Cyclic Voltammetry: 

§ setmethodparameter('Method','CyclicVoltammetry') 
§ setmethodparameter('Technique','Standard') 

o If wrong or unavailable Parameter names are selected, or when unavailable parameter values are 
entered, the commands are ignored without an error message. When a parameter value with 
improper format is supplied, the command is ignored and an error message is shown. Please 
note that the parameter availability depends on the chosen Method and Technique. 

 
 

8.9 Galvanostatic generation icw. Amperometric dete ction with 
BiStat 

 
The techniques: Chronopotentiometry, galvanostatic CV and galvanostatic LSV, can be combined with 
the bipotentiostat module.  
 
Several applications that normally require 2 potentiostats/galvanostats can be performed with a single 
instrument. The primary WE and CE will control the applied current in galvanostatic mode, while the 
BiStat module is operating in potentiostatic mode, applying a potential and measuring a current. The 
bipotentiostat will use the RE (standard mode) or S (scanning mode) electrode, as reference. Its offset 
potential can be set in the ±2V range. 
When the Bistat option is activated, the measurement plot will show both working electrode currents.   
The WE/CE electrode pair may be located in a different cell-compartment than the WE2/RE(S) pair. For 
a typical application the WE/CE pair would generate a product that is detected by measurement with 
the WE2.  
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8.10 Labview interfacing 
 
LabView drivers are bundled with the IviumSoft. These will facilitate the control of the Ivium instruments 
from a LabView development environment. More information is given in the Ivium Labview driver 
product note in Appendix1 of this user manual.  
 
 

8.11 Ivium data file registration 
 
It is possible to "register" Ivium datafiles (*.idf) and Ivium datasets (*.ids). This action will make it 
possible to double mouse click on an Ivium data file/set to load it in the scan panel of the IviumSoft. 
To activate this option, in the Options menu click on "Register idf/ids files". 
 
Each time when double clicking on an Ivium datafile/set the file/set will be opened in the scan panel of a 
new IviumSoft instance. Only opening a data file from the File menu will allow data to be opened in the 
same IviumSoft instance.  
 
 

8.12 Measurements using the peripheral port 
 
8.12.1 Peripheral analog inputs 
 
Ivium Instruments are equiped with a peripheral I/O port (list of signals and connections: see chapter 
9.20: Connectors). The peripheral port interfaces via a DB37 connector (CompactStat, IviumStat) or a 
DB15 connector (Ivium-n-Stat sModule). For the DB37 connector a break-out box is available: the PPE 
(peripheral port expander, see chapter 9.9), that outputs all signals to 4mm banana connectors. 
Alternatively, the desired signals can be taken directly from the corresponding pins in the DB37 
connector. 
 
The peripheral port includes: 
- 8 analog inputs (0 to +4V) for the CompactStat/Iviumstat 
- 2 analog inputs (0 to +10V) for the Ivium-n-Stat. 
 
Signals from these inputs can be recorded in pairs simultaneously with the primary signals. In the 2 
channel configuration, ch1 & ch2 are sampled at the same speed as the primary channel. When 4 
channels are sampled, ch1&ch2 and ch3&ch4 are sampled alternately, at half the sampling speed of 
the primary signals. Likewise when 4 channels are sampled, the peripheral channels are sampled at a 
quarter of the sampling speed of the primary signals. Results are visualized in the "Extra" plot, 
accessible via the graphic toolbars by clicking "Ain". 
 
 
8.12.2 Analog inputs direct or via PPE 
 
Measurement in Method mode 
To use analog inputs in method mode: 
 

1. Connect the analog inputs as desired (analog inputs are measured vs. analog ground). 
2. In the method parameters (advanced) at the "Analog inputs" parameter choose the number of 

channels to be measured, keeping within the capability of your hardware (= 2, 4, 8 channels 
standard). 

3. In the method parameters (advanced) at the "Data Options" parameter select the "Analog 
Inputs" tab: 



   99 

 
 

In this form it is possible to select how the inputs are displayed, including plot title and a 
number of transformations that will be executed before the signal is plotted. It is also possible to 
plot different channels in 2 different plots by ticking the relevant box (when ticked the 
corresponding channel will be displayed in plot 2). Each of the 3 plots can have its own 
transformation. 

 
4. When the rest of the method is defined as desired, click "Start" to start the measurement. 
5. Click "Ain" in the graphic toolbar to the left of the graph window to make the extra graph visible 

containing the signals of the analog inputs. When any of the signals is plotted in plot 2, there 
will be 2 plot windows: Plot 1 and Plot 2 (otherwise only one extra plot will be visible). 
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6. In the legend panel to the right of the graph, click on the "Chan" tab to select individual traces to 
be plotted display. 

7. All analog signal data are stored in the same data file as the primary signal. 
 
Measurement in Direct mode 
The analog input signals can be measured from the direct mode tab: 
- Connect the analog inputs as desired (analog inputs are measured vs. analog ground). 
- Select the "Direct" tab 
- Below, select the "Extern" tab 
- Click on "Read analog inputs" 
- A single signal sample will be measured on all analog inputs and displayed in the value-array. 
 
 
8.12.3 Analog inputs via PLT 
 
The analog input measuring capability of the CompactStat/IviumStat is standard 0 to +4 V. This can be 
extended to 0 to +10 V or -10 to +10 V by using a PLT (peripheral level transformer).  To measure via 
the PLT connect the PLT directly to the Ivium instrument and connect the external signal to the PLT. 
Then the same procedure for measuring as described above can be used. When using the PLT it is the 
operators responsibility to calculate the correct signal value based on the formula given for the PLT 
(see chapter 9.11). 
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8.12.4 Analog inputs via PDA 
 
The PDA module (see chapter 9.10) is an interface box, almost the same as the PPE (see chapter 9.9), 
that outputs all signals to 4mm banana connectors. The exceptions are: 
· Normally the peripheral port analog inputs are measured vs the common analog ground, resulting 

in an "absolute" measurement. In the PDA the analog inputs are differential, i.e. each signal is 
measured with a differential measurement range of ± 2V and a maximum common mode voltage ± 
15V. 

· PDA modules can be stacked up to 8 units resulting in a maximum of 64 differential analog inputs. 
 
Measurement in Method mode  

1. Connect the analog inputs as desired (each analog input connected differentially). 
2. In the method parameters (advanced) at the "Modules" parameter tick the box and then tick the 

box next to "PDA" to activate the PDA module 
3. Then in the method parameters at the "Analog inputs" parameter choose the number of 

channels to be measured, keeping within the capability of your hardware (= up to 64 channels 
for 8 PDA modules). 

4. Proceed in the same manner as described above at "Analog inputs direct or via PPE" 
 
Measurement in Direct mode 
The differential analog input signals can be measured from the direct mode tab: 
- Connect the analog inputs as desired (each analog input connected differentially). 
- Select the "Direct" tab 
- Below, select the "PDA" tab 
- Using the arrow buttons select the number of PDA modules connected 
- Click on "Read units " 
- A single signal sample will be measured on all analog inputs on all modules and displayed in the 

value-array. 
 
 
8.12.5 Using AC input 
 
The peripheral port of the CompactStat and IviumStat instruments is equiped with an AC-input. The AC-
input can be used to superimpose the analog or ac input-signal on the DC signal of the instrument. 
 
In direct mode 
In theDirect mode on the "Extern" tab, check the box for "Ext ACin". When checked the analog or ac 
signal connected to pin 9 of the peripheral port will be superimposed on the DC signal that is set in the 
Direct mode. 
 
In method mode 
For using the AC-input during a method, go to the Options menu>Settings. In the "Environment" area 
check the box for AC input. Now the analog or ac signal connected to pin 9 of the peripheral port will be 
superimposed on the DC signal that is set in the method parameters. 
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9. Instrumental specifications 
 

9.1 CompactStat 
 
Ivium CompactStat specifications: 
 
System Performance:  
Current compliance ±30mA (±1mA in USB powered mode) 
Maximum output Voltage ± 7.5V  
Potentiostat Bandwidth >1MHz 
Stability settings Potentiostat/Galvanostat High Speed, Standard, and High Stability 
Programmable response filter   1MHz , 100kHz , 10kHz , 1kHz , 10Hz   
Signal acquisition dual channel 16 bit ADC, 100.000 samples/sec. 
Safety features automatic disconnect on intern./ext. exceptions 
Potentiostat  
Applied potential range  ± 4 V , with 0.125mV resolution 
Applied potential accuracy 0.2%, or 2mV 
Current ranges  ±10nA to ±10mA (to 1mA in USB powered mode) 
High sensitivity current ranges ±1pA, ±10pA, ±100pA, ±1nA 
Measured current resolution. 0.015% of current range, minimum 0.15fA 
Current feedback ohmic drop compensation  n*ohm /(current range*65,536), with n=0 to 

65,535 
Galvanostat  
Applied current resolution  0.0125% of applied current range  
Applied current accuracy 0.2% 
Potential ranges ±1mV,±4mV,±10mV,±40mV,±0.1V, 

±0.4V,±1V,±4V 
Measured potential resolution  0.003% of potential range, minimum 16nV 
Impedance Analyser  
Frequency range   10uHz to 2MHz (or 3MHz) 
Amplitude    0.015mV to 1.0V, or 0.03% to 100% of current 

range 
DC offset  16 bit dc offset subtraction, 2 dc-decoupling filters 
Dynamic range 4nV to 4V, and 0.05fA to 30mA 
Electrometer  
Input impedance:  >1000 Gohm //<8pF 
Input bias current  <10pA 
Bandwidth  >16 MHz 
Peripheral connections  
8 Analog in 0 to +4.000V, 16 bits resolution, bandwidth 40kHz 
2 Analog out 0 to +4.096V, 16 bits resolution 
2 Digital inputs, and 3 Digital outputs 0 to +5V 
I-out, and E-out  analog monitor for cell current and potential 
AC-out ±0.5V sinewave 10µHz-2MHz, variable 

attenuation 
Channel-X, and  Channel-Y inputs ±4V: to record impedance from peripheral devices 
Environment  
power requirements: in USB powered mode  USB port capable of 5V, 500mA (standard pc 

spec.) 
                                : with external adapter  100-240V, 45-65Hz, 6VA 
Interfacing    USB 1.1 or 2.0 compliant 
Size     w x d x h =  12 x 26 x 2.5 cm 
Weight     0.6 kg 
PC requirements    Windows XP/Vista/7, with free USB port 
Specifications subject to change, Ivium Technologies ©2010 
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9.2 CompactStatPlus 
 
Same specifications as CompactStat, except: 
 
System Performance: Plus Plus2 
Current compliance ± 250mA ± 800mA ± 500mA 
Maximum output Voltage ± 20V  ± 8V  ± 10V  
Additional current range 100mA 100mA, 1A 
  
Potentiostat  
Applied potential range  ± 20 V, 0.666mV res. ± 10 V, 0.333mV res. 
  
Galvanostat  
Potential ranges ±2mV,±20mV, 

±200mV, 
±1mV,±10mV, 
±100mV, 

 ±2V,±20V ±1V,±10V 
  
Environment  
power requirements in USB powered mode  not available 
power requirements with external adapter  100-240V, 45-65Hz, 12VA 
power requirements at dc-connector   12V, 1A 
Size     w x d x h =  12 x 12 x 2.5 cm 
Weight     0.6 kg 
  
Specifications subject to change, Ivium Technologies ©2010 
 
 

9.3 Ivium-n-Stat 
 
Specifications: Ivium-n-Stat main frame  
Slot positions 8 (can mount up to 8 s- or b-Modules) 
Common connectors GND and combined emergency off control monitor 
Power requirements 100-240 V, 47-63 Hz, 300 W 
Interfacing USB 1.1 or 2.0 compliant 
Size w x d x h = 47 x 36 x 14 cm 
Weight 6.2 kg (no modules) 
 11.8 kg (with 8 modules) 
 
s-Module 
System Performance:   
4 Electrodes WE, CE, RE and S 
Current compliance  ±2.5A  
Maximum output Voltage ± 10V below 1A and ± 8V up to 2.5A 
Potentiostat Bandwidth 250kHz  
Stability settings Potentiostat/Galvanostat High Speed, Standard, and High Stability 
Programmable response filter  1MHz , 100kHz , 10kHz , 1kHz , 10Hz 
Signal acquisition  dual channel 16 bit ADC, 100.000 samples/sec 
Safety features automatic disconnect on intern./ext. exceptions  
  
Potentiostat    
Applied potential range ±10 V, at 0.33mVresolution 
Applied potential accuracy 0.2%, or 2mV 
Current ranges  ±10nA to ±10A in 10 steps 
Measured current resolution. 0.015% of current range, minimum 1 pA 
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Galvanostat   
Applied current resolution 0.033% of applied current range  
Applied current accuracy 0.2%  
Potential ranges ±10mV, ±100mV, ±1V, ±10V  
Measured potential resolution 0.038% of potential range, minimum µV 
  
Impedance Analyser   
Frequency range 10µHz to 250kHz  
Amplitude 0.015mV to 1.0V,   
 or 0.03% to 100% of current range 
DC offset 16 bit dc offset subtraction, 2 dc-decoupling filters  
  
Electrometer   
Input impedance:  >1000 Gohm //<8pF  
Input bias current <10pA  
Bandwidth >1 MHz 
  
Peripheral connections   
2 Analog in ±10 V, 16 bits resolution, bandwidth 40kHz  
1 Analog out  0 to +4 V, 16 bits resolution 
1 Digital input, and 3 Digital outputs 0 to +5V; Rin = 2.2 kOhm  
I-out, and E-out analog monitor for cell current and potential  
AC-out 150 Ohm  
Channel-X, and Channel-Y inputs ±4V: to record impedance from peripheral devices 
Power out +5V 
  
Environment   
Size w x d x h = 3 x 35 x 13 cm 
Weight 0.7 kg  
PC requirements Windows XP/Vista/7, with free USB port 
Specifications subject to change, Ivium Technologies ©2010 
 
 

9.4 IviumStat 
 
System Performance:   
Current compliance  ±5A  
Maximum output Voltage ± 10V below 1A and ± 8V up to 5A 
Potentiostat Bandwidth 1MHz for small signals, 300kHz for large 

signals  
Stability settings 
Potentiostat/Galvanostat 

High Speed, Standard, and High Stability 

Programmable response filter  1MHz , 100kHz , 10kHz , 1kHz , 10Hz 
Signal acquisition  dual channel 16 bit ADC, 100.000 samples/sec 
Safety features automatic disconnect on intern./ext. exceptions  
  
Potentiostat    
Applied potential range ±10 V, at 0.33mVresolution 
Applied potential accuracy 0.2%, or 2mV 
Current ranges  ±10nA to ±10A in 10 steps 
High sensitivity current ranges ±1pA, ±10pA, ±100pA, ±1nA 
Measured current resolution. 0.015% of current range, minimum 0.15fA 
Current feedback ohmic drop 
compensation  

n*ohm /(current range*65,536), with n=0 to 
65,535 

  
Galvanostat   
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Applied current resolution 0.033% of applied current range  
Applied current accuracy 0.2%  
Potential ranges ±1mV, ±10mV, ±100mV, ±1V, ±10V  
Measured potential resolution 0.003% of potential range, minimum 40nV 
  
Impedance Analyser   
Frequency range 10µHz to 2MHz (or 8 MHz) 
Amplitude 0.015mV to 1.0V,   
 or 0.03% to 100% of current range 
DC offset 16 bit dc offset subtraction, 2 dc-decoupling 

filters  
Dynamic range 12nV to 10V, and 0.05fA to 5A 
  
Electrometer   
Input impedance:  >1000 Gohm //<8pF  
Input bias current <10pA  
Bandwidth >16 MHz 
  
Peripheral connections   
8 Analog in 0 to +4.000V, 16 bits resolution, bandwidth 

40kHz  
2 Analog out  0 to +4.096V, 16 bits resolution 
2 Digital inputs, and 3 Digital outputs 0 to +5V  
I-out, and E-out analog monitor for cell current and potential  
AC-out ±0.5V sinewave 10µHz-1MHz, variable 

attenuation  
Channel-X, and Channel-Y inputs ±4V: to record impedance from peripheral 

devices 
  
Environment   
power requirements 100-240V, 47-63Hz, 150VA 
Interfacing USB 1.1 or 2.0 compliant  
Size w x d x h = 26 x 33 x 12 cm 
Weight 4 kg  
PC requirements Windows XP/Vista/7, with free USB port 
Specifications subject to change, Ivium Technologies ©2010 
 
 

9.5 IviumStat20V 
 
Same specifications as for IviumStat, except: 
 
System Performance:   
Current compliance  ± 2.5A  
Maximum output Voltage ± 20V 
    
 
 

9.6 IviumStat.XR 
 
Same specifications as for IviumStat, except: 
 
System Performance:   
Current compliance  ± 5A  
Maximum output Voltage ± 20V 
    



   106 

9.7 IviumStat.XRi 
 
Same specifications as for IviumStat, except: 
 
System Performance:   
Current compliance  ± 10A  
Maximum output Voltage ± 10V 
    
 

9.8 IviumStat.XRe 
 
Same specifications as for IviumStat, except: 
 
System Performance:   
Current compliance  ± 2A  
Maximum output Voltage ± 50V 
    
 

9.9 IviumBoost 
 
 40A @ 10 V 20 A @ 20 V 
System Performance:   
Current compliance  ±40 A  ±20 A 
Maximum output Voltage ±10 V  ±20 V 
Potentiostat Bandwidth >100 kHz 
Stability settings 
Potentiostat/Galvanostat 

High Speed, Standard, and High Stability 

Programmable response filter  1MHz , 100kHz , 10kHz , 1kHz , 10Hz 
Signal acquisition  dual channel 16 bit ADC, 100.000 samples/sec 
  
Potentiostat    
Applied potential range ±10 V, at 0.33mV res. ±20 V, at 0.66mV res. 
Applied potential accuracy 0.2%, or 2mV 
Current ranges  ±100 mA,  ±1 A, ±10 A 
Measured current resolution. 0.015% of current range, minimum 0.15fA 
Rise time <50 µs 
  
Galvanostat   
Applied current resolution 0.033% of applied current range  
Applied current accuracy 0.2%  
Potential ranges ±0.1V, ±1V, ±10V ±0.1V, ±1V, ±20V 
Measured potential resolution 0.003% of potential range, minimum 40nV 
  
Impedance Analyser   
Frequency range 10µHz to 100kHz 
Amplitude 0.015mV to 1.0V,   
 or 0.03% to 100% of current range 
DC offset 16 bit dc offset subtraction, 2 dc-decoupling 

filters  
Dynamic range 12nV to 10V,  12nV to 20V,  
 and 0.05fA to 40A and 0.05fA to 20A 
  
Electrometer   
Input impedance:  >1000 Gohm //<8pF  
Input bias current <10pA  
Bandwidth >16 MHz 
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Special functions  
Ohmic drop compensation 2 V/current range, 16 bits resolution 
Safety features automatic disconnect on intern./ext. exceptions 
  
Peripheral connections   
8 Analog in 0 to +4V, 16 bits resolution  
2 Analog out  0 to +4V, 16 bits resolution 
2 Digital inputs, and 3 Digital outputs 0 to +5V  
I-out, and E-out analog monitor for cell current and potential  
AC-out ±0.5V sinewave 10µHz-100kHz, var. 

attenuation  
Channel-X, and Channel-Y inputs ±4V: to record impedance from peripheral 

devices 
  
Environment   
power requirements 100-240V, 50-60Hz, 1000VA 
Interfacing USB 1.1 or 2.0 compliant  
Size w x d x h = 47 x 36 x 14 cm 
Weight 16 kg  
PC requirements Windows XP/Vista/7, with free USB port 
Specifications subject to change, Ivium Technologies ©2010 
 
 

9.10 PPE 
 
Peripheral Port Expander: Break out box for peripheral port. 
 
Specifications  
Connection To instrument peripheral port 
 DB37 to 32 x 4mm banana sockets 
power requirements Not powered 
Size     w x d x h =  12 x 26 x 2.5 cm 
Weight     0.5 kg excluding cabling 
   
 
Peripheral connections: 
pin function Signal range remarks 
1  +5V  max 100mA, not to be used in usb-powered mode 
2 dig-in-1 0 to +5V  
3 dig-out-2 0 to +3.3V  
4 busy 0 to +5V reserved for Ivium 
5 com-RxD RS2322C reserved for Ivium 
6 dgnd   
7 an-out-1 0 to+4.096V  
8 ac-out  -1 to +1 V  
9 an-in  -4 to +4V  
10 pga-in-X  -4 to +4V  
11 pga-in-Y  -4 to +4V  
12 an-in-1 0.05 to +4V 1MOhm impedance 
13 an-in-3 0.05 to +4V 1MOhm impedance 
14 an-in-5 0.05 to +4V 1MOhm impedance 
15 an-in-7 0.05 to +4V 1MOhm impedance 
16 an-in-2 0.05 to +4V 1MOhm impedance 
17 an-in-4 0.05 to +4V 1MOhm impedance 
18 an-in-6 0.05 to +4V 1MOhm impedance 
19 an-in-8 0.05 to +4V 1MOhm impedance 
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20 dig-in-2 0 to +5V  
21 dig-out-1 0 to +3.3V  
22 dig-out-3 0 to +3.3V  
23 com-TxD RS2322C reserved for Ivium 
24 dgnd   
25 agnd   
26 an-out-2 0 to+4.096V  
27to35 agnd   
36 I-out  -4 to +4V 1 V = 1 X Current Range 
37 E-out  -10 to +10V limited by device compliance 
 
 

9.11 PDA 
 
Same specifications as for PPE, except for analog i nputs: 
 
System Performance:  
No. of channels 8 analog inputs for each unit 
Maximum no. of channels 64 (8  units) 
  
Each Channel  
Differential measurement range ± 2V  
Maximum common mode voltage ± 15V  
Input impedance >100 Gohm //<8pF 
Input bias current  <10pA 
Signal bandwidth  3.3 kHz 
  
Environment  
power requirements with external adapter  100-240V, 45-65Hz, 6VA 
Size     w x d x h =  12 x 26 x 2.5 cm 
Weight     0.6 kg excluding cabling 
 
Calibration 
The PDA differential analog inputs can be calibrated in the Direct mode:  
· Connect the PDA to the P/G-instrument  
· In the Direct mode select the "PDA" tab  
· Connect ch1+/ch2+ to E_out (i.e. use a banana lead)  
· Connect ch1-/ch2- to Agnd (i.e. use a banana lead)  
· Press the "Calibrate" button  
· Press the "Save cal." button  
· Remove the connections  
· Calibration values can be reset by pressing the "Reset" button 
 
 

9.12 PLT 
 
Functionality: enhance the potential range of the analog inputs and outputs at the peripheral port to 
±10V. 
 
Specifications  
Connection To instrument peripheral port 
Power requirements Powered from peripheral port 
Size     w x d x h =  7.5 x 5.3 x 1.5 cm 
Weight 50 gram 
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Application: 
The standard input/output-range of the IviumStat/CompactStat analog peripheral port is 0 to +4V. The 
PLT transforms the range of the analog inputs 1&2 to ±10V, and the analog outputs to 0 to +10V (or 
±10V see note 1). When the PLT is connected, the externally measured/applied potential E can be 
calculated from E_PLT: 
· analog inputs 1 and 2 : E_PLT = -0.185 * E + 1.96 range -10V to +10V 

(where E_PLT = reading on screen; E = actual input on peripheral port) 
· analog outputs 1 and 2 : E = 5 * E_PLT range 0V to +10V 

(where E_PLT = setting on screen; E = actual output of peripheral port) 
 
Note 1: The analog inputs 3-8 remain unchanged. 
Note 2: On request the analog output range can be adjusted to ±10V. In such case, the potential 

transformation will be: E = 5 * ( E_PLT - 2.048V ). 
Note 3: For CompactStat, when using PLT make sure that CompactStat is fed from adapter power. 
 
 
Installation: The male side of PLT module can be placed directly on the peripheral port connector of the 
IviumStat/CompactStat*. Any external equipment can be connected to the female side, as before. It is 
thus connected between the instrument and the periphery. All signals are passed through this module, 
and except level change of the analog inputs and outputs, it is fully compatible with the situation without 
PLT. 
 
*For CompactStat, when using PLT make sure that CompactStat is fed from adapter power.  
 
 

9.13 BiStat 
 
BiStat, bipotentiostat module (WE2):   
2 configurations  
             "standard"  WE2 at a fixed potential w.r.t. RE 
             "scanning" WE2 at a fixed offset potential w.r.t.the  primary 

WE 
Current compliance ±30mA (±1mA in USB powered mode 

CompactStat) 
Applied potential resolution 0.0625mV 
Current ranges 1pA to 10mA in 11 ranges 
 (lower 4 ranges use amplifier) 
Minimum current resolution 0.15fA 
Measured current resolution 0.076% or current range, 
 and 0.0000023% using gain amplifier 
Programmable response filter   1MHz, 100kHz, 10kHz, 1kHz, 10Hz   
Signal acquisition simultanously with primary WE1, 
 100kHz samplerate 
Software implementation LSV and CV 
 
Note: Configuration standard/scanning is controlled by software, and is determined by the method 
procedure parameter BiStat. 
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9.14 LinScan 
 
Applies a smooth analog ramp, instead of the standard staircase ramp. 
 
LinScan, True Linear Scan module:  
Scan range ±2 V 
Minimum scanrate 1 µV/s 
Maximum scanrate 10,000 V/s 
Software implementation LSV and CV 
 
 

9.15 MultiWE32 
 
The MultiWE32 module will accomodate cells with 32 Working Electrodes, that share a single CE and 
RE. The potential is applied to all channels simultaneously, thus applied E is not multiplexed! 
 
System Performance:   
Current compliance  ±1mA for each WE (±32 mA for CE) 
Maximum offset Voltage ± 2V  
Applied potential max. ±20 V (depends on controlling 

potentiostat) 
Potentiostat Bandwidth >100 kHz 
Stability settings 
Potentiostat/Galvanostat 

High Speed, Standard, and High Stability 

Programmable response filter  1MHz , 100kHz , 10kHz , 1kHz , 10Hz 
Signal acquisition  dual channel 16 bit ADC, 100.000 samples/sec 
  
Potentiostat    
Applied potential range determined by controlling Ivium potentiostat: 

CompactStat: max. ±4V 
IviumStat: max. ±10V 
IviumStat.XR: max. ±20V 

Applied potential offset max. ±2V, 0.0625mV resolution 
Applied potential accuracy 0.2%, or 2mV 
Current ranges  ±10nA to ±1mA 
High sensitivity current ranges ±1pA, ±10pA, ±100pA, ±1nA 
Measured current resolution. 0.015% of current range, minimum 0.15fA 
Current feedback ohmic drop 
compensationn*ohm /(current 
range*65,536), with n=0 to 65,535  

 

  
Impedance Analyser   
Frequency range 10µHz to 2MHz 
Amplitude 0.015mV to 1.0V,   
 or 0.03% to 100% of current range 
DC offset 16 bit dc offset subtraction, 2 dc-decoupling 

filters  
Dynamic range 4nV to 4V 
  
Electrometer   
Input impedance:  >1000 Gohm //<8pF  
Input bias current <10pA  
Bandwidth >16 MHz 
  
Environment   
power requirements external adapter: 100-240V, 47-63Hz, 400mA 
 Voltage input: 5V ±0.2Vdc / max. 2W 
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Interfacing USB 1.1 or 2.0 compliant  
Size w x d x h = 12 x 26 x 2.5 cm 
Weight 0.6 kg  
PC requirements Windows XP/Vista/7, with free USB port 
Specifications subject to change, Ivium Technologies ©2010 
  
 

9.16 HiMux 
 
Ivium HiMux specifications: 
 
System Performance:  
No. of channels 8 for each unit, with each 4 electrodes 

WE/CE/RE/S 
Maximum no. of channels 64 (8  units) 
Configuration WE and CE selected channel connected to primary instrument  
Configuration RE&S continuously connected to dedicated 

electrometers 
  
Each Channel  
Maximum current 5A (limited by instrument) 
Maximum applied potential ± 10V  (limited by instrument) 
Connector BNC 
Electrometer input impedance >100 Gohm //<8pF 
Electrometer input bias current  <10pA 
Electrometer bandwidth  >16 MHz 
  
Environment  
power requirements with external adapter  100-240V, 45-65Hz, 6VA 
Size     w x d x h =  12 x 26 x 2.5 cm 
Weight     0.9 kg excluding cabling 
Specifications subject to change, Ivium Technologies ©2010 
 
Ivium HiMux.XR specifications: 
 
System Performance:  
No. of channels 8 for each unit, uses standard cell cables 
 with each 6 leads: WE/CE/RE/S/WE2/GND 
Maximum no. of channels 64 (8  units) 
Configuration WE, WE2, CE selected channel connected to primary instrument  
Configuration RE&S continuously connected to dedicated 

electrometers 
GND continuously connected 
  
Each Channel  
Maximum current 5A (limited by instrument) 
Maximum applied potential ± 20V  (limited by instrument) 
Connector HD15 
Electrometer input impedance >1000 Gohm //<8pF 
Electrometer input bias current  <10pA 
Electrometer bandwidth  >16 MHz 
  
Environment  
power requirements with external adapter  100-240V, 45-65Hz, 6VA 
Size     w x d x h =  12 x 26 x 2.5 cm 
Weight     1 kg excluding cabling 
Specifications subject to change, Ivium Technologies ©2010 
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9.17 Edoubler 
 
Specifications Applied Edoubler in combination with IviumStat20V: 
 
Potentiostat    
Applied potential range ±20 V, at 0.66mV resolution 
Applied potential accuracy 0.2%, or 4mV 
 
 

9.18 CIM 
 
Current interrupt module 
 
Functionality: Enable the current interrupt technique for measuring the IR-drop of the electrochemical 
system. 
 
Specifications  
Current compliance ± 5A 
Voltage compliance ± 20V 
Resistance on-state 0.13 Ohm typical 
Resistance off-state >100 GOhm 
Interrupt time < 2� s 
  
Use only i.c.w. Ivium potentiostats 
Interfacing/connectivity HD15, connects in-line with cell cable 
Power requirements Powered from cell cable 
Size     Size w x d x h = 3.3 x 6.3 x 1.5 cm 
Weight     25 gram 
  
Note: When not using the current interrupt technique all signals are passed through this module and it 
is fully compatible with the situation without CIM. However, the CIM adds ca. 130 mOhm  impedance to 
the cell cable. This should be taken into account when measuring in the 2-electrode mode and it will 
slightly lower the compliance voltage of the potentiostat. The latter will only have a significant effect 
when measuring very low impedance objects.  
 
 

9.19 ModuLight 
 
Functionality: The ModuLight module is a programmable light source designed to investigate photo-
electrical devices. Its light intensity can be modulated with the IviumStat/CompactStat. The wavelength 
can be set programmatically from 465-635 nm in 7 steps, with a maximum light intensity of 60 lm. 
 
Table 1 
Mode Color Wavelength Luminous Flux Radiant Flux Di gital code 
1 White 425-600 nm 57 lm N.A. IIO 
2 Royal Blue 465 nm 10 lm 255 mW IOI 
3 Blue 475 nm 19 lm 278 mW IOO 
4 Cyan 510 nm 45 lm 78 mW OII 
5 Green 535 nm 52 lm 91 mW OIO 
6 Amber 595 nm 42 lm 82 mW OOI 
7 Red 635 nm 40 lm 260 mW OOO 
 
Light intensity can be modulated with the FRAoutput of the build-in sinewave generator of the 
IviumStat/CompactStat from 10µHz to 2 MHz. 
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Table 2 
Specifications  
Wavelength 465-635 nm in 7 steps, programmatically 
Dynamic flux 0 - 57 lm 
Luminous flux 0 - 278 mW 
Bandwidth 0 => 2 MHz 
Interrupt time < 2� s 
Bias resolution 16 bit, 0.0015% 
  
Use only i.c.w. Ivium potentiostats 
Interfacing/connectivity HD37, connects to the potentiostat  
 peripheral port 
Power requirements external adapter: 100-240 V, 45-65Hz 
 at DC-connector: 5 V, 1A 
Size     w x d x h = 12 x 13 x 2.5 cm 
Weight     0.5 kg 
  
Installation  
Connect The ModuLight module directly to the DB37 peripheral port via the 37 pin Male connector. 
Then insert the 5V DC plug into the back of the ModuLight. Plug the adapter into the mains power. The 
ModuLight is now ready for use. It is controlled via the IviumSoft software. 
 
Operation 
 
Color Selection 
The color/LED can be selected by using the 3 digital outputs of the peripheral port. The digital codes 
are given in table 1 above (Note that these codes are according to the electronic standards, i.e. 
counting from right to left). The digital outputs can be accessed in the IviumSoft from the "Direct control" 
tab in the "Extern" tab below. As an example, to choose the color "white", the digital code is "IIO". This 
means that "Dig out 3" and "Dig out 2" need to be checked and "Dig out 1" is unchecked: 
 

 
 
Intensity  
The intensity of the light is controlled via the Analog output1. This output has a range of 0 - 4V, which 
corresponds to a light output of 0-100%. For example enter "1"V into the ch1 field (see above) and 
press "ch1" to apply this voltage. This will effectuate a light output of 25% of the chosen color. 
 
Modulation 
The modulation of the light is controlled via the AC-output of the peripheral port. The AC-output can be 
accessed in the IviumSoft from the "Direct" tab in the "AC" tab below. The AC voltage has an amplitude 
of 0 - 1V, which corresponds to a modulation of 0 -100%. The speed of modulation is controlled by the 
frequency. For example, if the analog output ch1 is set to 2V, and when "2" is entered in the field for 
Frequency and "0.5" in the Amplitude field, upon pressing "Apply", the light will start modulating 
between 100% intensity and 0% intensity with a frequency of 2 cycles per second: 
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Note: When controlling the ModuLight from the direct mode, it should be taken into account that 
communication between PC and Ivium device only takes place once per second. This means that there 
may be a delay of up to one second before a change takes effect. 
 
Running a single method 
A single method can be run by first setting the desired parameters of the ModuLight, such as 
wavelength and intensity, in the "Direct" mode tab. Then in the "Method" mode tab, a method can be 
run. I.e. to measure an E/I curve of a solar cell, the desired wavelenght and intensity can be set, and 
then the E/I curve can be measured using the linear sweep method. 
 
To run an impedance measurement, first the ModuLight parameters need to be set in the "Direct" mode 
tab. Then in the "Method" mode tab the desired impedance technique is selected (for example 
"Constant E"). Then the "Advanced" parameters need to be activated. In the method parameters now 
"MeasConfig" is available. This parameter determines how and which signals are recorded and shown 
in the graph. 
 
Running automated methods 
In the "BatchMode" it is possible to run several methods successively. In between running the 
successive methods it is possible to change the wavelength and intensity of the ModuLight. To do this 
add a "DirectCommand" line in the appropriate place in the batch program. When this line is selected in 
the Line-properties below, the wavelength can be chosen by ticking the "SetDigOut" box. The boxes for 
the individual digital outputs become available and by ticking the relevant boxes the wavelength can be 
chosen. In the same way ticking the "SetDAC" box will make the analog outputs available. Inserting the 
desired value in the "DAC 1" field will set the intensity of the light. 
 
Mixed mode 
In the transient technique "MixedMode" a sequence of operations can be programmed in the window of 
"Stages" method parameter. In the "Properties for Level", at the bottom of the list the following 
parameters allow operation of the ModuLight:  
· AnOut1: when ticked a value can be entered from 1 - 4 V which determines the intensity of the light 

1 - 100% (in the same way as in the direct mode operation, see above).  
· Digouts: when ticket an integer value can be entered to select the color. This integer corresponds to 

an 8 bit conversion for the digital outputs, i.e. 0 = all digouts off; 1 = digout1 on digout2and3 off, etc. 
 
The modulation of the light can be controlled by ticking the "Record ac" box. In the method parameters 
the frequency and amplitude can be set. 
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Photometry 
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9.20 EMO: Emergency Off 
 
Next to the software options for automatic disconnection of the cell, the IviumStat and Ivium-n-Stat 
instruments are equiped with an external EMO (emergency off) function. 
 
IviumStat 
All IviumStat instruments (including XR's) have a red push button for the EMO function on the front 
panel. When pressed, all electrode cables are disconnected, and the button lights up red. Its circuitry is 
independent of the pc software setting or the instruments microprocessor, and its operation has a very 
high reliability. This button can be used as an EMO or panic button, to avoid dangerous situations. 
During normal operation, this button should not be used, and the red light should be off. Of course, 
measurements are not possible while this button is pressed. 
 
Ivium-n-Stat 
At the back plane of the Ivium-n-Stat, two 4mm sockets are available: EMO (red) and GND (green). The 
EMO bus is a 0 to 5V compliant input, and unconnected it pulls up to 5V, which means "EMO not 
activated". When the EMO is pulled to GND (i.e. via a wire bride), it will actively disconnect the 
sModules of all channels in the frame, and generate a shutoff event that will stop all running methods. 
The EMO function operates independently from the software/firmware. The cells cannot be activated 
until the signal on the EMO bus is removed. 
 
For both the IviumStat and Ivium-n-Stat the EMO function is also used for instrument restoration (i.e. to 
recover from a firmware upgrade mishap). 
 
 

9.21 Connectors 
 
Cell connector Type 1: DB9 female 
Pin Function Colour 
1 CE black 
2 gnd green 
3 gnd  
4 WE red 
5 WE2 red 
6 S-shield  
7 S white 
8 RE-shield  
9 RE blue 
 
Cell connector Type 2: HD15 female 
Pin Function Colour 
1 shield WE/WE2  
2 WE red 
3 Reserved gnd  
4 CE black 
5 Shield CE/agnd green 
6 Reserved clk  
7 +5V  
8 Reserved sel  
9 Reserved data-out  
10 Reserved data-in  
11 WE2 red 
12 S white 
13 S-shield  
14 RE-shield  
15 RE blue 
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MultiWE32 cable assignment 
 
Note: both RE shield leads are present in the cable as shielding for the RE, but they are not carried out 
to a banana plug. 
 
Electrode Color HD37 Pin number 
CE black 21 
CE shield/Ground green 3 
RE blue 20 
RE shield white (not external lead) 1 
RE shield brown (not external lead) 2 
WE1 brown-blue 22 
WE2 yellow 4 
WE3 white-red 23 
WE4 pink 5 
WE5 brown-red 24 
WE6 grey 6 
WE7 white-black 25 
WE8 red 7 
WE9 brown-black 26 
WE10 violet 8 
WE11 yellow-grey 27 
WE12 grey-pink 9 
WE13 green-grey 28 
WE14 red-blue 10 
WE15 yellow-pink 29 
WE16 green-white 11 
WE17 green-pink 30 
WE18 green-brown 12 
WE19 yellow-blue 31 
WE20 white-yellow 13 
WE21 green-blue 32 
WE22 yellow-brown 14 
WE23 yellow-red 33 
WE24 white-grey 15 
WE25 green-red 34 
WE26 brown-grey 16 
WE27 yellow-black 35 
WE28 white-pink 17 
WE29 green-black 36 
WE30 pink-brown 18 
WE31 pink- blue 37 
 WE32  white-blue 19 
 
 
Peripheral port connector: DB37 female 
Pin Function Signal range Remarks 
1  +5V  max 100mA, not to be used in usb-powered mode 
2 dig-in-1 0 to +5V  
3 dig-out-2 0 to +3.3V  
4 busy 0 to +5V reserved for Ivium 
5 com-RxD RS2322C reserved for Ivium 
6 dgnd   
7 an-out-1 0 to+4.096V  
8 ac-out  -0.5 to +0.5 V  
9 ac-in  -4 to +4V  
10 pga-in-X  -4 to +4V  
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11 pga-in-Y  -4 to +4V  
12 an-in-1 0.05 to +4V 1MOhm impedance 
13 an-in-3 0.05 to +4V 1MOhm impedance 
14 an-in-5 0.05 to +4V 1MOhm impedance 
15 an-in-7 0.05 to +4V 1MOhm impedance 
16 an-in-2 0.05 to +4V 1MOhm impedance 
17 an-in-4 0.05 to +4V 1MOhm impedance 
18 an-in-6 0.05 to +4V 1MOhm impedance 
19 an-in-8 0.05 to +4V 1MOhm impedance 
20 dig-in-2 0 to +5V  
21 dig-out-1 0 to +3.3V  
22 dig-out-3 0 to +3.3V  
23 com-TxD RS2322C reserved for Ivium 
24 dgnd   
25 agnd   
26 an-out-2 0 to+4.096V  
27to35 agnd   
36 I-out  -4 to +4V 1 V = -1 X Current Range 
37 E-out  -10 to +10V inverted signal; limited by device compliance* 

*E-out: 
-IviumStat: signal range -10 to +10V, i.e. for IviumStat.XR in 20V mode: E-out = -E/2 
-CompactStat: signal range -4 to +4V, i.e. for CompactStatPlus: E-out = -E/5.33;  
 for CompactStatPlus2: E-out = -E/2.66 

 
Peripheral connector Ivium-n-Stat: DB15 female 
 
The peripheral connector of the sModule has 15 pins instead of 37 pins. The sModule has fewer signals 
than the IviumStat/CompactStat. Also note that the analog input-range is different. 
Note: in floating mode, the peripheral signals are referred to the local sModule gnd. In floating mode, 
the peripheral port should only be used with floating equipment. 
 
Pin Function Remarks 
1 +5V  
2 Dig input 1  
3 Yin Range +/-4V 
4 Dig output 1 Rin=2.2kohm 
5 Dig output 3 Rin=2.2kohm 
6 Iout 1V/Current Range 
7 Analog in 1 +/-10V 
8 GND  
9 Ac output 150ohm 
10 Xin Range +/-4V 
11 GND  
12 Dig output 2 Rin=2.2kohm 
13 An output 1 0 to +4V 
14 Eout  
15 Analog in 2 +/-10V 
- Frame GND Connected to nStat common GND 
 
CompactStat power connector: 5.5mm bus female 
2.1mm inner, 5.5mm outer diameter, recommended shaftlength 12mm  
· center pin should be +5V ± 0.2V, max 1A  
 
Plus-module power connector: 5.5mm bus female 
6.8mm diameter  
· center pin should be +12V ± 0.2V, max 1A   
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10. Method parameters 
 
Mode 
 
Standard/HiSpeed mode.  
 
Standard mode allows sample rates up to 500 samples/s, during Standard mode sampes are directly 
communicated to the pc. Standard mode allows application of more features: automatic current ranging, 
etc. 
 
HiSpeed mode allows sample rates up to 100,000 samples/s, during a HiSpeed expertiment the data is 
stored inside the instrument and communicated after experiment completion. Maximum available 
datapoints = 8192 (32768 for CV methods). Note that in HiSpeed some features are unavailable, such 
as AutoCR. 
 
Title 
 
Title that will appear above the result plot.  
 
E start 
 
Start potential of the scan  
 
I start 
 
Start current of the galvanostatic scan  
 
E_end 
 
End potential of the scan  
 
I end 
 
End current of the galvanostatic scan  
 
E_step 
 
Potential step size  
I step 
 
Current step size  
 
DynamicVertexes 
 
It is possible to define the scan boundaries depending on the measured currents. The operator can set 
parameters for Maximum and Minimum current limits, inside which the scan will remain. If the current 
exceeds the defined "I max", or gets below "I min", the scan is stopped. This feature is only available in 
Standard mode.  
 
It is possible to use Dynamic Vertexes in combination with AutoCR. However when AutoCR is 
activated, the dynamic vertexes will only be active in the defined "AutoCR.Max range". This means that 
the Absolute values of "I max" and "I min" should be larger than 0.25* the selected "Max range". In 
practice, usually the 'Max range" parameter will be chosen according to the desired vertexes.  
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DynamicVertexes.I max 
 
Maximum current allowed, when exceeded the sweep is terminated or the scan direction is 
reversed.  

 
DynamicVertexes.I min 

 
Minimum current allowed, when exceeded the sweep is terminated or the scan direction is 
reversed.  

 
Vertex 1 
 
First vertex potential: potential is scanned from E_start to Vertex 1, subsequently to Vertex 2, and back 
to E_start.  
 
I vertex 1 
 
First vertex current: current is scanned from I start to I vertex 1, subsequently to I vertex 2, and back to I 
start.  
 
Vertex 2 
 
Second vertex potential: potential is scanned from E_start to Vertex 1, subsequently to Vertex 2, and 
back to E_start.  
 
I vertex 2 
 
Second vertex current: current is scanned from I start to I vertex 1, subsequently to I vertex 2, and back 
to I start.  
 
N scans 
 
Number of cycles to be executed, 1 to 65535 for Standard mode. At HiSpeed mode, the maximum is 
limited by 32678 datapoints.  
 
Scanrate 
 
Slope of the potential scan in Volts/second. The sample rate equals scanrate/E_step.  
 
Iscanrate 
 
Slope of the current scan in Ampere/second. The sample rate equals Iscanrate/I_step.  
 
Alpha 
 
During digitally produced sweeps, e.g. in LSV and CV, the potential/current-ramp is generated in step-
increments in a staircase shape. This compares with the smooth analog shape of a True Linear sweep. 
The standard practice for staircase sweeps is to sample the measured variable (current for chrono-
amperometry: potential for chrono-potentiometry) at the end of each step increment. However in some 
cases, a different sampling point is required for the measurement. Hence the parameter "alpha" is used 
to indicate the fraction of the step at which sampling occurs. For example, "alpha"=1 (the default 
setting) means sampling at the end of each step whereas alpha = 0.5 is halfway along, and so on. In 
practice, the effect of "alpha" depends on the object under test. For a pure resistor, "alpha" variations 
have no effect, but for systems with a capacitive component, strong variations can be observed. For the 
staircase techniques of LSV and CV in Advanced mode at Standard speed, the parameter "Alpha" can 
be activated. When checked, a value from 0.125 to 0.625 can be entered. The resolution for alpha is 
0.04ms. 
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If the "Alpha" parameter remains unchecked, the value reverts to 1 (default).  
 

Alpha.Value 
 

Fraction of the step at which sampling occurs; Values of 0.125 to 0.625 can be entered.  
 
Interval time 
 
Time between 2 consecutive samples. The sample rate equals 1/interval time, or scanrate/E_step. Max. 
60s.  
 
Run time 
 
For the transient technique "Electrochemical Noise" and for the electroanalysis method "AC detection": 
duration of the experiment.  
 
Levels 
 
Number of potential or current levels to be applied, 0 to 255. A pop-up window allows each level to be 
specified individually. 
In the pop-up window the interval time is only shown, it can be changed in the method parameters; the 
time base can be adjusted. The number of levels can be changed by pressing the up/down arrows. In 
each level the potential/current and time (=duration of that level) can be changed by entering the 
desired value in the appropriate cell. 
In ChronoPotentiometry also the current range can be selected from the drop down menu.  
 

Levels[index].time 
 

Time duration of level[index], from 1 to 4E9 times the interval time in Standard mode. In 
HiSpeed mode, the total number of datapoints must be lower than 8192.  

 
Levels separate 
 
When applying the Transient methods: ChronoAmperometry, Chronopotentiometry or Mixed Mode, 
each level can be viewed and stored separately. Each level is plotted as an independent scan, i.e. the 
time coordinate starts at 0 sec at the start of each level. The curves are listed in the Legends pane as 
"level 1", "level 2" etc, and can therefore be selected, saved and analysed separately. 
To activate level-separation, check 'Levels separate' in advanced mode. This feature cannot be used in 
combination with 'Cycles separate'.  
 
Stages 
 
Indicate how many stages/levels are sequenced in MixedMode, 0 to 255. A pop-up window allows each 
level to be specified individually. 
In the pop-up window the number of levels can be changed by pressing the up/down arrows. For each 
level E_control/I_control/Open_cell can be selected from the drop down menu. When a level is selected 
the parameters for that level can be entered in the "Properties for Level[]" window.  
 
Cycles 
 
Number of times that the whole sequence of levels is repeated, range 1-65535, only available in 
Standard mode.  
 
This option will allow multi-cycle experiments, such a multiple charging and discharging of 
batteries/supercaps. 
Please see the "Cycles separate" option to select how cycles are displayed. 
Also see the "Thresholds" option to select dynamic cycling limits. 
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Continuous cycling 
For ChronoAmperometry and ChronoPotentiometry in standard mode, and in MixedMode, the scans 
may be repeated continuously. When the parameter "Cycles" that normally is used to define a finite 
number of scans, is assigned the value "0", it is translated to infinite. Thus the cycling will never stop. 
Note that the only way to stop cycling is to press "Abort".  
 
Cycles separate 
 
For multi-cycle experiments, each cycle will appear as a separate scan, as is done in cyclic 
voltammetry. 
 
Turning on this option will keep subsequent scans separated, and will appear as different scans "on top 
of each other". Thus the first level wil always start with time = 0 seconds.  
Turning off this option will combine all cycles in a single scan. Subsequent scans are appended to the 
datafile, and the time will appear continuous. 
See both examples for ChronoPotentiometry for a comparison. 
 
N samples 
 
Number of samples to be acquired  
 
Thresholds 
 
Activate dynamic level switching in ChronoPotentiometry ( Standard mode).  
If during a level with a positive current (charge cycle), the potential exceeds "E max", this level is ended 
and the next level is applied. 
If during a level with a negative current (discharge cycle), the potential falls below "E min", this level is 
ended and the next level is applied. 
If the interupted level was the last level, the scan is ended, or proceeds to level-1 for multi-cycle 
experiments.  
 
Please note that the potential is sampled each interval time. In this case the interval time coincides with 
the reaction time. 
 

Thresholds.E max 
 

Set maximum potential threshold for dynamic levelswitching.   
 

Thresholds.E min 
 

Set minimum potential threshold for dynamic levelswitching.   
Pulse time 
 
Time (DPV-Technique) that pulse is applied, 0.1 ms to 400 ms; must be less than half of the interval 
time.  
 
Pulse amplitude 
 
Pulse height, 1 mV to 1000 mV. Sign of pulse is defined by scan direction.  
 
SQRWV frequency 
 
Frequency of the square wave signal, 2 Hz to 1kHz in Standard mode. Up to 50 kHz in Hispeed mode.   
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Phase sensitive 
 
Apply Y/N phase sensitive current detection with AC Voltammetry. 
If not activated the displayed result equals the RMS value of the current. When Phase-selective is 
turned on, the result will show the current component detected at that phase angle, for example at 0 
degrees the ohmic component will be displayed. 
 
Note that in AC Voltammetry, both RMS and phase angle are collected and stored. It is thus always 
possible to change the detection angle of existing measurements afterwards.  
 

Phase sensitive.phase 
 

Phase angle for Phase-sensitive AC Voltammetry.  
 
2nd Harmonic 
 
Detects the AC current at double the excitation frequency. 
This is useful to investigate non-linear phenomena. Please note the special relation with the excitation 
amplitude.  
 
Deposition time 
 
Time duration deposition stage during which E_start is applied.  
 
Current stripping 
 
Y/N: when current stripping is off, the cell is turned off during the stripping stage, i.e. no electrical 
current flows. This is sometimes called Chemical stripping. 
When current stripping is turned on, the instrument is configured as galvanostat, and the electrode is 
stripped at a constant applied current.   
 

Current Stripping.Stripping current 
 

Constant applied current during electrochemical strippping potentiometry. 
Please note that the current must be compliant with applied current range.  

 
Equilibration time 
 
E_start will be applied for indicated time, before an experiment starts, and at each new DC-setting 
(when relevant).  
 
Current range 
 
Current sensitivity during the experiment. When automatic current ranging is applied, this parameter 
sets the initial current range (CR). The maximum current that can be measured is 3* the current range, 
higher currents will trigger the current overload indicator. Overload currents that are higher than 3* but 
lower than 4* the current range may still be correct, but the reliability is not guaranteed. 
 
In case the DualCR option is checked (for impedance measurements), the active current range 
depends on the applied frequency. AutoCR is not available for galvanostatic techniques.  
 
Noise reduction 
 
This parameter can be used to reduce the impact of noise in impedance measurements. This can be 
convenient in cases that suffer from excessive noise. 
When activated, it will apply stronger automatic filtering, with built in analog filters.  
Also it will give easy access to the Acquisition period of the FRA settings, which is the total period that 
is sampled (averaged).   
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Noise reduction.Acquisition period 

 
Easy access to the acquisition period (FRA settings); a longer period will give better noise 
reduction. Note that this will override the value in the Options menu. The default value in the 
Options menu is 0.4sec, while this parameter in the EIS method is set to 2sec (default) when 
Noise reduction is activated.  

 
AutoCR 
 
Automatic current ranging. The instrument will automatically select the appropriate current range. 
Automated current range switching is possible for sampling rates below 100 datapoints/second. 
In case the DualCR option is checked for impedance measurements, the active current range depends 
on the applied frequency.   
 

AutoCR.Max range 
 

Maximum allowed current range  
 

AutoCR.Min range 
 

Minimum allowed current range  
 
DualCR 
 
This option may be checked for potentiostatic frequency scans that use automatic current ranging. 
It will override the automatic current range selection and set the current range depending on a user 
specified frequency :  
· at frequencies > SwitchFreq, the AutoCR_Max range is selected.  
· at frequencies < SwitchFreq, the AutoCR_Min range is selected. 
  
Note that this option is only active if the AutoCR option is checked.  
 

DualCR.SwitchFreq 
 

Frequency at which current range is switched.  
 
Potential range 
 
Maximum potential range for potentiometric (galvanostatic) measurements. More sensitive ranges give 
higher accuracy, but lower the range of measurable potentials.  
 
Frequency 
 
Frequency of the superimposed sinewave. Because of data/speed limitations the range is limited to 
10Hz to 2 MHz, and no oversampling is carried out.  
 
Amplitude 
 
Amplitude : 0.05 mV to 1 V.  
 
Frequencies 
 
Number of frequencies used in the frequency scan, max 255. Actual frequencies will be calculated from 
a logarithmic spread between start and end frequency. A pop-up window allows frequencies to be 
configured. 
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Frequency range: 
min: 10µHz  
max: depends on instrument*  

Before 2010: 2 MHz 
After 2010: CompactStat 3MHz 

IviumStat 8MHz 
Ivium-n-Stat 250kHz 

 
*Specifications subject to change. 
 
The applied frequencies are derived from the main 8 MHz oscillator: 8 MHz/n. An advanced software 
algorithm is developed for high resolution. The applied frequency resolution is finer than 0.05% for the 
whole applicable frequency range. The resolution is defined as the smallest possible separation 
between 2 applicable frequencies.  
Note that the frequency resolution is not the same as the applied frequency accuracy. Frequency 
resolution is defined as the smallest possible separation between 2 applied frequencies whereas 
frequency accuracy is the accuracy of each frequency point. (For all software versions, with 
IviumStat/CompactStat, the frequency accuracy is better than 100ppm (0.01%), for -10degC to 
+70degC.) 
 

Frequencies.Single sine 
 

Single sine: application of one frequency sine wave at a time.  
 

Frequencies.Multi sine 
 

MultiSine applies multiple sine wave frequencies simultaneously and the corresponding 
impedances are collected in a single measurement. For measurements at lower frequencies 
this can decrease measurement time considerably and minimize artefacts caused by to time-
variable impedances. 
In this setting, 5 frequencies within a single decade are combined. By using the odd harmonics: 
1:3:5:7:9 Hz., etc. and carefully controlling the relative phase of these frequencies it is possible 
to minimise the total combined amplitude for a given effect. 

 
Frequencies.Start 

 
Start frequency  

 
Frequencies.End 

 
End frequency  
 
Frequencies.Frequencies each decade 

 
Can be used to automatically apply an evenly distributed number of frequencies per decade  

 
Frequencies.Amplitude 

 
Amplitude of the applied ac signal. 
Standard: 0.0001V - 1V 
Galvanostatic: 0.001mA - 1A  

 
Frequencies.manual override 

 
Allow manual editing of frequencies and amplitudes. If override is disabled (standard), the 
amplitudes are fixed and the frequencies are automatically calculated from the Start- and End- 
frequencies. If manual override is activated, the operator can change any frequency and 
amplitude value independently.  
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Filter 
 
Signal measurement filter setting 1MHz/100kHz/10kHz/1kHz/10Hz or automatic. In Basic mode, 
automatic is applied. This filter is applied to the signals to be measured: current/potential/bipotentiostat 
or external X/Y-inputs. In automatic mode, the system determines the most appropriate setting from the 
applied samplerate (DC) or applied frequency (impedance method). Overriding the automatic setting 
should be done with care, because it may result in signal deformation. Especially for the impedance 
methods it is recommended to use the automatic setting. The automatically selected filter depends 
upon sample rate. It is subject to change in future revisions without notice but is currently as follows: 
Filter:  
· SR>500kHz: 1MHz 
· SR>50kHz: 100kHz 
· SR>5kHz: 10kHz 
· SR>50Hz: 1kHz 
· when AUTOCR and SR>8Hz: 1kHz 
· else: 10Hz  
 
Stability 
 
Bandwidth that signals are applied on the sample: highspeed/standard/high stability or automatic. In 
Basic mode, automatic is applied.  High speeds allow for faster pulses/scanrates and higher 
frequencies, but increase noise levels and worsen stability.  In automatic mode, the system determines 
the most appropriate setting from the applied samplerate (DC) or applied frequency (impedance 
method). Overriding the automatic setting should be done with care, because it may result in signal 
deformation and instability. Especially for the impedance methods it is recommended to use the 
automatic setting. In automatic setting the Stability is as follows*: 
· SR>1kHz: hispeed 
· SR>20Hz: standard 
· else histability 
 
*Subject to change without noticfication  
 
Connect to 
 
Select electrode cable configuration or internal dummy cell: 
· Cell-2El, only CE and WE need to be connected 
· Cell-4El, CE, WE, RE and S need to be connected 
· Dummy 1: 1kOhm 
· Dummy 2: 100kOhm 
· Dummy 3: 10Mohm 
· Dummy 4: 1kohm parallel over 1µF in series with 100ohm (CompactStat) or 250ohm (IviumStat).   
 
Analog inputs 
 
Measurement configuration of external analog inputs of the peripheral port. The 8 channels from the 
peripheral port are recorded in pairs, simultaneously with the primary signals. In the 2 channel 
configuration, ch1 & ch2 are sampled at the same speed as the primary channel. When 4 channels are 
sampled, ch1&ch2 and ch3&ch4 are sampled alternatingly, at half of the sampling speed of the primary 
signals. Likewise when 4 channels are sampled, the peripheral channels are sampled at a quarter of 
the sampling speed of the primary signals. Results are visualized in the "Extra" plot, accessible via the 
graphic toolbars.  
 
Anout2 
 
This is a facility to generate an external output pulse or variable voltage level just before the 
measurement starts. With this option, another measurement device can be triggered to start 
simultaneously, or a generator can be controlled to perform at the selected analog level. For example 
the intensity of a light-source can be varied to study photoelectric phenomena. It is both possible to 
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apply a pulse of defined duration before the measurement starts, or apply a continuous voltage level at 
Analog Output 2 of the peripheral port. 
 
The pulse level can be defined at 16bits resolution. The pulse duration can be programmed from 
0.05ms to 500 ms, at 10us resolution. The pulse is applied just before measurement sampling starts. In 
the HiSpeed techniques, the first recorded measurement sample follows within 0.05ms after the 
pulse/level-change. 
 
For all techniques, in Advanced mode, the methodparameter "Anout2" can optionally be selected. 
When checked, 2 parameters appear:  
· Level : the voltage to be applied to Analog output 2  
· Pulse period : the duration of the pulse (0.05 to 500 ms), or 0 
If a Pulse period of 0 ms is set, the level will be applied continuous. The value will be applied during the 
whole measurement, and thereafter. In such case, the analog output retains its setting, and must be 
reset in manual control or by the next executed scan.  
 

Anout2.Level 
 

Potential level of the pulse.The pulse level can be defined at 16bits resolution.  
 

Anout2.Pulse period 
 

Period of the pulse. 
The pulse duration can be programmed from 0.05ms to 500 ms, at 10us resolution. The pulse 
is applied just before measurement sampling starts. In the HiSpeed techniques, the first 
recorded measurement sample follows within 0.05ms after the pulse/level-change. 
If a Pulse period of 0 ms is set, the level will be applied continuous. The value will be applied 
during the whole measurement, and thereafter. In such case, the analog output remains its 
setting, and must be reset in manual control or by the next executed scan.  

 
Apply wrt OCP 
 
Potentials are referred to the Open Cell Potential. Before the measurement starts, the instrument 
determines the OCP by monitoring the potential with CE disconnected (no current passes). The 
determined OCP is added to E start and the other scan potentials, before the measurement starts. 
Results are visualized in the "Extra" plot, accessible via the graphic toolbars. 
 
The measured OCP is also shown in the bottom status bar.  
 

Apply wrt OCP.monitor time 
 

Time (s) that OCP is monitored. The potential that is reached at the end of this period is 
assumed to be the OCP.  

 
Apply wrt OCP.monitor interval 

 
Sampling interval (s) during OCP monitoring   

 
Apply wrt OCP.Estart wrt OCP 

 
When checked the startpotential is defined relative to OCP. When unchecked, the E start is 
applied as a real potential.  

 
Apply wrt OCP.Vtx/End wrt OCP 

 
When checked the Vertex- and End-potentials are defined relative to OCP. When unchecked, 
these are applied as real potentials.  
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Apply wrt OCP.Estandby wrt OCP 
 

Determines whether the stand-by potential needs to be applied with respect to OCP. 
When checked the stand-by potential is defined relative to OCP. When unchecked, it is applied 
as real potential.  

 
Apply wrt OCP.Record real E 
 
When checked, the real potentials are displayed and stored. When unchecked, potentials 
relative to OCP are displayed and stored. To improve clarity, the OCP value is shown on 
screen in the bottom status panel.  

 
Remove DC initial 
 
Before an ElectroChemical Noise scan, the voltage bias can be removed. If the checkbox "Remove DC 
initial" is checked, the initial voltage is measured and subsequently electronically subtracted from the 
cell potential before measurement. This option can improve the sensitivity of ECN measurements, 
because it will allow for a more narrow Potential range setting with a higher resolution.  
 
IR feedback 
 
Compensates for ohmic drop in the sample, via the direct feedback method. The instrument will 
increase the cell potential by the amount that is defined by the product of current and Compensation 
resistance. Care should be exercised, because overcompensation will result in instabilities.  
 

IR feedback.Compensation 
 
The ohmic value to be compensated. This value may range from 0 to 2V/current range, for 
example at 1mA current range at most 2 kohm can be compensated.  

 
BiStat 
 
Use bipotentiostat. When active, WE2 will be connected and its current recorded  
 

BiStat.E offset 
 

Potential offset for WE2, range +/-2V  
 
 

BiStat.Current range 
 

Similar to the primary current range setting, but for WE2. If CR min <> CR max, then automatic 
current ranging is applied.  

 
BiStat.CR min 

 
Minimum allowed current range  

 
BiStat.CR max 

 
Maximum allowed current range  

 
BiStat.mode 

 
Select Standard or Scanning mode. In Standard mode, the WE2 potential is set to a constant 
offset with respect to RE. In Scanning mode, WE2 is kept at a constant offset potential with 
respect to the primary WE, thus WE2 will scan at the same speed as WE1.  
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Cell after measurement 
 
If activated the cell will remain connected after completion of the measurement; the E standby will be 
applied between measurements.  
 

Cell after measurement.E standby 
 

Potential applied after measurement(s).  
 
Pretreatment 
 
Up to 5 potential or current levels may be applied before the experiment starts. Each level is defined by 
a potential or current value, and a time duration. The pretreatment stage preceeds all operations, also 
the OCP monitoring if that is activated. Results are visualized in the "Extra" plot, accessible via the 
graphic toolbar.  
 
Data Options 
 
Transform the visualized result. The peripheral port signals may be transformed with user defined 
functions, the potential axis may be automatically corrected for various reference electrodes, or the 
electrode surface area may be entered to plot current density. Note that the transformations are on the 
visual graphs only, the underlying data is always stored in original form. 
 
"Apply to selected data" will apply the transformation only to the scan in memory; "Apply to all data" will 
apply the transformation to all data in the graph sheet. 
 
In the "AnalogInputs" tab, the 8 available analog inputs may be plotted in 2 separate graphs according 
to 2 different transformations (see graphic toolbar). 
  

 
 
In the "Ecorrections" tab an offset potential may be entered, and/or reference electrode potentials may 
be converted (see graphic toolbar). 
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In the "Electrode" tab the electrode surface area and reference capacity may be entered in order to be 
able to plot current density (see graphic toolbar). 
 
Data reduction 
 
When data is captured over extended periods and/or at high sample rates, the large data files produced 
can become slow and cumbersome to manage. For ChronoAmperometry and ChronoPotentiometry in 
standard mode, and in MixedMode, the data can be reduced in real-time. 
 
Skipping or Averaging datapoints: Reduce the number of datapoints by entering a number of points to 
use in computing an average. This is stored as a single value. By ticking the box "No Averaging", every 
n-th value is stored without averaging the intermediate values. 
 
The averaging is done inside the instrument, and only the average values are sent to the pc. Thus less 
points are transferred and stored. For example at an interval time of 0.002 sec and an average count of 
500, only 1 point per second will be produced. This feature is convenient for very long measurements 
that otherwise would produce too many datapoints. At very long interval times, for example at 1 sec 
interval, and an average count of 600, only 1 point per 10 minutes is recorded. 
 
Data reduction by averaging has the beneficial effect that noise is suppressed, and curves will become 
more smooth. Because less data needs to be communicated, the speed limit for standard mode is 
increased. The minimum interval time is reduced from 2ms to 0.5ms at sufficient average counts. (500 
Hz - 2 kHz). 
 
This feature has some consequences for other functions. If AutoCR is active, the average values are 
used to decide to change a current range. Also when averaging is activated, and analog inputs are 
recorded simultaneously with the measurement, only channels 1&2 can be used, To use this feature, 
check the "Data reduction" option, and set the "average" parameter to the desired number. 
 
Adaptive sampling enables the user to set a minimum change in the measured parameter (E/I) which 
will be stored in the data file. Thus, all relevant trends are captured with a minimum of datapoints. The 
user can define a minimum potential- and/or current-difference which he considers relevant. Datapoints 
that differ less than the defined delta from the last recorded point, will not be stored. Only datapoints 
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that differ more than the minimum defined delta will be displayed. The exception is the 1st datapoint 
after each new applied level-change, which will always be stored. 
 
For ChronoAmperometry the instrument will use the "min I delta", and for ChronoPotentiometry the "min 
I delta" parameter. 
 
For Mixed mode, both parameters will be used: either an E-delta or an I-delta will trigger a sample-
recording. In this case, a single parameter can be effectively disabled by entering a very high value. 
 
In principle, the averaging approach could be combined with the "minimum delta" method. However, 
this is not recommended because of the increasing complexity. Therefore, if using the "minimum delta" 
method, keep the "average every" on 1 point. And for the averaging approach, keep both min-deltas to 
0.  
 

Data reduction.average every 
 

Number of points to be averaged. For example at 1 sec interval, and an average count of 600, 
only 1 point per 10 minutes is recorded.  

 
Data reduction.no averaging 

 
In the existing data reduction option (transient techniques), the number of datapoints can be 
reduced by setting an averaging number. In this manner the instrument will reduce the number 
of datapoints by a selectable fraction. The intermediate datapoints are averaged to a single 
stored value. However: When "no averaging" is checked, every n-th value is stored without 
averaging the intermediate values.  
 
Data reduction.min E delta 

 
Adaptive sampling: only E values differing more than this value from the previously stored data 
point, will be stored. 

 
Data reduction.min I delta 

 
Adaptive sampling: only I values differing more than this value from the previously stored data 
point, will be stored. 

 
Automatic save 
 
When activated, that data will be saved automatically.   
 

Automatic save.filename 
 

Filename at which the automatic backup wil be saved. If a file with this name already exists, an 
index number will be added to the filename.  

 
Automatic save.save every 

 
Every x seconds, the data will be saved to disk. This is intended for measurements that take a 
long time to complete.  
Note that when short periods of time (x) for saving are chosen, during long term experiments 
the data-saving action may take longer than the chosen period and there will be a conflict which 
may result in non-responsive PC/software.  

 
 

Automatic save.on completion 
 

When checked, the data will be saved automatically at the end of the measurement.  
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AUX 
 
The IviumStat/CompactStat has been prepared for controlling external equipment via the peripheral 
port:   
· external trigger that signal begin & start of a measurement  
· purge control  
· stirrer control  
· RDE control  
· new drop control (DME, SMDE, etc.) will execute a selectable number of knock/dispense cycles at 

the start of the measurement 
 
The trigger, stirrer and purging is controlled via digital outputs (TTL compatible, active-low). The 
rotation-speed of the RDE is controlled from an analog output with 16 bits resolution. The new drops 
are controlled via the Analog output 2. Connections:  
 
· Purging control line is Digital Output 1 (pin 21 from 37pins peripheral port).  
· Stirrer control line is Digital Output 2 (pin 3 from 37pins peripheral port)  
· Trigger output line is Digital Output 3 (pin 22 from 37pins peripheral port)  
· RDE control line is Analog Output 1 (pin 7 from 37pins peripheral port)  
· New drop output line is Analog Output 2 (pin 26 from 37pins peripheral port)   
· Digital ground is pin 24, analog ground is pin 25. 
 
In the IviumSoft program, the auxiliary equipment can be activated with the "AUX" methodparameter. 
When enabled, new options appear: "Purging period" ,"Stirrer pretreatment" ,"RDE speed".The trigger 
output is activated automatically with the AUX parameter. 
 
When auxiliary equipment is activated by the "AUX" parameter, the corresponding output ports are 
set/cleared depending on the progress of the measurement. Sequence of events: 
1. RDE is turned on, and set to selected rotation speed. 
2. Purging is turned on for the indicated "Purging period". If this parameter is set to 0, no purging will 

occur. 
3. Selected number of new drops will be dispensed at 1 sec interval. If "New drops at start" is set to 0, 

no knock/dispense cycles will be exceuted. 
4. If "Stirrer pretreatment" is checked, the stirrer is turned on for the duration of the complete 

pretreatment. NB: OCP determination, and equilibration time are not part of pretreatment. 
5. Trigger line goes to LO (active-low logic)  
6. The actual measurement is executed. 
7. RDE is turned off. 
8. Trigger line goes to HI.  
 

AUX.purging period 
 

Specify the purging duration, in seconds  
 

AUX.Stirrer pretreatment 
 

Switch stirrer on/off during pretreatment  
 

AUX.RDE speed 
 

Specify rotationspeed, from 0 to 100%. Standard 100% corresponds to 4.096 V, optionally this 
can be increased to 10 V. To increase to 0 to 10V or to -10 to +10 V a PLT is needed.  
 
AUX.New drops at start 

 
Specify the number of knock/dispense cycles. If this value is non-zero, the new drops will be 
dispensed directly after purging, before pretreatment starts. The new drops are dispensed at 1 
second intervals. If applied to Static Mercury Electrodes, usually this value is set to 3-5, to 
eliminate memory effects. 
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The Analog output 2 will go LO for 1 millisecond to dislodge the previous drop, and suspend the 
new drop. It will remain HI after the last drop has been dispersed: LO = 0 Volt; HI = 4 Volt.  

 
AUX.InvertDig polarity 

 
When this box is ticked, the polarity of the digital output is reversed.  

 
Modules 
 
Check this if special modules are to be activated.  
 

Modules.PDA 
 

Check this if external PDA modules should be used. 
If multiple PDA units are used (>8 channels), this will activate the selection of the extra PDA 
modules.  

 
MeasConfig 
 
For impedance measurements, the applied and measured signals can be redefined. This is especially 
useful when using external equipment in combination with the potentiostat/galvanostat. One can use 
the ACout, Xin and Yin connectors on the peripheral port for this purpose.  
Some possible applications/configurations:  
· Interfacing a Solar cell, to modulate a light source and measure the photocurrent/ potential 

(Modulight module).  
· Interfacing with an electronic load  
· Interfacing with an RDE to modulate rotation rate: Hydrodynamic impedance  
· Using the Ivium FRA in combination with an external analog potentiostat  
· etc. 
 
In standard setting, the impedance is defined as Y/X, which is normally the measured E/I from the 
electrochemical cell. When other (external) signals are used for X/Y, the meaning of the plotted 
impedance might be different from the classical definition. The plot is always displayed as if Y/X were 
E/I, and the user is responsible for any conversions. 
 
To change the configuration of the signals, in the method parameters the advanced parameter 
"MeasConfig" gives the user the possibility to adjust this configuration. A list of possibilities is given in 
the table below: 
 
 MeasConfig X  Y remarks 
0 standard I we E  Internal DSG not applied  
1 INT_ac I ac intern E  Internal DSG not applied 
2 INT_ac E I we ac intern  
3 EXT_ac EI X periph. Y periph.  
4 EXT_ac I X periph. E   
5 EXT_ac E I we Y periph.  
6 EXT_I INT_E X periph. ac intern  
7 EXT_E INT_I ac intern Y periph.  
8 DirectE I we E  CE as reference, instead of (RE-S) 
9 DirectE_INT_I ac intern E  CE as reference, instead of (RE-S) 
10 DirectE_EXT_I X periph. E   
11 BiStat I we I we2  
12 EXT_I BiStat X periph. I we2  
 
In the Direct configs, the potential control loop is bypassed. This means that the potential is the directly 
applied potential on the CE terminal, w.r.t. the gnd. This can be useful when controlling other 
equipment, such as loads. The differential electrometer can be used independently for other purposes. 
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Example 1: Solarcell IMPS 
The IviumStat/CompactStat AC-OUT port is used to drive the intensity of a light source, and the ac-
photocurrent from the solar cell is to be recorded with reference to the incident light: "impedance" = 
Light /photo-Current. The instrument is set to "Impedance Constant E", and the MeasConfig parameter 
to "INT_ac E". With this parameter-setting, the internal applied ac signal is used as Y, which is the light-
intensity here, instead of the cell-potential. 
 
Note that the potentiostat potential may be set to shortcut conditions (E=0), but it may also be operated 
at other potentials, such as maximum power point. 
 
Example 2: Solarcell IMVS 
The IviumStat/CompactStat AC-OUT port is used to drive the intensity of a light source, and the ac-
photopotential from the solar cell is to be recorded with reference to the incident light: "impedance" = 
photopotential / Light. The instrument is set to "Impedance Constant I", and the MeasConfig parameter 
to "INT_ac I". With this parameter-setting, the internal applied ac signal is used as X, which is the light-
intensity here, instead of the cell-current. 
 
Note that the galvanostat current may be set to OCP conditions (I=0), but it may also be operated at 
other currents, such as maximum power point. 
 
WE32_offsets 
 
Applying a potential with the MultiWE32: 
 
By default, the electrodes of the MultiWE32 act similar to a Bipotentiostat in Scanning mode. This 
means that the potential that is selected by the user is applied to all working electrodes at the same 
time. For example, when a CV is run, all 32 working electrodes will be sweeping at the same speed. 
 
As an advanced parameter feature, it is possible to give each working electrode an individual offset. 
This offset is subtracted from the base-potential. Offsets are intended to apply fixed potential 
differences between the 32 working electrodes, which remain constant during a scan. Note that the 
value for the real-time potential in the software measurement window, and the graph axis, will only 
show the "base-potential" (the potential/potential range selected by user), thus this potential does not 
include the offset-part. The offset potentials for each WE are stored in the datafile/method parameters. 
 
The offset potentials can be defined in the Method parameters: selecting "We32_offset" will open a 
dialog screen that will allow the operator to set independent offsets for each electrode, either manually 
or with a distribution function (within a range of -2 V to 2 V).  
In this example, a linear distribution is applied from -1V to +1V. Suppose the basepotential is scanned 
from 0 to 1V, the WE[1] will sweep from 1V to 2V, and WE[32] will sweep from -1V to 0V.  
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To show the scans for all WE's in the graph, tick the box "WE32_allchannels" in the method  
parameters. 
 
Note that when a MultiWE32 is used, there is no primary (base) electrode. For most applications, the 
offset potentials would remain at 0V, because potential manipulations are more conveniently done by 
setting the base potential.  
 
WE32_allchannels 
 
To acquire measurement data from all 32 channels of the MultiWE32 simultaneously. It is available for 
the following techniques: LSV standard, CV standard and CA standard. When checked, the currents for 
all 32 working electrodes are recorded. Each scan will therefore produce 32 curves. Individual curves 
can be stored with "save data", while all 32 scans can be stored in a single file with "save dataset".  
 
Report 
 
Data report: add notes to datafiles. 
 
The operator can include notes and extra information about the experiment in the datafile. When 
pressing the Report button, a window opens where notes can be typed in the "Remarks" tabsheet. 
Additionally, a "Process Report" tabsheet is added, that will list important measurement and instrument 
data. 
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Labview VI 

Ivium remdriver 

IviumSoft 

Ivium device 

Order of hierarchy 

Appendix 1: Labview Interfacing 
 

 
Product note for Ivium Labview Driver 1.0 

(Developed in Labview 8.2) 
 
 

1. Order of communication hierarchy 
 
  
For optimum results when using Labview to control an 
Ivium device it is very important to realise the order of 
hierarchy for communication between the various 
software and hardware. In this case Labview (the VI) 
communicates with the Ivium remdriver, which in turn 
communicates with the IviumSoft-software. Only the 
IviumSoft communicates directly with the Ivium device 
(IviumStat/CompactStat).  
This implicates that the IviumSoft-software should 
always be running in the background when using a 
Labview VI to operate the device. 
The IviumSoft can be minimised when operating 
Labview. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Directions for use 
 
To install, copy the 'Labview' directory into the 'IviumStat' directory of your computer. 
 
The Ivium remdriver (dll) was imported into Labview to create a Labview library (lvlib). In this library, a vi 
is present for all the functions that can be used to control the Ivium device. These vi's can be found in 
the Ivium_remdriver directory. A list of functions that can be controlled is given below, a detailed 
description for each of these functions is given in the IviumSoft development driver which can be found 
in the Software Development Driver directory.  
 
Imported function description 
GENERAL  
IV_open Opens the driver 
IV_close Closes the driver 
IV_getdevicestatus Returns status of device 
IV_readSN(*char) Returns serial number of selected device 
IV_connect(int) Connect to selected device 
DIRECT MODE  
IV_getcellstatus(int) Returns cell status 
IV_setconnectionmode(int) Select configuration, (off; EStat4EL, EStat2EL, EstatDummy1, 

EStatDummy2, EstatDummy3, EstatDummy4, Istat4EL, 
Istat2EL, IstatDummy, BiStat4EL, BiStat2EL) 

IV_setpotential(double) Set cell potential 
IV_setpotentialWE2(double) Set BiStat offset potential 
IV_setcurrent(double) Set cell current (galvanostatic mode) 
IV_getpotential(double) Returns measured potential 
IV_setcurrentrange(int) Set current range, 0=10A, 1=1A, etc, 
IV_setcurrentrangeWE2(int) Set current range for BiStat, 0=10mA, 1=1mA, etc, 
IV_getcurrent(double) Returns measured current  
IV_getcurrentWE2(double) Returns measured current from WE2 (bipotentiostat)  
IV_setfilter(int) Set filter 
IV_setstability(int) Set stability 
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IV_bistat_mode(int) Select mode for BiStat 
IV_setdac(int,double) Set dac on external port 
IV_getadc(int,double) Returns measured voltage on external ADC port 
IV_setmuxchannel(int) Set channel of multiplexer 
IV_setdigout(int) Set digital lines on external port 
IV_getdigin(int) Returns status of digital inputs from external port 
IV_setfrequency(double) Set ac frequency  
IV_setamplitude(double) Set ac amplitude  
METHOD MODE  
IV_readmethod(*char) Loads method procedure from disk 
IV_savemethod(*char) Saves method procedure to disk 
IV_startmethod(*char) Start method procedure 
IV_savedata(*char) Saves actual result data to disk 
IV_setmethodparameter 
(*char1,*char2) 

Modify method parameter  

IV_Ndatapoints(int) Returns actual available number of datapoints: indicates 
progress during a run 

 
To use the functions in Labview open the ' IVIUM_remdriver.lvlib'  (in the Labview directory) in the 
getting started window of Labview. Then drag the desired function from the lvlib onto the Block Diagram 
of the VI that you are building. 
 

 
 

 
 
When a VI is build to control an Ivium device make sure 
that the driver is opened before operating the device 
and closed again before the VI is stopped. 
 
 
 
 
 
Boundary conditions 
Some of the settings of the Ivium device that can be controlled via Labview change an actual setting in 
the Ivium device, like for example the current range. When one (or some) of these settings are changed 
outside Labview, i.e. in the IviumSoft or by the device itself when for example using the AutoCR setting 
in a method, this change of setting is NOT read back into Labview. That implicates that the value in the 
User Interface in the Front Panel may not be the actual setting anymore. 
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When using the method mode a number of strings (file names and locations) are communicated to the 
IviumSoft software. These can only be communicated when the device is CONNECTED. If the device is 
not connected it will result in an error. 
Note should be taken that the IviumSoft-software has many conditions and safeties incorporated. When 
using Labview to control an Ivium device the programmer her/himself will be responsible for supplying 
valid input parameters.  
 
  

3. Example Ivium Driver 1.0 
 
As an example how Labview may be used to control an Ivium device a Labview VI is build using 
Labview 8.2. In this example all functions that can be controlled through Labview are included. This 
example has been set up in such a way that the user interface resembles the user interface of the 
IviumSoft. 
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Set up of Ivium Driver 1.0 
The Ivium Driver 1.0 has been set up using a flat sequence to ensure that the order of events is correct. 
 

 
· The first operation is to open the Ivium_remdriver.dll so the IviumSoft and device can be operated.  
· Next a check is performed to see whether the IviumSoft is running. If not the VI is stopped. If 

IviumSoft is running a check is performed to see if the device is connect, and if so it will be 
disconnected. 

· Third sequence is the actual operation of the Ivium device, either in direct-mode or in method-
mode. 

· Finally, upon closing the VI, the Ivium device is disconnected and the Ivium_remdriver.dll is closed. 
 
Operating sequence of Ivium Driver 1.0: Block Diagram set-up 
To ensure the continuance of operating the Ivium device the actual running-sequence of the VI is 
incorporated in a while-loop. However, before the while-loop commences an initiation of the default 
values is executed for all the controls for the direct-mode operation. This has been done to ensure that 
the values shown in the user interface or Front Panel are the actual values. After this has been done 
the while-loop starts. 
 

  
 
 

Open 
remdriver 

Check 
IviumSoft 
And 
device 
status 

Operate IviumSoft and 
Ivium devicestatus 

Disconnect device 
and close remdriver 

Ivium Driver 1.0 set-up 
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First in the while loop (refer to Block Diagram) is the possibility of connecting with the Ivium device (1). 
Upon connecting, a flat sequence is carried out (2) connecting the device and subsequently setting the 
current range, again to ensure that the shown value is the actual one. 
 
�

�
 
 
The rest of the while-loop is reserved for a tab controlled case structure (3). This case structure 
operates depending on the choice of 'direct' or 'method' mode. 
 
The 'direct' case includes all operating parameters, as well as the tab controlled case structure for the 
AC/Extern/BiStat controls. It also includes the writing-data-to-file operation and the simple chart. 
 
The 'method' case includes all the operating parameters for reading, starting, changing and saving 
experimental methods. 
 
Operating the Ivium Driver 1.0 
Operating the Ivium Driver 1.0 mostly resembles the IviumSoft 
software. First start the VI from Labview. Clicking the 'Disconnect - 
Connect' button at the top of the user interface above the tab 
control connects the Ivium device. 
 
 
 
 
 
 
 
If the device is not connected, none of the direct operating controls or the method controls, work. After 
connecting, all functions can be operated. This includes the reading of the device serial number. If the 
IviumSoft is not running a pop-up window will show mentioning this. Upon clicking the 'OK'-button the 
Ivium Driver 1.0-VI will stop running.  
 
 
 
 
 
 
 
 
 
 
  
 

1 

2 

3 



   142 

When connected the Ivium device can be simply operated by using the controls on the various tab 
pages. 
 
Direct Mode 
In the 'direct' mode tab page the device and cell status can be called and all parameters of the Ivium 
device can be controlled directly. For some of these parameters a property node is called to 
enable/disable the controls when relevant. This has been done to eliminate the possibility of sending 
illegal or conflicting commands that might result in an error and subsequent ceasing of Labview.  

 
 
In the direct mode, as an example, an operation for writing data to spread-sheet file (1) and a simple 
chart (2) have been incorporated. The chart plots data from the data file and thus only operates when 
the data is being written to file. The name of the data file is automatically genrated as 'test+date/time'. 
This filename can be altered in the Block Diagram. 
 
The 'direct' mode also shows an extra number of tab pages: AC/Extern/BiStat (3). 
· The 'AC' page allows to control a simple AC experiment.  
· The 'Extern' page allows to read and control all external ports.  
· The 'BiStat' page only shows when the configuration 'BiStat4EL' or 'BiStat2EL' has been chosen. It 

then allows BiStat control. 

2 

1 

3 
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Method mode 
In the 'method' mode tab page a method can be selected (A). This method can then be read into the 
Ivium software and the device (B). Then the method can be started (C). When 'start method'is clicked 
and no method was read into the IviumSoft, the method currently selected in the IviumSoft is started. 

 
  
Furthermore, separate parameters of method can be changed (D) and this new method can be saved 
(E). Care should be taken that the entered method-parameters to be changed are spelled exactly as in 
the IviumSoft, otherwise it will not register. 
 
During running of a method the number of available data points can be requested (F). In Labview there 
is no possibility to abort a method once started. 
 
Finally, upon completion of executing a method the then in the IviumSoft available data can be stored 
as a Ivium data file (.idf) (G). 
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